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License Agreement 
By opening the sealed license envelope, you are agreeing to the following li-
cense: 
NATIONAL INSTRUMENTS AND DASYTEC USA grants you a non-exclusive license to use this 
Software on one computer at a time. You do not obtain title to the Software or any copyrights or 
proprietary rights in the Licensed Software. You may not transfer, sub-license, rent, lease, convey, 
copy, modify, translate, convert to another programming language, decompile or disassemble the 
Licensed Software for any purpose, except as expressly provided for in this license. You may not copy 
the Documentation. 

You may copy the Licensed Software for backup purposes only, in support of your use of the Software 
in accordance with the terms and conditions of this license. 

NATIONAL INSTRUMENTS AND DASYTEC USA warrant, for a period of ninety days after your 
receipt of the product, 1) the disks on which the Software is distributed to be free from defects in 
materials and workmanship, and 2) that the software will perform substantially in accordance with the 
Documentation. If the product fails to comply with the warranty set forth above, NATIONAL 
INSTRUMENTS AND DASYTEC USA’s entire liability and your exclusive remedy will be replace-
ment of the disks or NATIONAL INSTRUMENTS AND DASYTEC USA’s reasonable effort to 
make the product meet the warranty set forth above. If NATIONAL INSTRUMENTS AND 
DASYTEC USA is unable to make the Product conform to the above warranty, then you may return 
the complete package to NATIONAL INSTRUMENTS AND DASYTEC USA or its dealer, and 
NATIONAL INSTRUMENTS AND DASYTEC USA, at its option, may refund all or a fair portion 
of the price you paid for this package. 

Although NATIONAL INSTRUMENTS AND DASYTEC USA has tested the Software and re-
viewed the Documentation, NATIONAL INSTRUMENTS AND DASYTEC USA MAKE NO 
WARRANTY OR REPRESENTATION, EITHER EXPRESS OR IMPLIED, WITH RESPECT 
TO THIS SOFTWARE OR DOCUMENTATION, THEIR QUALITY, PERFORMANCE, 
MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. AS A RESULT, THIS 
SOFTWARE AND DOCU-MENTATION ARE LICENSED “AS IS,” AND YOU, THE 
LICENSEE, ARE ASSUMING THE ENTIRE RISK AS TO THEIR QUALITY AND 
PERFORMANCE. 

IN NO EVENT WILL NATIONAL INSTRUMENTS AND DASYTEC USA BE LIABLE FOR 
DIRECT, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES ARISING OUT OF 
THE USE OR INABILITY TO USE THE SOFTWARE OR DOCUMENTATION, even if advised 
of the possibility of such damages. In particular, NATIONAL INSTRUMENTS AND DASYTEC 
USA shall have no liability for any programs or data stored or used with the Software, including the 
costs of recovering such programs or data. 

Copyright © 2004 Copyright National Instruments Ireland Resources Limited  
All rights reserved. Product and company names listed are trademarks or trade names of 

their respective companies. 

DASYTEC USA 
A National Instruments Company 

6 Bedford Farms 
Bedford, NH 03110 USA 

MeasX GmbH & Co. Kg. 

Postfach 401264, 
D - 41182 Mönchengladbach, Germany 

The DASYLab®
 software and information in this document are subject to change without notice. 
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Year 2000 Compliance Statement  
 

 

DASYLab 8.0 is Year-2000-compliant. It conforms to the British Standards In-
stitution BSI DISC PD-2000-1 'A Definition of Year 2000 Conformity Re-
quirements‘ document. Specifically, DASYLab will: 

 

� Work correctly for the following the transition from December 31, 
1999 to January 1, 2000 

� Recognize that 2000 is a leap year; 

� Work correctly for all dates in the range January 1, 1980 through De-
cember 31, 2037, but not before, and not after 

� Read and store dates correctly using its private (.DDF) data format, 
and store appropriately for other date formats  
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Risky Applications 
 

Warning:  
(1) National Instruments products are not designed with components and test-
ing for a level of reliability suitable for use in or in connection with surgical im-
plants or as critical components in any life support systems whose failure to per-
form can reasonably be expected to cause significant injury to a human. 

(2) In any application, including the above, reliability of operation of the soft-
ware products can be impaired by adverse factors, including but not limited to 
fluctuations in electrical power supply, computer hardware malfunctions, com-
puter operating system software fitness, fitness of compilers and development 
software used to develop an application, installation errors, software and hard-
ware compatibility problems, malfunctions or failures of electronic monitoring 
or control devices, transient failures of electronic systems (hardware and/or soft-
ware), unanticipated uses or misuses, or errors on the part of the user or applica-
tions designer (adverse factors such as these are hereafter collectively termed "sys-
tem failures").  

Any application where a system failure would create a risk of harm to property or 
persons (including the risk of bodily injury and death) should not be reliant 
solely upon one form of electronic system due to the risk of system failure.  

To avoid damage, injury, or death, the user or application designer must take 
reasonably prudent steps to protect against system failures, including but not 
limited to back-up or shut down mechanisms.  

Because each end-user system is customized and differs from NATIONAL 
INSTRUMENTS' testing platforms and because a user or application designer 
may use NATIONAL INSTRUMENTS products in combination with other 
products in a manner not evaluated or contemplated by NATIONAL 
INSTRUMENTS, the user or application designer is ultimately responsible for 
verifying and validating the suitability of NATIONAL INSTRUMENTS prod-
ucts whenever NATIONAL INSTRUMENTS products are incorporated in a 
system or application, including, without limitation, the appropriate design, 
process and safety level of such system or application. 
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Chapter 1: Introduction 

1. Welcome to DASYLab! 

You have acquired an easy to use software product that provides an enormous 
range of functions and options for your data acquisition tasks. Install this elec-
tronic laboratory on your computer and start experimenting; you will quickly 
discover many of DASYLab’s powerful features.  

Use DASYLab’s Online Help system to display information about the operation 
that you are about to carry out on the screen. It may be unnecessary for you to 
thoroughly study this printed manual. 

If you are new to DASYLab, we recommend that you read through the Step-by-
Step Instructions in the online Help system, or read this introductory chapter 
plus Chapters 2 and 3. You will then know enough to start off with DASYLab 
on your own. 

If you have upgraded from a previous version of DASYLab, please review Chap-
ter 1 – Section 6 for information about new and changed features. 

Later, this User Guide can help you find your way through DASYLab even when 
you are not at your computer. It can serve as a reference book and it will provide 
background information that might seem out of place in the immediacy of the 
online Help system. 

The DASYLab team will continue to develop DASYLab as software that matches 
its users’ requirements and preferences. 

DASYTEC USA 
6 Bedford Farms 

Bedford, NH 03110 
U.S.A. 

MeasX GmbH & Co. Kg 
Postfach 401264 

D-41182 Mönchengladbach 
Germany 
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2. About your DASYLab Documentation 

2.1. What’s Included 

The DASYLab documentation consists of the following: 

� The context-sensitive online Help system provides quick on-screen 
reference to procedures and commands you may need while working 
with DASYLab. In addition, hardware help is provided to describe the 
installation, setup, and use of your specific data acquisition device. 

� This User Guide contains a comprehensive description of all of DA-
SYLab’s functions and their uses. It serves as a reference book, provid-
ing background information. Most of the same information is in-
cluded in the online Help. 

� Volume 2 of the User Guide, the Module Reference Guide, with 
complete descriptions of each Module Group and Module. Most of 
the same information is included in the online Help. 

� Volume 3 of the User Guide, the Hands-On Guide to DASYLab. 
This self-paced tutorial covers many of the frequently used processes 
in an illustrated step-by-step guide. 

� The Getting Started Guide, an interactive set of examples. In addition 
to a comprehensive set of examples, this guide includes most of the in-
formation in Volume 3, the Hands On Guide.  

� The Hardware Information Manual provides a description of the in-
terface between the data acquisition hardware and DASYLab. This 
manual may not be provided with all packages. If not, review the 
README file and any hardware specific online help that is installed. 

� README.rtf, an information file that is copied to your hard disk 
when you set up DASYLab, provides information that was updated af-
ter this User Guide was printed. You can easily read (or print) this file 
using Windows Wordpad. 

� Additional documentation and examples may be available on 
www.dasylab.net. Check this site regularly for updates and informa-
tion. 

Ö We strongly recommend that you read the README file before you start working 
with the software. 
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2.2. Contents 

The DASYLab User Guide is divided into the following parts: 

Chapter 1: A general introduction to the software. It explains the basic 
concepts and provides setup information. It includes an 
overview of the new features and changes in this version. 

Chapter 2: Operating fundamentals. This chapter explains the skills you 
need to work with DASYLab, how you start the program, 
and how you can use the online Help system. You can then 
follow a tutorial. 

Chapter 3: A systematic survey of the elements you will use when work-
ing with DASYLab. 

Chapter 4: A description of all of DASYLab menu commands and func-
tions (except those from the Module menu). The chapter’s 
structure corresponds to the DASYLab menu system. 

Chapter 5: Background information about file formats and data ex-
change between Windows applications. 

Chapter 6: Additional hints and background information structured 
along particular tasks or problems that may arise during 
your work with DASYLab. 

Appendices: Lists of program specifications and error messages, a glos-
sary, the License Agreement and a comprehensive Index of 
Topics covering Chapters 1 to 7. 

Ö Please do not forget to register online at www.dasylab.net or www.dasylab.de, or, 
send us your Registration Card. 

 

The DASYLab Module Reference Guide includes detailed descriptions for each 
module. The interactive Getting Started Guide and the Hands On Guide pro-
vide examples and tutorial information. 

The optional Hardware Information Manual contains a description of your de-
vice with information concerning setup and operation with DASYLab. 
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2.3. Typographic Conventions 

We have used visual cues and standard text formats in this User Guide to help 
you locate and interpret information easily. 

Text Formats 

File names and directory names are printed in ALL CAPITALS. 

All references to menus, menu commands and to the options available in dialog 
boxes are printed in this sans serif typeface. 

All references to keyboard keys and command entries are printed in this 
text format. These are usually commands that you must type at the DOS 
Prompt or in DASYLab or Windows text boxes exactly as you find them printed 
in this manual. It does not matter whether you type upper or lowercase letters. 

Keyboard Formats 

Key combinations and key sequences: 

KEY1+KEY2 means to press and hold down the first key while you 
press the second. 

KEY1, KEY2 means to press and release the keys one at a time.  

Symbols 

We have used the following symbols throughout this User’s Guide to identify 
important information to guide you to information on a related topic: 

, 

Serious Warning! Neglecting the hints indicated by this symbol may result in 
severe program errors or even damage to your hardware. 

Ö Warning. Neglecting the hints indicated by this symbol may result in DASYLab not 
operating properly; data may be misinterpreted or not calculated correctly. This sym-
bol will remind you to check that parameters are set correctly, or to check settings that 
must match. 

ª When you have read a passage about a subject, this symbol may indicate that expla-
nations on a related subject can be obtained elsewhere in this User Guide, or that 
similar commands, options, etc. might be of interest in the current context. 
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3. What is DASYLab? 

Data Acquisition and Analysis under Windows 

DASYLab is a data acquisition, process control, and analysis system which takes 
full advantage of the features and the graphical interface provided by Microsoft® 
Windows™. 

The most important design requirements for DASYLab were the integration of 
the important measuring and control devices on the market, a truly intuitive op-
erating environment which offers extensive help functions, a maximum signal 
processing speed, and the most effective graphical display of results. 

Intuitive Operation 

Using DASYLab, a measuring, process control, or simulation task can be set up 
directly on your screen by selecting and connecting modular elements that can 
then be freely arranged. Even highly specialized tasks can be solved immediately 
on the screen, interactively and without difficulty. It is no longer necessary to 
find your way through lengthy and rigid menu structures. 

Large Variety of Measuring, Control, and Analysis Functions 

Among the module functions provided are A/D and D/A converters, Pre/Post 
and Start/Stop Triggers, digital I/O, mathematical functions from fundamental 
arithmetic to integral and differential calculus, statistics, digital filters of several 
types, frequency analysis including various evaluation windows, signal generators 
for simulation purposes, scopes for the graphic display of results, logical connec-
tors like AND, OR, NOR, etc., counters, a chart recorder, file I/O, timer, digital 
display, bar graph, analog meter and more. 

Measuring Technology under Windows 

With DASYLab it is now possible to achieve high signal input/output rates using 
the full power of the PC. Special buffers with large, selectable, memory address 
ranges enable continuous data transfer from the data acquisition device through 
to the software. DASYLab uses extremely sophisticated drivers to obtain real-
time logging at a rate of up to 800 kHz and real-time on-screen signal display at 
a rate of up to 70 kHz (depending on the type of data acquisition device and 
graphics board installed). 

Flexible Worksheet Setup 

In spite of its complexity and high performance, DASYLab can be used easily. 
The worksheet displayed on screen can be edited at any time. New modules can 
be inserted; others can be moved to a different position or deleted altogether. 
Dialog boxes prompt for all the necessary parameters to be set for an experiment. 

Use the Black Box module to take combinations of worksheet elements repeat-
edly required in your experiments, and integrate them into a Black Box module, 
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which you can then insert into worksheets as ready-to-use units. This will save 
you time and simplify your worksheets. 

Integrated Autorouter Utility 

While you are connecting the module inputs and outputs using the mouse, these 
connections are displayed as direct lines, but as soon as the mouse button is re-
leased the integrated Autorouter optimizes all these connections. This prevents 
data channel lines being drawn through or behind existing module symbols or 
too close to other lines. 

In the same way, the integrated Autorouter rearranges the display whenever a 
module symbol has been moved. It thus creates a readable worksheet diagram 
ready for documentation purposes. 

Ample Resources 

The maximum worksheet size is 2000 by 2000 pixels, and a worksheet can con-
tain up to 256 modules. For most modules up to 16 inputs and/or outputs can 
be configured. 

The virtual working area at the user’s disposal is much larger than what can ac-
tually be presented in the active window on screen. When dealing with more ex-
tensive applications, where the complete arrangement of module symbols will 
not fit on the screen, you can scroll through the screen window vertically and 
horizontally. In addition, an overview command, several tagging functions, and 
the ability to hide the worksheet diagram help you to keep track of the setup and 
experiment. 

Function Bar and Module Bar 

Icon bars that provide commands and functions that might be repeatedly re-
quired when experiments are set up and carried out enhance DASYLab’s user-
friendliness considerably. 

You can define the Module Bar on the left of the screen to reflect your pref-
erences. You can assign module functions that you need most often in your indi-
vidual tasks to the buttons on the Module Bar. Once configured, these settings 
can be saved and reused for other worksheets or experiments. Various configu-
rations adapted to the individual requirements of different tasks are easily reused. 

Display of Results 

Readings can be displayed graphically or numerically using specially assigned 
modules. This can be done effectively by making use of scope modules. Each one 
provides a resizable window in which data from several channels can be dis-
played; a system of suitable coordinates (linear, logarithmic, polar, waterfall), and 
different color codes (for multiple signals) can be selected. 

Scaleable analog instruments, bar graphs and LED indicators are especially help-
ful when it comes to process control and testing. As these elements can be freely 
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placed and combined, all the instruments necessary for any process can be inte-
grated completely. 

Storing the Setup 

The complete experiment setup, including all the currently selected parameters, 
window positions, and additional information can be saved to a file and opened 
again later. Multiple ready-to-use standard setups for different tasks can be de-
veloped. The corresponding data acquisition process itself can even be started 
automatically at a specified time, when your computer restarts or when Win-
dows starts. 

Storing Data and Data Exchange 

The acquired data and process results can also be saved to files so that they can 
be retrieved for further processing at a later time. They can be analyzed in detail, 
or used for simulation and training. 

Use DDE (Dynamic Data Exchange) to transfer data directly to other Windows 
applications supporting the DDE protocol. For example: Excel and applications 
with DDE capabilities may be used to start DASYLab and control it while run-
ning an experiment. 

Process Control Applications 

External systems can be controlled by employing appropriate modules for digital 
I/O or D/A conversion. DASYLab provides a wide range of powerful modules 
for binary operations (AND / OR / NOT etc.), counters, and PID control func-
tions. 

Precise time-related process control operations depending on complex signals 
can be realized with DASYLab. Output frequencies, slopes, duration, dependen-
cies on certain input source conditions, etc., can be determined for several chan-
nels by the user. 

Simulation – for Testing and Training Purposes 

Pure simulations, even without a data acquisition device, offer excellent oppor-
tunities to test measuring or process control experiments that have been devel-
oped on the PC. In these cases, a signal generator module, or several of them, is 
substituted for the measuring device. By combining signal generator modules 
with mathematical modules, complex stimuli can be generated. For example, a 
sine or rectangle signal might be overlaid by a noise signal or by further sine, rec-
tangle, or saw tooth signals. Even signals that have previously been saved to files 
may be retrieved and used again as stimuli using the file I/O module. 

You can use DASYLab in training courses, as trainees can directly observe the ef-
fects and results of data acquisition and process control systems. 
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Publication 

All the resources provided by Windows are at your disposal for publication pur-
poses. Not only the measured results, but also the entire experiment setup can be 
published comprehensively and professionally. DASYLab can supply the work-
sheet diagram itself, or the graphic display of the measuring results, directly to 
Windows WordPad, Microsoft Word, or PageMaker. DASYLab provides inte-
grated publishing tools to print the worksheet, graphic or numerical data dis-
plays, captions and explanatory text passages. 

Custom Functions 

As a service to customers who have to cope with highly specialized tasks, MeasX 
will develop custom function modules and other software modifications on re-
quest to meet individual demands. For instance, specified mathematical opera-
tions or options concerning the graphic presentation can be implemented or 
modified as required, and further data exchange interfaces can also be supplied. 

An Extensions Tool Kit is available for experienced C programmers who wish to 
design their own modules. Contact your dealer for more information. 

Integrated Help System 

In most situations, it is not necessary to refer to the complete manual, since al-
most any problem can be solved using the online help system. 

The context-sensitive help system provides the user with detailed instruction on 
hardware settings and software options, and it also supplies background informa-
tion on measuring technology topics like FFT/spectral analysis. 

Conclusions 
In combination with one of the established PC measuring and process control 
devices, the DASYLab system is a powerful tool for data acquisition, process con-
trol and simulation. 
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4. Installation 

4.1. System Requirements 

DASYLab works with most personal computers available today. The minimum 
software and hardware requirements your PC needs to run DASYLab success-
fully are listed below. To get the best performance from the software, especially 
when more than one Windows applications is to be run, we recommend addi-
tional hardware resources. 

Minimum Requirements 
� A personal computer with a Pentium class processor, a standard keyboard, a 

mouse or similar pointing device 
� 128 MB for NT/2000/XP 
� 40 MB of free hard disk space 
� CD-ROM Drive for installation  
� A monitor and a VGA display adapter, 1024 x 768 resolution 
� Windows 2000 or Windows XP Pro  
� Windows 3.x, Windows 95, Windows ME, and Windows XP Home 

are not supported by this version of the software 
� Windows 98 and Windows NT V4 have not been tested for this re-

lease 

Recommended Configuration 

� Pentium 4 class or better PC 
� Additional memory (RAM) (the amount of memory determines the display 

capability of the Chart Recorder and Y/t Chart modules) 
� Hard drive space to install optional components, such as DataSockets 
� High resolution color monitor  
� Super VGA display adapter supported by Windows 
� Software, keyboard, mouse, hard disk, CD-ROM drive, and interfaces as 

described above  
� Serial interface (RS232) 

All printers and plotters supported by Windows can be used with DASYLab. 
No data acquisition hardware is required to run DASYLab. To acquire input or 
output analog signals one of the A/D or D/A devices that are supported by DA-
SYLab must be installed. Please refer to the Hardware Installation Manual or the 
online help for details about the installation of your hardware. 

Note that DASYLab does not support multiple monitors. Your application may 
work, but we cannot provide support for a multiple monitor environment. See 
the Readme.rtf file for updates to this limitation. 
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4.2. Setting up DASYLab 

Preparations 
1. Make sure that your DASYLab package is complete. It should contain 

a CD-ROM disk and your DASYLab serial number. It may contain 
one or more printed books. The books are also included on the CD 
and are available for download from www.dasylab.net. 

2. Review the Software license. Note that DASYLab is licensed for use on 
a single computer, unless you have specifically purchased a multiple 
user license. 

3. Make sure that there is at least 40 MB of free space on the hard disk 
where you are installing DASYLab. In addition, you may need space 
on the hard drive where your TEMP folder is located to decompress 
files while installing. 

4. You must be running Windows. DASYLab will not install from the 
DOS prompt. 

Starting the CD-ROM Installation 

1. Insert the CD-ROM disk into your drive.  
1a. If your system supports Autostart, the CD menu will appear.  
1b. If your system does not support Autostart, run START.EXE 

2. Choose your language, English (Continue) or German. 
3. The CD menu will offer you several choices. In addition to installation, 

you can review the product specifications, view a short tutorial, or run 
the demo version of the program. 

4. Select Installation 
5. Choose the version of the software to install (full) 
6. Select Install to run Setup. 

Setup Summary 

The installation program will … 

… Give you the choice of standard or custom install. If reinstalling, you will 
be able to modify, repair, or remove the software. For most customers, the 
standard installation is appropriate. Custom install gives you the ability to 
add or remove standard components, such as optional drivers. 

… Ask for the serial number which was provided for a new or upgraded in-
stallation (use your current number to re-install) 

… Give you the opportunity to specify the directory and other installation 
options 

… Allow you to specify the data acquisition driver(s) to install.  

… Check if the specified directory exists, and create it if necessary. 

… Check if there is enough free space on your hard disk. If not, you will be 
asked to enter another drive or to cancel setup. 
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… Copy all the DASYLab program files to the drive and directory. 

… Create a DASYLab program group in the Windows Program Manager. If 
the group already exists, it will be opened. 

… Create various program items within that group. 

… Load kernel mode drivers (*.KMD) for Windows 2000/XP. 

… Add appropriate items to the Windows Registry 

… Optionally, install DataSocket Client and Server software 

… Allow you to register online. Registration is important, and allows you to 
contact Technical Support for assistance. 

Completing Setup 

If your data acquisition device does not require a kernel mode driver, you can 
exit the installation procedure and use DASYLab immediately. 

If you have installed a DASYLab version that includes a kernel mode driver, 
Windows may need to be restarted so that the changes made to your system can 
take effect. 

If you choose Exit Installation to use your original Windows configuration, DA-
SYLab is ready to be used, but can only access any newly installed device drivers 
(if required) after you exit Windows and restart it. If you choose Restart Win-
dows, the program will exit Windows completely and restart it. 

ª With some data acquisition devices it may be necessary to modify the configura-
tion of Windows. Please refer to the documentation that comes with your hard-
ware, or to the Software Installation section pertaining to your hardware in the 
Hardware Installation Manual. 

4.3. Hints for PC Hardware Configuration 

PC’s used for data acquisition systems must fulfill other requirements than com-
puters used as office systems or for games.  

This means there are different considerations when installing a measurement sys-
tem. The following hints will help if your PC hardware has hardware problems. 
Often these problems are related to the following components or functions: 

� Power Management 

The Power Management System of some PCs often obstructs the 
measurement. Please completely disable the Power Management op-
tion in the PC BIOS. You may also have to disable the "Support of 
Advanced Power Management" in System/Device Manager/Hardware 
Components. Even the Windows Screen Saver should be disabled, as 
it may interrupt data acquisition processes. 

PCMCIA / PC-Card and USB based devices may have additional 
power management settings. Disable all applicable power management 
to prevent Windows from stopping your devices while running. 
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� Windows Time Zone Settings 

Please disable the Time Zone property "Automatically adjust clock for 
daylight savings changes" in the Window's Date/Time Properties. If 
DASYLab is running when the operating system changes the clock 
time, it pauses until the user clicks on the Dialog Box to acknowledge 
the change. In addition DASYLab will not have the correct start time 
for the Experiment. DASYLab only checks the PC clock time at ex-
periment start. 

� Graphic Card Drivers 

New drivers from some Graphics Card manufacturers are often opti-
mized for maximum speed (e.g. to reach high performance in PC 
games). The driver overrides and obstructs the measurement running 
in the background. When in doubt, do not use the driver of the card 
manufacturer but use the original Standard VGA or SuperVGA driver 
shipped with Windows by Microsoft. Sometimes, there is a newer 
driver available from your graphics card manufacturer that fixes prob-
lems. Please check with your manufacturer for the latest drivers. 

� Printers 

Several printer drivers may disturb the data acquisition. If you experi-
ence any problems, use a printer that is supported by the original 
Standard Printer Driver of Microsoft. Often these standard drivers 
support a complete family of drivers. For example, you can control the 
HP LaserJet family with the 'HP LaserJet Series II' driver from Micro-
soft. 

� Resource Conflicts 

Please pay attention to resource conflicts between the hardware com-
ponents of your PC. Often the data acquisition hardware uses the 
same IRQ or DMA addresses as Sound Cards, Network adapters and 
other devices. In case of doubt, remove the Sound Card from your sys-
tem or, if it is fixed in a notebook, disable it in the BIOS. Simply re-
moving the driver (!) in Windows 98 will not solve the problem. 

5. DASYLab Versions 

DASYLab V8.0 is available in several versions. The table below lists the features 
available with each version. Please contact your dealer or distributor for more in-
formation about DASYLab.  

Ö This User Guide includes information about optional features. To determine which 
version you have, select About DASYLab from the Help Menu and click on the 
Options button 

Ö Optional features may vary by country. Check with your dealer or distributor for 
details. 

The DASYLab Limited, LE or Lite version provides only the most basic func-
tions of DASYLab and is limited to up to 32 Analog Input channels (1 main 
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board, 1 extension or expansion board) and a maximum of 64 data channels. 
One VITool Layout Window is allowed. Add-On modules and optional fea-
tures, such as the Sequence Generator and the Microstar DAP Power DLL are 
not available with this version. 

The DASYLab Basic version has all of the properties of the Full version, and in-
cludes a full set of modules for data acquisition and processing, although some 
modules or groups of modules are not available. One VITool Layout Window is 
allowed. The Analysis Toolkit and optional features, such as the Sequence Gen-
erator are not available with this version. The Driver and Extension toolkits are 
supported. 

The DASYLab Full version gives you all functionality of this easy to use software 
and adds the Control Sequencer, Signal Analysis Modules and Action/Event 
based modules that enhance program control. The full VITool is included, with 
200 Layout Windows. It can be supplemented with all available options, the 
Analysis Toolkit and hardware. Check with your dealer or distributor if you have 
any questions. 

The DASYLab-Net option adds the Net Input and Output modules to the DA-
SYLab+ Full version. The Analysis Toolkit option adds specialty features for ad-
vanced FFT signal analysis (Transfer Function, Octave Analysis, nth Harmonic), 
statistical modules for fatigue analysis and classification, and the Set-
point/Sequence Generator. 

DASYLab 16- and 32-bit Version Differences 

This version of the software is only available as a 32-bit product. DASYLab 32-
bit version takes advantage of the features available with Windows 32-bit operat-
ing systems: Windows 98, Windows NT/2000 and Windows XP Pro. It pro-
vides some functions that aren’t supported by the 16-bit version. The 32-bit ver-
sion will not run under Windows 3.1 or 3.11, even if Win32s is loaded. Due to 
problems with some drivers, Windows 95, Windows ME and Windows XP 
Home are not supported. Windows 98 and Windows NT V4 were NOT tested 
with this release. 

To convert 16-bit program worksheets to V8.0, you must use DASYLab V5.0 
16-bit to save the worksheet as worksheet ASCII format, *.DSA. You can read 
this format with DASYLab V8.0. You will need to copy both the *.DSA and the 
*.DMX files if you need to move them from their original folder. You can con-
tact your distributor to obtain a V5.0 serial number to allow you to install the 
older version. 
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The chart below shows which modules are provided with each version. 
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6. New in DASYLab Version 8.0 

Below, you will find an overview of the most important additions and changes 
for the current DASYLab Version. Please also read the README file for addi-
tional changes made after this book was printed. 

6.1. Getting Started Tutorial 

The Getting Started Tutorial supports new DASYLab users with useful tips and 
examples for creating typical worksheets. You can open demonstration work-
sheets in a second DASYLab session and test them in parallel to the user’s own 
worksheet.  

Extended Getting Started 

The Getting Started section of the Help contains a new QuickStart chapter that 
shows beginners step-by-step procedures for basic functions of DASYLab and 
provides an easy-to-use tutorial for the creation of your first worksheets. Con-
crete tasks of worksheets are explained in each single step. Each worksheet devel-
oped in the different chapters is available as a Getting Started worksheet and al-
lows you to easily verify whether the worksheet you created with this tutorial is 
correct. 

6.2. General 

User defined Function Buttons 
All four DASYLab Main Views provide 8 User Defined Function Buttons that 
can be defined to execute any of the functions and commands available in DA-
SYLab. 

Overview of Global Variables and Strings 

A new command in the Options menu opens an overview of all global Variables 
and Strings. Each item lists information about global Variables and Strings, in-
cluding where they are used, how they are used, and the current value and set-
tings. Possible conflicts in usage are marked.  

Module Defaults 

The settings of modules on the workarea can be stored as the module default for 
that type of module. Right-click over the module to open the context menu and 
choose the Default Module Options command. Each time a module of that type 
is be inserted on the worksheet, it will be configured based on the saved settings.  

User defined Hot-Keys 

New option menu command allows you to define and assign key combinations 
to any available DASYLab menu function. 
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Simply use the key (combination) to call up the assigned menu function. 

Activation of Channels 

The method for activating and deactivating channels has changed. You can now 
quickly enable and disable multiple channels for all types of modules. 

Extended Tooltip Functions 

Move the mouse over the modules symbol to get information about modules 
name and short description shown as Tool-Tip flag. 

6.3. New Modules 

See the Module Reference Guide for details of each new module. 

 Module  Module Group 

 
Polar Plot Module Display 

 
CAN Logger 

CAN Hardware (see the CAN 
Hardware Help) 

 
Multi-Speed Analog Output 

 
Multi-Speed Digital Input 

 
Multi-Speed Digital Output 

Input/Output (only available for 
selected drivers) See the Help for 
the Multispeed Driver that you 
install 
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6.4. Module Changes  

Action Module  

New Event: Input = Value. 

New Action: Copy Layout as Bitmap into Clipboard allows you to create Bitmap 
Snapshots of VITool layout pages while DASYLab is running. The Bitmap is 
stored to the clipboard. The moment of capture is controlled by an event driven 
action. 

Message Module  

Messages created by the Message Module now are displayed in the Layout using 
the fast drawing mode. 

Regression Module 

The coefficients of the polynomial can be stored in global variables. 

The module now supports exponential curve fitting. If the Exponential Fit op-
tion is active the exponential polynomial is calculated (exp (a + b x + c x^2 + ....) 
) not the standard polynomial (a + b x + c x^2 + d x^3 +...). 

ICom/IEEE Modules  

Motorola Float and Double Format are available. 
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Chapter 2: Getting Started 

1. Basic Techniques 

Chapters 2 and 3 are designed to give you a quick first look at the program and 
to let you start experimenting with it. 

This chapter discusses the following subjects: 

� How to start DASYLab. 

� How to obtain online help while working with DASYLab. 

� How to create your first worksheet and become familiar with DASY-
Lab’s basic functions. 

You should be familiar with the basic techniques needed to operate your PC, 
DOS commands (such as those concerning drives, directory changes and file 
management), mouse operations and Windows fundamentals (like using menus 
or window features, etc.). 

ª If you require additional information, please refer to your Windows User’s Guide and 
the documentation that comes with the corresponding software and devices. The online 
tutorial supplied with Windows helps you to learn basic mouse techniques. 

DASYLab uses features common to most Windows applications: 

� A menu structure with pull-down lists 

� Scroll within windows using vertical and horizontal scroll bars on the 
right and the lower window borders 

� Drag elements across the working area by selecting the element and 
moving the mouse with the left mouse button pressed 

� Drag groups of modules by selecting the group using the left mouse 
button to click and drag a selection box. Then left click on the se-
lected area and drag it to the desired location. 

� Dialog boxes provide option buttons, list boxes and text boxes to se-
lect options and to enter parameters 

Right Mouse Button Functions in the Worksheet Window  

Ö The right mouse button has multiple functions within DASYLab, which are 
explained here and in Chapter 3. 

When the mouse cursor is on a module in the worksheet, you can display a con-
text-sensitive pop up menu by pressing the right mouse button. The following 
menu items are displayed: 

� Delete Module 

� Delete Input Channels (if module has any input channels connected) 

� Delete Output Channels (if module has any output channels con-
nected) 
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� Cut (if module is selected) 

� Copy (if module is selected) 

� Replace Module 

� Search for Module 

� Default Module Options 

� Module Documentation (extended description of selected module) 

� Properties (Module dialog box for selected module) 

� If the mouse cursor is over a free area of the worksheet (the worksheet 
background), the pop up menu has the following entries: 

� Colors 

� Paste (insert previously copied or cut worksheet components at the 
position of pointer) 

� Properties (general worksheet settings) 

To select the window mode: 

� Control Sequencer 

� Display 

� Worksheet 

� Layout 

Worksheet Documentation Tool: 

� √ Edit Documentation (enables the documentation tool) 

� Create Documentation 

� Delete Documentation 

� Documentation Properties 

Delete a Data Channel - Two separate clicks (not a double-click!) with the right 
mouse button on the connection line between a module output and another 
module’s input deletes that data channel 

Right Mouse Button Functions in the Control Sequencer 
Click with the right mouse button on the background to open the popup con-
text menu to switch to the other window modes ( Worksheet, Layout, Display). 

Right click on a flowchart junction to open a menu with the commands: 

� New (Flowchart or Action) 

� Comment Flowchart 

� Set Start Flowchart (The start flowchart is marked by an added 
“start”) 

� Load Flowchart 

� Delete Flowchart (with an additional security request) 

For Action junctions the commands below are available: 

� New Action) 
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� Edit Action 

� Delete Action 

Right Mouse Button Functions in the VITool Layout Window  
If the mouse cursor is on an object in a VITool Layout Window, you can display 
a context-sensitive pop up menu with the following items: 

� Cut 

� Copy 

� Delete 

� Up 

� To Front 

� Down 

� To Background Properties (Graphic Object) 

If the mouse cursor is on a free area of the Layout Window, the pop up menu 
has the following entries: 

� Paste 

� Object (to insert a new object) 

� Zoom 

� Full Screen 

� Delete Layout page 

� Switch to…  

� Worksheet 

� Displays 

� Control Sequencer 

� Global Layout Properties 

� Page Layout Properties  

Right Mouse Button Functions in the Display Window 
Display Windows: If the mouse cursor is on a display window, the pop up pro-
vides the window menu options (useful if the Menu Bar is hidden).. 

Right Mouse Functions if the pointer is on Module, Function or 
Status Bar 
� Module, Function or Status Bar (32-bit Version only): You can use 

the right mouse button to activate or deactivate the Module, Function 
or Status Bar. Activated bars are marked with a checkmark. The Mod-
ule Bar display can be defined by user (number of rows/columns).  

� Configure the Module Bar - Click on a Module Bar icon with the 
right mouse button to assign any of the modules available in DASY-
Lab to that button 
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� You can change the relative size of the Module Bar by choosing from 
the selection of settings for the configuration of the Module Bar 
(1x40, 2x20, 4x10, etc.). 

Configuring Hardware Module Input/Output Channels  

Double-click the icon of an active channel on the Channel Selection Bar with 
the right mouse button to deactivate that channel. 

2. Starting DASYLab 

2.1. Starting DASYLab with a New Worksheet 

From the Windows Start Menu 
Click on the Windows Start button. Select Programs, then the DASYLab pro-
gram group. Select the DASYLab icon from that group to start the program. 

From the Windows Program Manager 
Double-click the DASYLab Icon displayed in the DASYLab program group of 
the Windows Program Manager. When you installed DASYLab on your hard 
disk, a new program group (“DASYLab”) was automatically created. 

2.2. Starting DASYLab with an existing Worksheet 

From the Windows Program Manager 
� If you prefer to keep a program startup option without a worksheet, 

first copy the DASYLab icon. Select the icon, and press the F8 func-
tion key, or choose Copy from the File menu. 

� Select either of the two icons (one mouse click), and press the 
ALT+ENTER keys or choose Properties from the File menu. 

� Type the complete worksheet file name (including drive, directory, 
and extension) after the DASYLab command in the Command Line 
box. For example: 

“C:\Program Files\DASYLAB 5.6\DASYLAB.EXE” D:\TESTS\TEST1.DSB 

� In the Description box, type a description that identifies the worksheet 
that will be loaded onto the work area. 

� Press ENTER 

� Use this method to set up several icons to automatically open various 
worksheets. 

ª You will find additional information on Automatic Program Start options in Chap-
ter 6 of this User Guide. 
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3. Experiment Setup and Time Bases 

General parameters for data acquisition and measurement control are set in the 
Experiment Setup dialog. You can set the  

� Global Sampling rate per channel 

� Global block size 

� Global settings for Analog Output and Digital Output 

� Global clocking for the driver 

� Disk Streaming options 

� Driver specific settings, including driver buffer, acquisition mode, etc. 

See Chapter 4: 1.4.9, Experiment Setup… on page 4-24 for more details.  

In addition to the Global Sampling Rate, DASYLab supports special drivers that 
may also be able to generate their own clock. The NI-DAQ driver for National 
Instruments devices is one such special driver.  

The Time Base Setup, in the Experiment Menu, allows you to review each of the 
available time bases, and to configure them in one place. Various modules which 
can generate data, such as the Switch or Slider Modules, have a user settable op-
tion to choose the time base, allowing you to synchronize the output with hard-
ware generated data. 

4. Documenting your Worksheet 

In addition to the module name and short description you can add an extended 
description to each module inserted on a flowchart. You can also create docu-
mentation frames that are permanently shown on the worksheet background, 
behind or around one or more modules or just in an empty area. 

Modules Documentation  
The popup context menu, opened by right clicking the mouse over a module 
shows the Module Documentation choice. Select this command to create a de-
scription with up to 256 characters.  

Flowchart Documentation  
In addition to the module documentation, you can insert information to the 
flowchart in text boxes, which are shown permanently on the background of the 
worksheet. A right mouse click on an empty area of the worksheet background 
opens the popup context menu that offers several commands to Edit, Create and 
Delete documentation frames where you can enter up to 256 text characters to 
be displayed. The Edit Documentation command activates (√) the documenta-
tion function. The Properties command enables you to modify the look of the 
frame (background, font and frame colors) and provides an edit area to insert 
any text up to 256 characters. You can choose any available font to apply to all 
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of the characters. Use the left mouse click to move (“catch” the upper left corner) 
or resize (“catch” the lower right corner) the boxes. 

A maximum number of 256 frames may be placed on each worksheet.  

ª This new feature allows you to structure your flowchart with colored frames. Put 
modules of the same functional group into boxes with the same color (see the online 
help for a colored example). 

5. Context Menus 

Right Mouse Click on Module  
If the pointer is over a module on the worksheet, you can display a popup menu 
by clicking the right mouse button. The following menu items are displayed: 

� Delete Module 
� Delete Input Channels (depending on position of pointer) 
� Delete Output Channels (depending on position of pointer) 
� Replace 
� Cut 
� Copy 
� Delete 
� Search for Module 
� Default Module Options 
� Module Documentation (Description of the module) 
� Properties (Dialog box for the module beneath the mouse pointer) 

Context Menu: Right Mouse Click on Worksheet Background  
If the pointer is on a free area of the worksheet, the popup menu has the follow-
ing entries: 

� ModulesÆ (display a list of the modules in the Module Menu) 
� ColorsÆ (change colors for  background, wires or grid) 
� Paste (Insert components of worksheet at the position of the mouse 

pointer) 
� Search for Module 

 (to select the window mode) 
� Control Sequencer 
� Displays 
� Flowchart 
� Layout 

(Worksheet Documentation Tool) 
� √ Edit Documentation (enables the documentation tool) 
� Create Documentation 
� Delete Documentation 
� Documentation Properties  
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� Properties (general worksheet settings) 
 

6. Using the DASYLab Help System 

Click on this Button to call up the DASYLab Online Help or choose Help from the 
Main Menu and select Index or one of the other available options. 

You can usually obtain information on the function you are currently using by 
pressing the F1 function key or by clicking the Help button found in many dia-
log boxes. Then, either specific information on the current function, command 
or dialog box, or the Help Index will be displayed. 

ª You can obtain information on how to use the Windows Help system itself by 
pressing the F1 function key while using a Help window or by choosing Using 
Help from the Help menu. 

7. Creating your First DASYLab Worksheet 

Follow this tutorial to create a simple worksheet and to learn about the basic 
elements and functions of DASYLab.  Also see the Online Help and the new 
Getting Started Tutorial for interactive examples. 

To start the program, double-click the DASYLab icon in the DASYLab Program 
Group of the Windows Program Manager. 

The DASYLab screen will appear, displaying the Title Bar and the Main Menu 
Bar, the Function Bar below them, and the Module Bar on the left of the win-
dow. (These elements of the DASYLab screen are described in Chapter 3.) 

Press the F1 function key (or the Help button while working in a dialog box) to 
obtain online help. If you prefer to follow these instructions on screen, press F1 
now, and choose Creating your First Worksheet from the Help Index page. 

On the left hand side of the DASYLab screen you can see the Module Bar. It 
displays a selection of icons that represent modules frequently required in work-
sheets. 

 
Place the mouse pointer on this Module Bar icon. It represents a 
Generator module. Click the icon with the left mouse button. 
The name of the module the mouse pointer is pointing at is dis-
played in a small window above the module icons. 

 
In the same way, choose the Y/t Chart module by clicking its icon 
on the Module Bar with the left mouse button. You have now 
integrated these two modules into your worksheet; their symbols 
appear in the work area. 

Any module can be installed either by clicking the corresponding icon on the 
Module Bar, or by choosing it from the Modules menu. While the Module Bar 
can only offer a limited selection of icons, the Modules menu provides the com-
plete list of available modules. 



Getting Started  

2-8  

When you install a module from the Display group of the Modules menu (for 
example, a Y/t Chart module), an additional icon will appear at the bottom of 
the screen. 

The two modules in the worksheet must now be connected by data channels so 
that data can be transferred between them. 

To connect them, simply move the mouse pointer to the Y/t Chart module sym-
bol, press the left mouse button, and drag the module symbol to the Generator 
module symbol (keeping the mouse button pressed down) until the output (O) 
and input (I) symbols touch. When you release the mouse button, DASYLab will 
automatically connect the two modules and route the wires. 

You can also connect two modules without moving the module symbols – you’ll 
do that in a few minutes. 

The data channel is now complete; the output of the first module is connected to 
the input of the second. The experiment can begin. 

At the top of the DASYLab screen, below the Main Menu Bar, you can see the 
Function Bar. It contains icons that provide easy access to frequently used func-
tions. When the mouse pointer is pointing at a Function Bar icon, a QuickInfo 
tag with the name of that function will appear. Just click the icon representing 
that function. 

 
Use the left mouse button to click this icon on the Function Bar – 
the first one on the left or press F5. This will start the experiment, 
and soon the Generator module will generate a signal. 

The signals and results of measuring processes can be displayed graphically using 
modules from the Display group. They consist of two elements each: the work-
sheet symbol, which is integrated into the worksheet and connected to the other 
modules by data channels, and the Display Window, which initially appears 
minimized as an icon at the bottom of the computer screen, and which you must 
separately restore (or “open”) to see the display during an experiment. 

 
Open the Y/t Chart Display Window using the left mouse button, 
either by clicking this Function Bar icon (it represents the Show 
Display Windows command from the View menu) or by double-
clicking on the display window icon at the bottom of the desktop. 

The Y/t Chart Display Window appears, and you can observe the signal generated 
by the Generator module as it is shown on the display. 

Before you perform the next steps, please drag the Y/t Chart Display Window to a 
position above this Help window, so that it does not hide any elements of your 
worksheet. It may be necessary to adjust its height first. You can drag a window 
by clicking its Title Bar with the left mouse button and moving it to its new lo-
cation with the mouse button pressed down. 

 
By alternately clicking this Function Bar icon with the left mouse 
button you can pause the running experiment or resume it at the 
same stage at which you interrupted it. Pressing CTRL+F6 on 
your keyboard has the same effect. 
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Click the right mouse button on the Y/t Chart Display Window screen: the Color 
dialog box appears. Select a new color for the display background by clicking the 
colors on the palette and pressing OK. 

 
Now stop the experiment. You can either click this icon on the 
Function Bar or press CTRL+F5 on your keyboard. 

If you cannot see the Y/t Chart module symbol (in the work area) because it is 
hidden behind the display window, drag the window to one side or reduce it to 
an icon by clicking the Minimize button (the down arrow in the upper right-
hand corner of the display window). 

Use the right mouse button to double-click the Y/t Chart module symbol on the 
worksheet to open a dialog box. Select Delete Module and press OK to delete the 
Y/t Chart module from your worksheet. 

 

Now add the Bar Graph module to your worksheet by clicking its 
icon on the Module Bar with the left mouse button. The module 
symbol appears in the work area, and the icon representing the 
corresponding display window will appear on the lower edge of 
the desktop. 

Connect the input of the Bar Graph module symbol with the output of the 
Generator module symbol as described above. 

 
Open the Bar Graph display window either by clicking this Function 
Bar icon or by double-clicking the display window icon at the bot-
tom of the desktop. 

 
Start the experiment again; the Generator signal will appear in the 
Bar Graph display window. 

 
Stop the experiment,  

 

And click the Module Bar icon representing the Digital Meter 
module. The module symbol appears on the worksheet next to 
the Bar Graph module symbol, and the corresponding display 
window icon appears at the bottom of the desktop. 

Move the Digital Meter module symbol around the worksheet by clicking and 
holding the left mouse button while you drag it to various locations. For exam-
ple, drag it below the Bar Graph module symbol. DASYLab will arrange the 
blocks evenly according to the grid settings defined in the Window Setup dialog 
box from the Options menu. 

The quickest way to connect the Digital Meter module to the Generator module 
is to “tap” the existing data channel between the Generator module and the Bar 
Graph module. To create a branch, use the left mouse button to click anywhere 
on the data channel between the two module symbols. The mouse pointer takes 
the shape of a hand holding a plug. Place the tip of the plug precisely onto the 
input symbol (I) of the Digital Meter module symbol, and click the left mouse 
button again. This establishes the connection, and the Autorouter automatically 
finds the correct path for the new data channel segment. 
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You can now start, pause, and resume the experiment. Practice changing the 
color of the display by double-clicking the Digital Meter icon at the bottom of 
the screen, to change the color of the display as described above. 

The default signal generated by the Generator module is a square wave. Double-
click the Generator module symbol with the left mouse button. You can select 
various settings in the dialog box to define the signal to be generated. Refer to 
the Module Reference Guide or press the F1 function key to obtain information 
on the parameters. 

Click the Sine button in the Wave Form box, and then click the OK button. 
The Display modules will display the selected signal type. 

 
The Y/t Chart module can be used now to visualize the sine wave. 
Since you previously deleted the Y/t Chart, click on the Module 
Bar to bring the Y/t Chart back onto the worksheet. (If your ex-
periment is still running, you must first stop it before making 
changes in the experiment setup.) 

 
Create another data channel branch to connect the Y/t Chart module 
symbol, and then start the experiment again. 

You should Save your first worksheet now, so that you can use it to try out some 
more of DASYLab’s options later on. 

 First, stop the current experiment, 

 
And then click this Function Bar icon with the left mouse button. It 
represents the Save command from the File menu. 

A dialog box appears. In it, the File Name box displays a list of demo worksheet 
files that were copied to the DASYLab directory during the setup procedure. 
These files will give you examples of the wide range of measuring and data acqui-
sition tasks that can be solved by DASYLab. You can open, run, modify and re-
run them all later. Their File Info box contains a description of each worksheet. 

Type a file name of your choice (using no more than eight characters) in the File 
Name box; for example, type TUTOR1. Choose the OK button, and your work-
sheet will be saved as TUTOR1.DSB in the DASYLab directory. (DASYLab 
automatically adds its standard extension .DSB.) The DASYLab window Title 
Bar now shows the file name. 

 
To open this (or any other) worksheet file later, click the File Open 
icon on the Function Bar with the left mouse button. This icon is a 
shortcut to the Open command on the File menu. 

Congratulations! You have successfully finished the DASYLab basic lesson and 
are now ready to begin working with DASYLab! 

The next time you have a question or need help, you can 
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� Read these instructions again 

� Find the answers in other chapters of the DASYLab documentation 

� Use Online Help. You can obtain Online Help by pressing the F1 
function key whenever you need help; or use the Search function in 
the Help window 

Unless you prefer to continue experimenting with DASYLab, exit the program 
now by double-clicking the Control Menu box in the upper left corner of the 
DASYLab window, or by pressing ALT+F4 on your keyboard. 
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Chapter 3: Creating an Experiment Setup 
This chapter describes DASYLab’s basic elements and functions used to set up a 
data acquisition experiment. 

Read these pages at your computer so that you can try out all the functions pro-
vided by DASYLab. This chapter can also be used as a reference. 

This chapter addresses the following topics: 

� The elements of an experiment setup 

� The elements of the DASYLab screen and how to use them effectively 

� A brief overview of the module groups 

� A systematic approach to a data acquisition task to be solved on 
screen. 

� An overview of the VITool Layout windows 

1. The Elements of a Worksheet 

The worksheet graphically displays the complete experiment setup or meas-
urement procedure, including all the modules and data channels. The maximum 
size of a worksheet in pixels is 2000 (vertically) by 2000 (horizontally). It is in-
dependent of the screen resolution.  

1.1. Modules 

A module represents a functional element in the DASYLab experiment setup 
(worksheet). A worksheet can contain up to 256 modules. 

The functions symbolized by the modules comprise all the operations required 
for an experiment: 

� Data acquisition (by a data acquisition board) or signal generation 
(simulated by a software generator) 

� Data analysis, evaluation and processing (mathematics, statistics, con-
trol, trigger and other functions) 

� Presentation on screen (display instruments) or export for documenta-
tion purposes (printer, metafile, etc.). 

Most modules can be configured with up to 16 inputs and outputs. 

A module can be installed on the worksheet by choosing it from the Module 
menu or by clicking the icon on the Module Bar. 

You can find detailed information about the Module menu functions in Module 
Reference Guide. The Module Bar is described in detail on page 3-22 in this 
chapter. 

Icons in the Module Bar appear slightly different from the worksheet symbols. 
Additionally, modules from the Display module group have a display window 
symbol. 
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Module Bar Icons 
On the Module Bar, the modules are represented as simplified icons at a slightly 
reduced scale. The name of the module selected by the mouse is displayed above 
the Module Bar. 

� Click the Module Bar icon with the left mouse button to add that 
module as a symbol to the worksheet, where it takes the first available 
free space. The exact position depends on the Spacing value entered in 
the Window Setup box of the Options menu. 

� Click any Module Bar icon with the right mouse button to assign any 
of the available DASYLab modules to that position in the Module Bar 
(see page 3-22 in this chapter for a complete description of the Mod-
ule Bar and techniques to customize it.) 

� The Module Bar can only display a limited selection of the modules 
available in DASYLab. The exact size of the Module Bar depends on 
the screen resolution of your PC. All the available modules can be ac-
cessed from the Module menu. Please refer to Module Reference 
Guide of this manual for complete module documentation. 

Worksheet Symbols 
In the worksheet, modules are represented as complete symbols. These symbols 
display each module’s name and the input and output channels you have selected 
for it. 

� Use the left mouse button to double-click on the symbol to open the 
dialog box to configure the module. 

� Use the right mouse button to double-click on the symbol to open the 
dialog box to delete the module from the worksheet or to delete its in-
put or output data channels. 

� Click and hold the left mouse button to drag and drop the symbol to 
any position on the worksheet (depending on the Spacing value en-
tered in the Window Setup box of the Options menu). 

Ö When positioning modules manually in the worksheet, leave enough space 
between the module symbols for data channels to be created later. If you try 
to connect two modules and there is not enough space to arrange the data 
channels, an error message will appear: “Connection is not possible.” 

� The modules from the Display module group provide an additional 
display window, which initially appears minimized at the bottom of 
the screen. 

Module Manipulation by Keyboard 
The modules on the worksheet can be manipulated in various ways. The mod-
ule symbols on the worksheet can be dragged about, connected by data channels, 
configured, or deleted. The last two of these manipulations can also be done us-
ing the keyboard.  
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First, select the module. Only one module in the worksheet can be selected and 
manipulated at a time. When a module is selected, the Module Name Title Bar 
is highlighted in an inverse color. 

� To select a module, click it once with the left mouse button, or press 
the TAB key on your keyboard until that module is selected. 

� When you press the ALT+ENTER keys, the module configuration 
dialog box appears. Press the TAB or SHIFT+TAB keys to move from 
one field or button to another; select items by pressing the arrow keys, 
the SPACE and ENTER key. 

� Note: Channel selection can only be done using the mouse. 

� To copy setting for the selected channel to the other activated chan-
nels, use the F7/F8 function keys. This procedure can only be done us-
ing the keyboard. 

� To delete the selected module from the worksheet, or to delete all the 
input and/or output channels of that module, press the DEL key. In 
the dialog box that then appears, select the desired option, or choose 
Cancel, and press ENTER. 

1.2. Data Channels, Junction Points 

A data channel is the connection between the output of a module and the input 
of another module. Data is transferred between the respective modules via these 
connections.   

A branch is a data channel segment that branches off from another data channel 
at a junction point. 

Branches allow you to connect the output of one module to the inputs of several 
other modules. 

By creating branches each module output can be connected to up to 16 inputs of 
other modules. 

In the worksheet, lines like these represent data channels, branches and junction 
points: 

Data channel (wire) 

Branches and junction points  

 No connections 

You can choose the colors of the wires using the Colors command from the Op-
tions menu. Different colors can be specified for the wire cores and the wire 
sleeves. 

When you connect the modules, the Options Autorouter menu function allows 
the following. 

� When the Autorouter is active, DASYLab automatically finds the cor-
rect paths for the data channels. DASYLab ensures that the data chan-
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nels do not run across modules or hide other data channels. A control 
window in the Status Bar displays the progress of the autorouting 
operation. 

� When the Autorouter is not active, you determine the paths of the data 
channels manually. 

Channel FIFO Status while measurement is running 
In addition to the Animation options (View Menu), there are three ways to 
monitor the flow of data between modules while the measurement is running. 
This is a useful set of features for ensuring that the worksheet logic is working as 
designed. 

� Use the left mouse button to click on a 
data line. This simple display shows the 
data value and block size.  

� Press on the Shift key and click on the data line with the left mouse 
button. This auto scaling chart displays all of the data in a block.  

� Press the Control key and click on the data line with left mouse 
button to display the status of the data channel during measurement.  
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1.2.1 Creating Data Channels or Branches 

The Quick Way 
To connect a module, simply drag it against the module to which it is to be con-
nected until the output (O) and input (I) symbols touch. When you release the 
mouse button, DASYLab will automatically connect the two modules and route 
the wires (whether the Autorouter option is active or not). 

This procedure works with modules with any number of input or output chan-
nels, and it is very useful when connecting modules with multiple inputs and 
outputs. 

It works when both modules are configured differently, when different channel 
numbers have been selected, and when some of their inputs or outputs are al-
ready connected to other (i.e., a third) modules. 

For example, you can activate four output channels of a Generator module, then 
connect two of them to Display modules, and the remaining two to modules 
from the Signal Analysis group. 

Once a connection has been established between two modules, no further con-
nections (between the other – still unconnected – outputs and inputs of these 
two) can be created in this simple way. You must then proceed as described be-
low. 

With the Autorouter Option ON 
Click the left mouse button once at the point where you wish the data channel 
to begin – the output symbol (O) of a module or – for a branch – any position 
on the wire. The mouse pointer then changes into a plug symbol. 

Then place the tip of that plug symbol on the input symbol (I) of another mod-
ule. Note that the input of the second module must be open. While you do this, 
a thin black line is drawn from the starting point of the connection. 

Click the left mouse button again, on the input symbol at the end of the connec-
tion, to establish the connection. 

� Undo last Step: use ALT+BACKSPACE to remove the last connection 
and restore the worksheet. 

� To cancel the process, click the left mouse button once anywhere out-
side the input symbol. 

With the Autorouter Option OFF 
Click the left mouse button once at the point where you want the data channel 
to begin – the output symbol (O) of a module or – for a branch – any position 
on any wire. The mouse pointer then changes into a branch symbol. 

Draw the new data channel by moving the mouse. While creating each segment, 
you can lengthen or shorten it only in the vertical or horizontal direction indi-
cated by the branch symbol. You need not move the mouse pointer exactly along 
the future track of the channel. 
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Click the left mouse button again to freeze the length of the data channel seg-
ment you have just created and switch to the other axis (horizontal or vertical) 
for the next segment. 

When the data channel hits a module, you must guide it around it. 

When the tip of the new data channel is aligned with the input symbol of the de-
sired module input, click on the input symbol to complete the data channel con-
nection. 

� To undo the last segment, click the right mouse button once. 

� To cancel the process, double-click the left mouse button anywhere. 

� To undo the last data channel connection, use the ALT+Backspace 
key combination. 

To Create a Branch 
When the output of a module is to supply data to more than one input of a 
module, simply create a branch. Click the left mouse button once anywhere on 
the data channel where you want the channel to branch off. Create the connec-
tion to the module input as described above. 

1.2.2 Rearranging Data Channels or Branches 

To Rearrange a Data Channel 
First delete the data channel by clicking the channel twice with the right mouse 
button, and then create it again on a different track. 

Ö Note that the deletion of a data channel segment may delete further segments and/or 
branches. 

To Rearrange A Junction Point On A Data Channel 
Use the left mouse button to click once at the junction point that you want to 
move. The mouse pointer then changes into a branch symbol. 

Drag the small box that now represents the junction point to its new position on 
the data channel. 

Establish the new position by clicking the left mouse button again. All the data 
channels affected will be automatically rearranged. 

Note that you can only drag the junction point either vertically or horizontally 
along a data channel. If you want to move it around a corner you must first drag 
it right to the corner, click the left mouse button, and then move it in the other 
direction in a second step. 

1.2.3 Deleting Data Channels or Segments 

The Quick Way 
Use two separate right mouse button clicks (not a double-click!) on the data 
channel to be deleted: 

� At the first click, the section that is to be deleted will change its color. 
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� At the second click it will be deleted. 

To cancel the process, click anywhere on the screen but on the same section the 
second time. The data channel will then resume its previous color. 

-Or- 
Use the right mouse button to double-click at the end of the connection (i.e., 
the input symbol of the second module). 

Confirm the deletion in the dialog box that appears, or choose Cancel. 

If you accidentally double-click the beginning of the connection (i.e., the output 
symbol of the first module), you will be asked to confirm the deletion of that 
module (instead of the data channel). Click the Cancel button in the dialog box. 

To Delete ALL the Input and/or Output Channels of a Module 
Use the right mouse button to double-click on the module symbol. To use your 
keyboard, select the module first by repeatedly pressing TAB until the module’s 
Title Bar is highlighted, then press DEL. 

In the dialog box, click the desired option, then choose OK, or press ENTER on 
your keyboard. 

Ö Please note that any confirmed deletion will always be executed in compliance with 
the other elements of the worksheet. This means that if, for example, you delete a 
channel section that divides up into branches in its further course, and all those fur-
ther branches will be deleted too. 
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2. The DASYLab Screen 

2.1. The Worksheet Window 

 

Work Area: Worksheet Window 

The work area is where you create the virtual DASYLab experiment setup (the 
worksheet). It consists of the module symbols and the data channels connecting 
them. 

You can install modules in the worksheet either by choosing them from the 
Modules menu or by clicking the corresponding icons on the Module Bar. 

Data channels must then connect these modules. Every module input must be 
connected before you can start the worksheet. You do not have to connect every 
module output. 
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A worksheet can contain up to 256 modules. The maximum size of a worksheet 
in pixels is 2000 (vertically) by 2000 (horizontally) regardless of the screen reso-
lution. 

The size of the worksheet segment that is actually displayed in the workspace on 
your screen depends on your display adapter. The area available for a worksheet 
is much larger than can be displayed on screen at one time.  

� You can pan the window over the full worksheet by using the scroll bars. 
You can also use the SPACE bar. The cursor will change into a MOVE 
cursor within the worksheet area. You can now pan the worksheet just by 
using the mouse. Press the SPACE bar again to switch to normal mode. 

� You can drag any module symbol to any location in the worksheet by plac-
ing the mouse pointer on it, and pressing and holding down the left mouse 
button while moving the mouse. If you touch the window border while do-
ing this, the worksheet display will scroll until you release the mouse but-
ton, placing the module symbol at the new location. 

� You can move a group of modules together if the data lines do not have any 
data branches. Click and drag the mouse to draw a selection frame around 
the modules. All modules within this range will be marked and can be 
moved together. Use Ctrl-Click to deselect modules that you do not want 
to move. 

To Display More of Your Worksheet 
� Remove the Function Bar and/or the Module Bar from the DASYLab win-

dow. Choose these options from the View menu, or press ALT, V, F or 
ALT, V, M. 

� To view the complete worksheet in a separate window, choose the Over-
view option from the View menu, or click the corresponding icon in the 
Function Bar. However, you cannot edit or change it there. The display is 
automatically scaled to the size of the worksheet. 

� To enlarge the window to its maximum size, click the Maximize button in 
the upper right-hand corner of the DASYLab window, or choose Maximize 
from the Windows Control menu. The worksheet will fill the entire screen. 
Other Windows applications, such as the Program Manager, run in the 
background. After you enlarge the window, the Restore button replaces 
the Maximize button. Click the Restore button to return the window to its 
previous size. 

To Change the Appearance of the Worksheet 
� To change the grid, type of grid, or grid spacing of the DASYLab work-

sheet, choose the Window Setup option from the Options menu. 

� To change the colors of the DASYLab worksheet, choose the Colors option 
from the Options menu. 

� To change the colors of the DASYLab window frame, Menu Bar, etc., 
choose the Color option from the Windows Control Panel. 
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� Shortcut menu: you can right-click over the worksheet work area to display 
a contextual menu. You can change colors, switch to other modes, or dis-
play properties for this view. 

Worksheet Documentation Area 
You can insert information about the worksheet into text boxes that are shown 
on the background of the worksheet. Use the right mouse button to click on an 
empty area of the worksheet background and open a context menu that allows 
you to Edit, Create and Delete text boxes. You can insert up to 256 characters of 
text, change the font, or modify the background color/style. 

Use the left mouse click to move (“catch“ the upper left corner) or resize (“catch“ 
the lower right corner) the boxes. 

Open a New Layout Window 
Choose the New Layout Option from the Window menu. An empty window will 
appear. The Layout Window Function bar and Tool box are now available. 

You can place graphical objects and imported bitmaps on this worksheet. You 
can create links to visualization modules of the flowchart. Previously opened dis-
play windows stay open. 

To hide all elements of the worksheet, choose the View: Full Screen option. 
The Layout will be displayed, filling the complete screen. Open display windows 
are hidden. 

Since all control elements are hidden you can only start measurement by using 
the F5 key. To stop, use ALT+F5. ESC switches to the window mode of the 
VITool. 
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2.2. The Display Tree View 

 

Work Area: Tree View/ Display View 

The measurement setup is displayed in a structure similar to the Windows Ex-
plorer (32-bit version only). All elements of the worksheet are shown, starting 
with the layout pages, the modules and black boxes, and finishing with global 
setup, including global strings and variables. When you click on one of the tree 
elements, the next branch opens or the appropriate Dialog box opens. 

Shortcut menu: you can right-click over the worksheet work area to display a 
contextual menu. You can change colors, switch to other modes, or display 
properties for this view. 
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2.3. The Control Sequencer Window 

 
To control a multi-step application consisting of more than one DASYLab 
worksheets calling each other, DASYLab offers a new tool, shown as new display 
window (analogous to the worksheet, display and VITool windows), called the 
Control Sequencer Window. The contents of the window is stored in a new type 
of file, the Control Sequencer file (saved with the suffix *.DSQ.) 

The window shows a tree display of the control sequence. You can add any 
number of worksheets into the Control Sequencer File, whose name is shown as 
root of the tree.  

You can also multiple actions for each inserted worksheet to control the flow of 
the worksheets.  

In the Control Sequencer window you can load and save *.DSQ files using the 
main menu file commands: New, Open, Save and Save As…. 

To insert flowcharts or actions you need to use the pop-up context menu that 
appears when you right mouse click on one of the junction points on the screen. 
Depending on the junction (flowchart or action) the pop-up menu offers several 
commands to add, delete or to edit the object. 

Ö The Sequence file is a binary file type. You cannot edit it with ASCII Editor pro-
grams such as Notepad. 



DASYLab® The DASYLab Screen 

 3-13 

Work Area: Control Sequencer View 

The window shows a tree display of the control sequence. You can add any 
number of worksheets into the Control Sequencer File. The Control Sequencer 
filename is shown as the root of the tree.  

Also you can define several actions for each inserted worksheet to control the 
flow of the worksheets.  

In the Control Sequencer window you can load and save *.DSQ files using the 
main menu file commands: New, Open, Save and Save As…. 

To insert worksheets, simply right mouse click on the root symbol to open the 
context menu. The new flowchart command opens the standard explorer win-
dow dialog box to select any flowchart. If there is a flowchart already inserted, 
the context menu offers additional items to handle flowcharts and actions (in-
sert, delete…). 

You cannot load and start another worksheet using an Stop Measurement => 
Load and Start ("next worksheet.DSB") action in the sequence, because the ac-
tion stops the complete experiment and restarts the whole sequence. 

To get the desired result, use a global variable (e.g.Variable 1) with a determined 
value (e.g. 5) and use the action in the Sequencer: 'Rising edge->(${VAR_1}) => 
Load and start (...)'. This technique does not stop the experiment and the correct 
worksheet is loaded and starts. 

Control Sequencer Flowchart Junction  
You can add any number of worksheets into the Control Sequencer File. The in-
serted flowchart is shown as new flowchart junction. 

Double-click on the junction or select the Comment Flowchart context menu 
command to add or edit a description of the junction. 

Control Sequencer Action Junction  
You can add any number of actions to each flowchart in the Control Sequencer 
File. The inserted actions are shown as new branch of a flowchart junction. 

Each action will be processed if the defined condition is fulfilled. The conditions 
depend on the settings of global variables or strings or are global events such as 
Start/Stop of measurement. All global actions are allowed.  

Double-click on the junction or use the Edit Action context menu command to 
modify the action 

Sequencer Action Dialog 
You can edit the actions assigned to each flowchart in the control sequence file. 
The Action selection field offers all global actions. The dialog box may change 
depending on the action you have selected. Functions that control changing val-
ues are always assigned to global Variables (Event Parameter: Variable No set-
ting.). 

Function The action is initiated... 
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Rising Edge: When the variable changes from TTL Low 
(value 0) to TTL High (value 5). 

Falling Edge: When the variable changes from TTL High (5) 
to TTL Low (0). 

Threshold Overflow: When the variable rises above the specified 
threshold value. 

Threshold Underflow: When the variable falls below the specified 
threshold value. 

TTL High Level: When the variable is TTL High (5). 

TTL Low Level: When the variable is TTL Low (0). 

Input larger than Threshold: As long as the variable value is larger than the 
threshold value. 

Input smaller than Threshold: As long as the variable value is smaller than the 
threshold value. 

Start/Stop of Measurement: At the beginning and/or at the end of the 
measurement. 

Global String has changed: If the named global string has changed during 
measurement. 

Input value has changed(+/- 0.0 If the variable value has changed  

Value is reached (+/- 0.001%): If the variable reaches the defined value. 

Always: The action is constantly initiated. 

Never: The action is never initiated (NOP). 

Ö Global variables and strings are always saved with the corresponding flowchart. In 
exactly the same way, the Global Variables and Strings used in the event-driven 
actions in the sequence window are stored in the worksheet file of the corresponding 
flowchart where the action is defined in the sequence. If the variables or strings are to 
be used in other flowcharts you must save them using the actions Write 
String/Variable to INI file and Read String/Variable from INI file to save and re-
load the values separately. 

You will find more information about Event driven Actions parameters in the 
Action Module description. 

Control Sequencer File  
The Control Sequencer file stores all settings made in the tree. You can add any 
number of worksheets into the Control Sequencer File.  

You can define several actions for each inserted worksheet to control the work-
sheet flow.  

The Control Sequencer files (*.DSQ) can be loaded and saved using the main 
menu file commands: New, Open, Save and Save As…. 
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Sequencer Comment Dialog 
This dialog is used to add an additional description to each flowchart in the se-
quence file. The description is linked in the Control Sequencer mode to the 
name of the corresponding flowchart. 
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2.4. The Layout Window 

 

Work Area: Layout Window 

The DASYLab Visualization tool (VITool) allows you to connect a bitmapped 
graphical object with the active Elements of the Layout Window, so you can 
generate a practical on-line display of relevant data values. You can use technical 
worksheets or pictures as background and place the Display Windows of DASY-
Lab on the screen. Status Lamps, for example, are symbols of running engines, 
Digital Meters show rpm, and Bar Graphs can look like thermometers - all to 
give you quick information about the temperature of a vessel or the status of 
other parts of the plant. 

You can create up to 200 Layout Windows for each worksheet window using the 
main menu option window. The size of the working area can be specified in one 
of several DIN formats or adapted to the screen size. The zoom function allows 
you to scale parts of the screen for better handling. 

Full size mode allows you to hide all functional elements such as the Function 
Bar, Title Bar, etc. This mode is very useful for Online Presentation where you 
want to display only the custom designed display, not the program elements. 
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Work Area Layout Window 
The work area is where you create a Layout belonging to the DASYLab experi-
ment setup (the Worksheet). The size of the worksheet segment that is actually 
displayed on your screen varies depending on your display adapter. In any case, 
the area available for a worksheet is much larger than can be displayed on screen 
at a time. You can use the scroll bars to pan horizontally and vertically around in 
the worksheet. You can also use the SPACE bar. The cursor will change into a 
MOVE cursor within the worksheet area. You can now pan the layout just by 
using the mouse. Press the SPACE bar again to switch to normal mode. 

You can create objects in the work area either by choosing them from the Object 
menu or by clicking the corresponding icons on the Tool Box. These objects are 
placed onto the worksheet by drawing a frame with the mouse. Linked objects 
are connected to Display Modules of the Worksheet. You can scale or move ob-
jects on the worksheets  

Shortcut menu: you can right-click over the worksheet work area to display a 
contextual menu. You can select objects to add to your layout, switch to other 
modes, or display properties for this view or the layout page. 

New Layout 
Window Menu Command: New Layout 

Use this command to create a new Layout window. Up to 200 Layout sheets can 
be created with 512 Layout objects. The name of worksheet and the first nine 
Layout windows are displayed below the menu commands. If there are more 
than ten windows you can use the more command to see them. 

Properties of the Layout Page 
Double-click with the left mouse button on an empty part of the Layout Win-
dow, or, use the Properties Object Menu Command to view the Properties Dia-
log Box. 

Tool Box 

When a Layout window is active, the Tool Box will also be shown. Select a tool 
by clicking on the Symbols. 

The following tools are available: 
� Selection Tool  

� Line 

� Rectangle (filled or not filled) 

� Ellipse (filled or not filled), 

� Bitmap, 

� Text Line, 

� Text Block, 
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� Linked Text 

� Linked Graph 

Creating a new Layout Object 
Select an object type using the menu or the ToolBox. Draw a frame of the de-
sired size. You must create a frame when using a Text Object. The object will be 
inserted into the frame. To set the object’s properties double click with the left 
mouse button on the object to open the Properties Dialog Box. 

The size and position of objects may be changed using the mouse or by using the 
keyboard. To move the object just use the arrow keys, to resize the objects use 
CTRL+ arrow key. The degree of movement and scaling depends on the settings 
in VITool page setup. 

Types of Objects: 
� Drawing Elements: You can create Lines, filled and unfilled Rectan-

gles or Ellipses. You can import Bitmaps. 
� Visualization: You can create Linked Elements that import strings 

(Linked Text) or Graphs (Linked Graph) into your Layout Window. 
� Text Elements: Text frames with Line or Block Text can also be inte-

grated into your Layout. The text itself can be edited in the Properties 
dialog box 

Working with Layout Objects 
A single mouse click will select the object. Now you can resize or move it. Back-
space will delete the selected object. 
A single mouse click with the right mouse button on an object opens a pop up 
menu. (You cannot change objects while the measurement is running.) Double 
mouse click on the object to open the Properties dialog box for that object. 

Creating an Object 
Select an object type using the menu or the ToolBox. Draw a frame of the de-
sired size. You must create a frame for a Text Object. The object will be inserted 
into the frame. Open the Properties dialog box by double clicking the left mouse 
button on the object.  

Passive Elements 

In the DASYLab Layout Window there are some objects that are created on the 
worksheet although they don’t have a direct connection to modules on the work-
sheet. These passive elements are simple graphical objects such as lines, circles, el-
lipses (filled or unfilled), or text. Position, size and color are freely selectable for 
each element. You can modify other properties for each element, too. Passive 
elements are useful to create an attractive layout page design. Block text with 
scaleable font size is useful to display information about the layout (for example, 
the measurement parameters). 
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You can also specify the text line object: Using field placeholders, you can insert 
the current time, date or other system information. 

Active Elements 

Another group of objects shows the unique features of the VITool. These active 
connected objects create a direct link with modules on the DASYLab worksheet. 
Information that is displayed in the display window of the visualization module 
can be integrated into the Layout Window and can be dynamically updated as 
the data changes. The VITool is a perfect instrument to create an online data ac-
quisition and visualization setup that reflects your ideas and creativity. Available 
active elements are linked with graphical and text objects. 

Linked graphical objects import graphical information from the display windows 
of visualization modules into a Layout Window. You can show the curves of Y/t, 
X/Y or Recorder module as well as the display of Analog, Digital Meter or Lamp 
and Bar Graph or you can display an alert message from the Message module. 

A special feature links an object to the Switch module: You can show the state of 
the switch and operate the module from the Layout Window. This allows you to 
interact with the measurement when the Layout Window is in full screen mode. 

Functions in the Display Windows in VI-Tool 
Linked graphical objects also offer additional options in display: 

� To Zoom and unzoom the contents of the display: 

� Zoom in: CTRL key and drag; 

� Zoom out: CTRL key and right mouse click. 

You can perform the zoom in function multiple times. The zoom out function 
has only two steps: first to the previous zoom, then back to the unzoomed dis-
play. 

If there are cursors shown in the display window in the worksheet or tree view, 
they are also shown in the linked object in VI-tool. The cursors can be moved 
with the mouse directly in the layout. If you want to display the cursor data on 
your layout page you must activate the Survey menu command and select Print 
Cursor data in VI-Tool in the display window menu.  

Graphics 

The DASYLab VITool allows you to import bitmapped graphics objects and use 
them as background in the Layout Window. You can use plant flowcharts and 
other pictures as background in the Layout Window and you can place other 
passive or active elements over them. For example, status displays placed over 
machines show activated engines, a Digital Meter shows their rotational speed, 
Bar Graphs shaped as thermometers quickly inform you of the temperature of 
several parts of a plant. You can even insert your own logo into the layout. Only 
the reference address of the picture files (*.BMP and *.WMF format only) are 
saved with the worksheet or with the layout file. The original picture file must be 
separately saved in the correct directory to be displayed in the Layout Window. 
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ª You cannot use pictures and drawings created by CAD programs. You must first 
convert the files into .BMP or .WMF format using appropriate conversion soft-
ware.  

2.5. VITool Toolbox 

 

The Layout Window Toolbox allows you to 
quickly select a Layout Window Drawing 
Object. 

2.6. Title Bar 

The Title Bar is the upper border of the DASYLab window and shows the name 
of the application (DASYLab) and the file name of the current worksheet. If the 
current worksheet has not yet been saved, “Untitled” appears as a placeholder. 

2.7. Menu Bar 

 

Below the Title Bar, the Menu Bar lists the Main Menu Options. Each menu 
contains a list of commands or actions. You can open each of these lists by click-
ing the Main Menu Option on the Menu Bar with the left mouse button, or by 
pressing the ALT key and then typing the letter that is underlined in the Main 
Menu Option. 

In the picture above, you can see the list of Options menu commands. 

You can then choose an option from that list by clicking it, or by typing the let-
ter that is underlined in the menu item without pressing the ALT key, or by us-
ing the arrow keys on your keyboard and pressing ENTER. The display field in 
the left half of the Status Bar will often contain information describing the cur-
rent menu item. 
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In the picture, the Wire Sleeve option from the Colors submenu is selected 
(highlighted). Click it, or press the ENTER key, to carry out that command. 

The following Windows menu conventions provide additional information 
about the menu items. 

� An ellipsis (…) following a command indicates that a dialog box ap-
pears when you choose that command. There, further options must be 
selected before the command can actually be carried out. For example: 

Output Setup… (Experiment menu) 

� A triangle ( ) next to a command indicates that a cascading menu ap-
pears when you choose that command. That submenu contains fur-
ther commands. For Example: 

Module Bar  (Edit menu) 

� A check mark (9) next to a command means that the command is al-
ready in effect. After selecting that command again, the command is 
no longer in effect, and the check mark disappears. For example: 

9 Auto Start  (Experiment menu) 

� Dimmed commands cannot be used at the current time. For example, 
another command must be chosen first to enable that command. For 
example: 

Stop  (Experiment menu) 

Stop is only available after Start is chosen, and vice versa. 

� A key combination next to a command is a shortcut for the command. 
To use your keyboard instead of your mouse, the key combination has 
the same effect as clicking, or choosing, the command from the menu 
list. For example: 

Pause CTRL+F6 (Experiment menu) 

ª The icons on the Module Bar and on the Function Bar also represent menu 
functions. Clicking these icons with the left mouse button is the easiest and 
quickest way of choosing a menu command. 



Creating an Experiment Setup  

3-22   

2.8. Module Bar 

The Module Bar, at the left of the DASYLab window, displays a selection of 
frequently required modules in icon form. The size of the Module Bar de-
pends on the screen resolution of the computer’s display. 

Use the left mouse button to click on the icon that symbolizes the module 
you want to add to your worksheet. 

There are only a limited number of spaces on the Module Bar; therefore 
not every available module can be displayed on the Module Bar. You can 
customize the Module Bar to display only the modules that are needed 
most frequently. 

Module Type Display 

The name of the module the mouse pointer is pointing at is displayed when 
you hold the mouse cursor over one of the module bar icons.  

Module Bar Configuration 

You can select which modules are displayed as icons on the Module Bar. 

Click on a square in the Module Bar with the right mouse button to assign 
any of the modules available in DASYLab to that square. A dialog box ap-
pears presenting the complete list of modules including their Module Bar 
icons. 

� Scroll through the list using the scroll bar or the arrow keys on 
your keyboard. 

� To quickly select a module in this list, type the first letter of its 
name to move to the first matching module. Type the letter again 
to move to the next module that starts with that letter.  

� Click the Help button to obtain information on the selected 
module. 

� Choose OK, or press ENTER, to install the selected module on 
the Module Bar. The Module Bar will now display the new icon.  

 

Saving a Module Bar Configuration  

You can customize several Module Bars for individual experiments. 

� All of the Module Bar settings are automatically saved together with 
information about the window size and position when you exit the 
program. When you start DASYLab the next time, you will find the 
same work environment as before. 
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� In addition the settings are saved with the worksheet file when you 
choose the Save or Save As… commands from the File menu. 

� You can individually save your customized Module Bars to files and 
open them when you work with similar tasks or you can open the De-
fault Module Bar provided by DASYLab. 

Use the Module Bar command in the Edit menu: 

New provides a blank Module Bar to be configured individu-
ally. 

Open… opens a saved Module Bar configuration onto the DA-
SYLab screen. 

Save As… saves the current Module Bar configuration to a file un-
der a name of your choice. 

Default opens the default Module Bar configuration onto the 
DASYLab screen. 

Basic Displays a limited number of modules, suitable for be-
ginners 

Intermediate Displays more modules, appropriate for experienced us-
ers 

Advanced Displays modules appropriate for “power users.” 

For details about these menu functions refer to Chapter 4 of this man-
ual. 

Removing the Module Bar 
To enlarge the display area for your worksheet, you can remove the Module Bar 
from the screen. The visible worksheet then extends to the left border of the 
DASYLab window. 

Use the Module Bar command from the View menu to hide and to redisplay the 
Module Bar. A check mark (9) indicates that the Module Bar is displayed. 

After you have hidden the Module Bar, you can still install modules by using 
Module menu commands. To install a Signal Generator module, for example, 
select Control from the Module menu, then choose Generator, or press the ALT, 
M, C, and G keys. 

2.9. Function Bar 

 

The Function Bar, below the Main Menu Bar of the DASYLab window, displays 
a selection of icons that provide easy access to menu functions often used during 
experiments or functions assigned by the user (buttons 1…8 at the right side of 
the Function Bar ). Use the left mouse button to click on the icon that repre-
sents the desired command.  
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When the mouse pointer is pointing at a Function Bar icon, a tag with the name 
of that function will appear. (You will find QuickInfo in all of the module win-
dows that provide a Function Bar.) 

Function Bar Configuration 
The configuration of the Function Bar is fixed. You cannot change it by remov-
ing or adding any icons. 

The following table contains a list of the icons included and the menu com-
mands they represent. For further details about the menu functions themselves 
refer to Chapter 4 of this manual. 

Icon Menu Command Function Shortcut 

 
Experiment Start Start experiment F5 

 
Experiment 9Pause Pause/Resume experiment 

(toggle) 
CTRL+F6 

 
Experiment Stop Stop experiment CTRL+F5 

 
File New 

Clear worksheet to create a 
new worksheet  

 
File Open… Open worksheet file  

 
File Save Save worksheet to file  

 
Experiment Time Base Set up different time bases  

 
Experiment Experiment 

Setup 
Set general experiment pa-
rameters (dialog box) 

 

 
Experiment Hardware 

Setup 
Set hardware-specific pa-
rameters (dialog box) 

 

 
File File Info… Open File Info dialog box  

 
Windows Control  

Sequencer 
Switch to Control Sequencer 
mode 

 

 
Windows Display  

Windows 
Switch to Display Window 
mode 

F3 

 
Windows Worksheet Switch to Worksheet mode F3 

 
Windows Layout Switch to VITool Layout 

Window mode 
F4 

 
Edit Cut 

Cut the marked object and 
copy it to the Windows 
clipboard 

 



DASYLab® The DASYLab Screen 

 3-25 

Icon Menu Command Function Shortcut 

 
Edit Copy 

Copies selected Worksheet 
part or Layout object to 
clipboard 

 

 
Edit Paste 

Inserts contents of clipboard 
into Worksheet or Layout 
Window 

 

 
View Make Invisible Hide all the display windows   

 
View Make Visible Show all the display windows  

 
View Minimize Minimize all the display 

windows 
 

 
View Restore Restore all the display win-

dows 
 

 
Edit 

To Preceding 
Black Box  
Level or 
Back to Main 
Chart 

Leave the Black Box, return 
to preceding worksheet level 
(or to the main chart). To 
enter a Black Box, double-
click its module in the work-
sheet. 

 

(list) View Select Window 
Arrangement 

Re-arrange display windows 
into one of the ways you have 
saved 

 

 
Help Help Display DASYLab Online 

Help options 
 

Performs any command 
assigned to the specific cus-
tom button (user defined) 

 

User Defined Function Buttons 

All four of the DASYLab Views allow you to define 8 Function Buttons to exe-
cute any of the available functions and commands. 

Each button is identified with color if it has been configured to execute a func-
tion and that function is available in the current view. Each main window uses 
its own color: 

Button (yellow) in Sequence Control Window:  

Button (blue) in Tree-View Window  

Button (green) in Worksheet Window:  

Button (purple) in Layout Window:  
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Right mouse click on the desired icon to display the menu opens. Select New 
Command… to change the setting for this button. A dialog box shows a tree 
view of the complete list of all available commands.  

 

Click the + sign before an item to open the branch to view the commands at the 
next level. Click the – symbol to close the branch. 

Click the desired command to assign the command to the selected button. The 
item will show in blue to indicate that the function now is directly available us-
ing a button. To assign that function in all display windows to the same button 
use the check boxes at the bottom of the dialog box. If the selected function isn’t 
available in one of the main windows (e.g. the Action list command isn’t avail-
able in the VITool) the check box is not available.  

 

Click the OK button to confirm the selection and to close the dialog box.  

Reset Button: The Reset button deletes the assignment of commands to the se-
lected Button. The button now appears grayed out to show there is no command 
assigned to it.  

Removing the Function Bar 
To enlarge the display area for your worksheet, you can remove the Function 
Bar from the screen. The visible worksheet then extends to the Menu Bar of the 
DASYLab window. 

The Function Bar command from the View menu enables you to hide and to re-
display the Function Bar. A check mark (9) indicates that the Function Bar is 
displayed. 
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After you have removed the Function Bar, you can still use any function by se-
lecting it from the menu. To start an experiment, for example, choose Start from 
the Experiment menu, or press the ALT, X, S keys, or press F5. 

2.10. Status Bar 

The Status Bar at the bottom of the DASYLab window provides the following 
information: 

� On the left of the display you will find an explanation of the menu 
function you have selected on the Menu Bar. 

� The status bar on the right displays the progress of operations, for ex-
ample, of the Autorouter function arranging data channels, or, during 
experiments, the driver buffer status. 

If the bar turns red, this indicates that the acquisition rate is too fast to 
collect data continuously. Left of the driver buffer indicator there is a 
small indicator for lost samples. Many drivers acquire data using inter-
rupts. Some boards allow DASYLab to check whether the program has 
processed all interrupts. A yellow flashing light indicates that some in-
terrupts have been missed. For more detailed information see the 
hardware help. 

� The current time is displayed on the far right. 

2.11. Display Windows 

Display Windows of the Display modules show data samples in various graphical 
ways. You can choose X/Y, Y/t Chart, Chart Recorder, Bar Graph, Digital or Ana-
log Meter. You can customize the appearance of Display Windows in many 
ways. 

Hiding and Showing Display Windows 
The modules from the Display module group consist of two parts: the module 
symbol in the worksheet, and a display window where the incoming data is visu-
alized. When a display module is inserted into the worksheet, the display win-
dow initially appears minimized.  

 You can restore each of the display windows contained in your work-
sheet individually by double-clicking its icon at the bottom of the 
computer screen, or by choosing Select Windows/Restore from the 
View Menu. 

 
You can restore all the minimized display windows contained in your 
worksheet simultaneously by choosing All Windows/Restore from the 
View menu, or by clicking this Function Bar icon. 

 You can minimize each of the display windows individually by clicking 
its Minimize button (in the upper right-hand corner of the dis-
play window). 
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You can minimize all the display windows contained in your work-
sheet simultaneously by choosing All Windows/Minimize from the View 
menu, or by clicking this Function Bar icon. 

You can hide a display window without minimizing it. Use the View 
menu command Select Windows/Make Invisible. You can hide mini-
mized display windows to make your work area easier to read. 

You can hide all display windows, including minimized windows, by 
clicking on the Hide button or choosing All Windows/Make Invisible 
from the View menu. 

You can show (un-hide) a hidden display window by choosing the 
Select Windows/Make Visible from the View menu. 

You can show (un-hide) all hidden display windows by clicking on this 
Function Bar icon, or by choosing the 36 

.All Windows/Make Visible command from the View menu. 

Window Arrangement 
This field shows the number and name of the current Window Arrangement. 
DASYLab allows you to save up to eight different Display Configurations to be 
used by the experiment: Switch to another arrangement by choosing the name 
displayed in the list. The Window Arrangement can also be switched using the 
Action module. 

While observing an experiment, with data being displayed on several instru-
ments, you may find it useful to save certain arrangements of these dis-
play windows (i.e., their sizes and positions on the screen). You can then easily 
restore any of these arrangements when it seems most suitable, and you can even 
switch between various window setups to compare different display modes. 

For these purposes, DASYLab provides the following menu commands: 

 Save Window Arrangement 

 Select Window Arrangement 

 Delete current Window Arrangement 
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3. Module Groups Overview 

DASYLab module functions are divided into ten Module Groups, each contain-
ing modules that perform related functions. 

The Module menu provides all the available module groups. Choose a module 
group from the Module menu to open a submenu with the list of the modules 
that belong to that group. You can select any of the modules listed by clicking on 
it. It is then placed on the worksheet as a module symbol. 

� The Input/Output and the Files modules provide data input and out-
put functions, including data archiving using the new Backup mod-
ule. 

� The Trigger Functions and the Control modules perform control tasks. 

� The Mathematics, the Statistics, the Signal Analysis, the Data Reduc-
tion and Add-On modules offer a large number of analysis, evaluation 
and calculation operations. 

� The Display modules provide several ways of displaying data. 

� The Black Box module allows you to store complete worksheet seg-
ments in one module as ready-to-use units. 

Input/Output Module Group 
This group provides all the function modules necessary to communicate with the 
data acquisition hardware, external devices and other programs. The modules 
Analog Input, Analog Output, Digital Input, Digital Output and Counter Input 
represent different functions of the data acquisition hardware, while DDE Input 
and Output implements DDE communication with other Windows applications. 
Serial Input and Output and the IEEE488 Interface modules represent the inter-
faces to the corresponding devices. 

Files Module Group 
This module group provides file reading and writing functions. It consists of 
Read Data, Write Data, Backup and ODBC Input / Output modules. 

Trigger Functions Module Group 
This module group contains the Start/Stop Trigger and the Pre/Post Trigger 
modules, which are used to control data flow in the worksheet depending on the 
acquired signal. The Combi Trigger allows you to detect a wide combination of 
signal changes. The Relay module is used in conjunction with the trigger mod-
ules to control the flow of data. 

Control Module Group 
This module group contains two different types of modules. There are four sig-
nal generating modules: the Generator can generate periodic or random signals; 
the Switch allows manual input of TTL low and high levels; the Slider is used to 
manually define an analog signal; and the TTL Pulse Generator will generate a 
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pulse of specific duration. The PID Control, Stop, Latch, and Time Delay mod-
ules may be used to control data flow within the worksheet. 

Mathematics Module Group 
This module group provides basic mathematical functions including Arithmetic 
and Trigonometry, Logic Operations, Linear Scaling, Thermocouple Linear-
ization, Interpolation, Differentiation/Integration and the general purpose For-
mula Interpreter. 

Statistics Module Group 
This module group provides several statistical calculations including standard 
deviation, min/max, mean values, and variance in the module Statistical Values. 
It also contains function modules for Histogram calculation, Counting and the 
calculation of Regression. 

Signal Analysis Module Group 
This module group contains several modules for signal analysis applications. It 
implements digital (IIR) Filters of different types, the calculation of FFTs, fre-
quency spectrum, amplitude and phase spectrum, Correlation functions and cep-
strum. Another module provides a number of different Window functions. Po-
lar/Cartesian coordinate transformation is now part of this module group. 

Data Reduction Module Group 
This module group contains different algorithms for data reduction including 
Averaging and Block Average, the selection of samples and blocks, and modules 
that allow you to combine and separate signals from different channels, includ-
ing Time Slice, Merge/Expand and Cut Block. 

Display Module Group 
This module group contains all the display modules. It includes the scope dis-
play (Y/t Chart), Chart Recorder, X/Y Chart, Analog and Digital Meters, Bar 
Graph, and List modules. 

Network Module Group 
The high-speed, TCP/IP network capable modules are available in this optional 
module group. Additionally, the DataSocket Import and Export Modules are in-
cluded here. 
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Special Module Group 
This module group contains Black Box modules to be “filled” with worksheet 
segments and with Export/Import modules which establish connections for data 
transfer between the main worksheet and the Black Box worksheet embedded in 
it. It also provides the Black Boxes that were saved to disk. Additionally, it in-
cludes modules that provide special functions, including the Action, Message 
and Time Base modules, as well as the Signal Adaptation module. 

Add-On Module Group 
When installed, the Add-On modules appear in the module menu. The follow-
ing modules are available: Weighting, Transfer Function and Convolution. See 
Module Reference Guide for details. 
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Chapter 4: Main Menu 

1. Worksheet Window Menu 

1.1. File Menu  

The commands of the File menu enable you to save, open and print worksheets, 
to manage your worksheet files, and to exit the program. Some of these functions 
can also be chosen by clicking on the corresponding icons on the Function Bar. 
The ellipsis (…) following a menu command indicates that a dialog box or sub-
menu will appear when the command is selected. 

 

New 

 
Open… 

 
Save 

 Save As… 

 
File Info… 

 Print… 

 Printer Setup… 

 Page Format… 

 Exit 

 Recently Used Worksheet List 

1.1.1 New 

 
Choose the New command from the File menu, or click this 
Function Bar icon to create a new worksheet. 

This command will open a new worksheet. If you have a worksheet open and 
have not saved it, you will be asked to: 

� save that worksheet before beginning work on the new one, 
� or to reject those changes, 
� or to recall the New command. 
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After creating the new worksheet you can save it to a file by selecting the Save or 
the Save As... command from the File menu. 
You can also click on the Save icon in the Function Bar to save the current file. 

1.1.2 Open… 

 
Choose the Open command from the File menu, or click this 
Function Bar icon to open a previously saved worksheet. 

If you have a worksheet open and have not saved it, you will be asked to save 
that worksheet before beginning work on the new one. 

After choosing the Open command you can select from a list of files using stan-
dard Windows dialog boxes. The default file extension for DASYLab worksheet 
files is .DSB. 

You can … 

� Open one of the files from the list directly by double-clicking the file 
name, 

� Select a different directory by double-clicking the directory name, 

� Select a different file format for the file display, or 

� Select a different drive. 

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from 
one field to another; select items from the lists by pressing ↑, ↓, SPACE and the 
ENTER key. 

In the File Name box you can define the filter for the file list. The default setting 
for the filter (∗.DSB) will create a list of DASYLab worksheet files, which usually 
have the extension .DSB. DASYLab can also load files with the extension *.DSA 
(DASYLab ASCII file). This format is used to exchange worksheet files between 
the 16 and 32 bit DASYLab versions. These files may have also other extensions 
such as *.txt, but to be interpreted correctly, the contents MUST follow the con-
ventions of the DASYLab ASCII file type. 

You can type a different extension, or use wildcards (like ∗.∗), to get lists of dif-
ferent groups of files. For example, you may do this if you have saved DASYLab 
worksheets with extensions other than .DSB. 
 

Ö DASYLab can only open files in its own .DSB or .DSA format, no 
matter what extension the files have. 

Ö If Password Protection is active, you will first be asked to enter the 
password unless you have already entered it. Without the correct pass-
word, the file will not be opened. 



DASYLab®   Worksheet Window Menu 

 4-3 

Ö When you save a worksheet, the current Module Bar configuration is 
saved with it. When you open a worksheet file, its Module Bar configu-
ration will replace the current one on your screen. If you prefer to retain 
the current configuration, disable the Replace Module Bar option in 
the Options menu. 

ªª You can specify a standard directory for DASYLab worksheet files in the 
Options menu. 

ª To create a new worksheet, select the New command from the File 
menu, or click the New icon in the Function Bar. 

1.1.3 Save 

 
Choose the Save command from the File menu, or click this Func-
tion Bar icon to save a worksheet. 

If you have created a worksheet without saving it to a file, the Save command 
will act like Save As… If this were a previously saved worksheet, the existing file 
will be replaced without further messages. 

The following settings are saved with the worksheet: 

� The current Module Bar configuration 

� All the entries in the File Info dialog box 

� All the entries in the Page Format dialog box 

� The settings for Display Window Arrangement 

� Text strings, with locations of where they were placed in the display 
window 

The following settings are not saved with the worksheet. 

� The settings for the Start/Stop at Time functions (Experiment menu) 

� The settings for the Auto Start function (Experiment menu) 

� The settings for the display of the Module Bar, the Function Bar and 
the Animation function (View menu) 

� The Options Menu settings for the Window Setup, Colors, the Auto-
router functions  

ª You can specify a standard directory for DASYLab worksheet files (Op-
tions menu command). 

ª To save the worksheet with a new file name, select the Save As… com-
mand from the File menu. 

Ö If Password Protection is active (Options menu, see page 4-48), the 
worksheet will be protected using the specified password. If a password has 
not yet been defined, you will be asked to specify it when the worksheet is 
saved. 
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ª To save the worksheet with a different file name, select the Save As… 
command from the File menu. 

1.1.4 Save As… 
Choose the Save As command from the File menu to save a worksheet under a new 
file name, in a different directory, or on a different drive. 

See the previous section for a list of the settings and parameters that will be saved 
together with the worksheet. 

After you have chosen the Save As… command from the File menu you can se-
lect the file name, the directory and the disk drive where the file is to be stored. 

� Type the file name in the File Name box. Note that the file name 
must be chosen in accordance with MS-DOS conventions. 

� If you do not type an extension, DASYLab will automatically add the 
standard extension (.DSB). DASYLab always saves worksheet files in 
its own format, even if you select an extension other than .DSB. 

� You can… 
… Select one of the file names in the list by double-clicking the file 

name. The file that was originally saved under that name will be 
replaced with the new worksheet. A warning message will first 
appear, asking you to either confirm the procedure or to cancel 
it. 

… Select a different directory by double-clicking the directory 
name. 

… Select a different drive for the new file. 

… In the List Files of Type box you can select the type of files (de-
fined by their extension) to be listed. 

… Save the file as DASYLab binary file (.DSB) or DASYLab ASCII 
format for interchange (.DSA). 

… Save the file as DASYLab worksheet documentation (.TXT or 
.HTML) 

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from 
one field to another; select items from the lists by pressing ↑, ↓, SPACE and the 
ENTER key. 

ª You can specify a standard directory for DASYLab worksheet files (Options menu 
command). 

ª To save the worksheet under its current file name, use the Save command from the 
File menu. 

ª To quickly save the current file, click the Save icon on the Function Bar. 
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Ö If password protection is active (from the Options menu), the worksheet will be 
protected by a specified password. If the password has not yet been defined, you will 
be asked to specify it when the worksheet is saved. 

Ö DASYLab always saves worksheet files in its own format, even if you select an 
extension other than .DSB. 

1.1.5 File Info… 

 
Choose the File Info command from the File menu, or click this 
Function Bar icon to display, enter, or modify information about the 
open worksheet. 

DASYLab will automatically provide the following fields. The user cannot mod-
ify these fields. 

Field Information 
Worksheet The file name of the current worksheet 
Created The date and time the worksheet was created 
Modified The date and time the worksheet was last saved to file 

You can add the following information: 
 
Field 

 
Information Max. Number of Characters 

Author Your name 50 
Company Your company 50 
Department Your department 50 
Title A descriptive worksheet title 80 
Info Text Additional informative text 4000 

ª To begin a new line in the Worksheet Info Text field, press CTRL+ENTER.  

To move from one field to the other, either use your mouse, or press the TAB or 
SHIFT+TAB keys. 

Click on the Clipboard button to copy all of the information to the Windows 
Clipboard. 

ª
All the File Info entries will be saved with the worksheet when you choose Save or 
Save as… from the File menu. The Author, Company, and Department informa-
tion is also stored in the DASYLAB.INI file.  

ª When you print a worksheet or the display of a module from the Display module 
group, you can include the information about Author, Company, Department, Title, 
and Worksheet file name from the File Info dialog box. Choose Page Format from 
the File menu to select the information you wish to include in the printing. 
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1.1.6 Print… 

Choose the Print command from the File menu. 

Choose Page Format from the File menu to select additional worksheet infor-
mation you wish to include on the printout, and to specify the page layout and 
page frames. 

Choose Printer Setup from the File menu to select paper size and paper source, 
orientation, printer resolution, and other specific settings for your active printer 
model. 

Ö DASYLab only prints to the default Windows printer. To use a different printer 
connected to your system, or to install and configure a new printer, choose the Print-
ers option in the Windows Control Panel. Refer to your Windows documentation 
for further information. 

1.1.7 Printer Setup… 

Choose the Printer Setup command from the File menu to select paper size and pa-
per source, orientation, printer resolution, and other specific settings for your active 
printer model. 

These settings are also valid when printing Layout Windows. You should pay at-
tention to the settings of the Layout Window, especially the page orientation. 

The options vary, depending on the printer you are using.  
� Change the specifications as needed. 
� To set options specific to your printer driver, choose the Options but-

ton, set the options as needed, and then choose the OK button. 
� For information about the printer-driver options, choose the Help 

button or press F1 while using the dialog box. 
� Choose the OK button. 

Some Printer-Drivers allow you to choose user defined page formats. If the 
minimum useable size (depending on the printer type) is under run, the printer 
will not print. So if your printer will not work, check the settings in printer dia-
log box and enlarge the size of page or use one of the preset page formats (e.g. 
A4, letter...) 

1.1.8 Page Format… 

Choose the Page Format command from the File menu to format printing. The set-
tings affect the following print commands: 

Printout of… Source module Print command from module menu 
Worksheet (Work area) File (Main Menu Option) 
Y/t chart Y/t Chart Display 
X/Y chart X/Y Chart Display 
Diagram Chart Recorder Display 
List of values List Display Edit 
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You can select additional information to include in the printout, and you can 
specify the page layout and page frames. 

The upper part of the dialog box mirrors the basic layout of the printed page. 

View port 
The actual information or display that is to be printed is indicated in the center 
of this area. Depending on the source module from which the printing will be 
activated, the worksheet, the graphic display, or the list of values will be posi-
tioned here. 

The final size of this area on the printed page is defined by the paper size, minus 
the selected paper frames, and minus the space required for any additional in-
formation. The actual display will occupy the entire page if you select no addi-
tional information. The more information you select, the smaller the space re-
maining for the actual display. 

Additional Information 
� In the text box and the check boxes above the View port area you can 

select the information that will be printed above the display at the top 
of the page. 

� In the text box and the check boxes below the View port area you can 
select the information that will be printed below the display at the 
bottom of the page. 

You can enter one text line of up to 80 characters in the text boxes. 

Select information already entered and saved elsewhere. 

� The Experiment Title, Author, Company, and Department will be 
printed as entered in the corresponding text boxes of the File Info dia-
log box from the File menu (see page 4-5). Commas will separate the 
printed information about Author, Company, and Department. 

� The date and the time of the printing will be printed at the position 
indicated by the Date/Time check box. 

� The Worksheet Name to be printed is the file name of the current 
worksheet. 

� When you select Description the worksheet file name will be printed 
when you print the worksheet itself. The Worksheet Info Text from 
the File Info dialog box will not be included in the printout. 

When you wish to print a graphic display or a list of values, the mod-
ule description printed will be the Description text box of the source 
module’s configuration dialog box. This dialog box appears when you 
double-click that module symbol on the worksheet. 

Page Frame 
Set the margins for the printed page. These are the distances between the paper 
edge and the printed area of the paper. The measurement system is always centi-
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meters. The default settings are 2.54 cm (one inch) or the values last saved with a 
worksheet. 

Printer… 
Click this button to select paper size, source, orientation, printer resolution, and 
other specific settings for your active printer model. This function is the same as 
the Printer Setup command from the File menu. 

Ö All the Page Format entries will be saved with the worksheet when you choose Save 
or Save as… from the File menu. 

1.1.9 Exit 
Choose the Exit command from the File menu to close DASYLab.  

ª You can also exit DASYLab by double-clicking the system control button in the up-
per left hand corner of the DASYLab window, or by pressing ALT-F4. 

If you have not saved or have changed the worksheet in the work area, you will 
be asked whether you want to save the changes or not, or cancel the exit request. 

The following settings are saved when you close DASYLab: 

� Size and position of the DASYLab window on your screen 

� The Module Bar configuration 

� The information about Author, Company, and Department from the 
File Info dialog box 

� The Autostart option (Experiment menu) 

� The Animation option (View menu) 

� The display settings of the Module Bar and the Function Bar 

� The Window Setup (Options menu) 

� The Color settings (Options menu) 

� The Autorouter option (Options menu) 

� The Password Protection option (Options menu) 

If there is a worksheet on the screen which you have changed since you last saved 
it, you will be asked to either save that worksheet now before exiting DASYLab, 
or to reject those changes or to recall the Exit command (Cancel). 

You can also exit DASYLab by double-clicking the system control button in the 
upper left hand corner of the DASYLab window, or by pressing ALT+F4. 

1.1.10 Recently Used File List 

The worksheets displayed as numbers 1 to 5 in the File menu contain the five 
worksheets worked on last. The list is automatically rebuilt when loading any 
worksheet and is stored when the program is closed. 
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1.2. Edit Menu  

The commands of this menu allow you to copy the DASYLab worksheet dis-
played on the screen to the Windows Clipboard and to configure the Module 
Bar according to your specific requirements. It also provides the functions neces-
sary to organize Black Box files. 

 Worksheet to Clipboard 

 
Black Box Module 

Save As… 
Load… 
Black Box Info 
Back to Main Chart / To Next Higher Black Box Level 

 Layout to Clipboard 

 
Layout 

Save As… 
Load… 

 
Module Bar 

New 
Open… 
Save As… 
Set to Default 

 Undo 

 
Cut 

 
Copy 

 
Paste 

 Delete 

 Search for Module 
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1.2.1 Worksheet to Clipboard 

 
Use the Worksheet to Clipboard command from the Edit menu, or 
click this icon on the Function Bar to create a Windows Metafile image 
(WMF/CLP) of the worksheet on the Clipboard. 

The worksheet is always copied to the Clipboard as displayed on screen, includ-
ing any changes you have made since last saving it. 

The worksheet background is not copied, even if you have selected a color and a 
grid for it. For further information on these options, see Customizing the DA-
SYLab Screen. 

The image on the Clipboard is automatically scaled to the size of the DASYLab 
worksheet. If the worksheet consists of only a few modules these will appear lar-
ger on the Clipboard than if you have used a large number of modules all over 
the worksheet. 

Use the Paste function provided in any Windows application (usually in the 
Edit menu) to transfer the metafile from the Clipboard to applications such as 
Paintbrush or Word for Windows for further use. 

1.2.2 Black Box Module 

Use the Black Box module to create worksheet elements frequently required in 
your experiments, integrate them into one module (the Black Box) and insert 
them into future worksheets as ready-to-use units. Similar to an integrated cir-
cuit, a Black Box module contains a portion of the worksheet. 

Use Black Box modules to implement standardized modules that perform cus-
tomized algorithms not provided by DASYLab. These menu commands provide 
all the functions necessary to organize Black Box files. 

For further information on the modules themselves, on how to create and edit 
Black Box worksheets, and on the corresponding Module menu commands refer 
to Module Reference Guide. 

Save As… 
To save a Black Box: 

� First, open the Black Box you wish to save. You cannot save a Black 
Box while the DASYLab main chart is active. 

� Make sure you have entered a Module Name and an ID Tag in the 
Black Box Info dialog box. 

� DASYLab can only list a Black Box file on the Module menu if a 
Module Name has been entered for that Black Box before saving it. 

� DASYLab can only install a Black Box icon on the Module Bar if an 
ID Tag was entered for that Black Box before saving it. 

Ö The Black Box Info dialog box will appear when you try to save the Black Box if the 
identifying tag is missing. 
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� Then choose Save As… from the Black Box Module submenu of the 
Edit menu. Specify the Name, Directory, and Drive of the file to be 
saved. DASYLab automatically adds its standard extension for Black 
Box files (∗.DBB).  

Ö If you save a worksheet containing a Black Box, a complete copy of the Black 
Box will be included with the worksheet. 

If you modify the original Black Box file independently, the Black Box saved 
with the worksheet will not be updated. To insert the new version first delete the 
previous Black Box version from the worksheet. 

The advantage to this system is that if you modify or delete the Black Box file, it 
will not cause errors in the worksheets incorporating (and possibly based on) the 
functions and settings of the original Black Box. 

Black Box Info 
Enter descriptive texts and identifying tags for the Black Box module. 

� The Module Name identifies the module symbol in the worksheet. 

• The Black Box module symbol in the main chart (or the preced-
ing worksheet level) displays its name in its Title Bar. 

• The first 20 Black Box files in the DASYLab directory (not the 
Worksheet directory!) automatically appear as menu items on the 
Black Box module submenu of the Module menu after the pro-
gram has been started. Their Module Names appear as menu 
commands. 

� Enter a short comment in the Description box to describe the 
functions implemented by the Black Box. 

� The ID Tag is a string of up to 3 characters that is used to identify the 
Black Box module in the Module Bar. The Module Bar icon repre-
senting that Black Box displays that tag. 

Ö A Black Box can only be saved if the ID Tag has been entered. The Black Box Info 
dialog box will appear when you try to save the Black Box if the identifying tag is 
missing. 

Back to Main Chart / To Next Higher Black Box Level 
You can insert another Black Box module in a Black Box worksheet. The mod-
ule can then contain a Black Box module, and so forth, down to any level. Thus, 
the worksheet becomes three-dimensional, with the Main Chart (the actual DA-
SYLab work area) and several subordinate Black Box levels, each one embedded 
into the preceding level. 

You can open any Black Box by clicking its module symbol on the worksheet; 
you can leave it again to return to the next higher worksheet by clicking this 
Function Bar icon, or by choosing the command from the Black Box Module 
submenu on the Edit menu. 
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The command can have two names: either Back to the Main Chart (if the current 
Black Box is an element of the Main Chart), or To Next Higher Black Box Level 
(if the current Black Box is itself an element of another Black Box worksheet). 

After a Black Box has been closed, the worksheet on the next higher level is dis-
played. 

Ö If you start an experiment from a Black Box worksheet, the program will first return 
to the Main Chart before acquisition begins. 

Ö You can enter a Black Box and activate its worksheet for editing by double-clicking 
its module symbol on the worksheet. 

By default the worksheet of a new Black Box has a blue background. Color set-
tings can be selected individually for each Black Box. Choose the Colors com-
mand from the Options menu to do so. 

ª Background color can be used as an indicator of the Black Box level. It will be 
easier to find your way through several worksheet levels without losing orienta-
tion by attributing a different background color to each of these levels. 

1.2.3 Layout to Clipboard/Layout as Bitmap to Clipboard 

Use this command to copy the Layout Window as a WindowsBitmap (BMP) or as 
aWindows Metafile (WMF/CLP) to the Clipboard. 

The layout is always copied to the Clipboard as displayed on screen, including all 
the changes made since last saving it. The Layout will not be modified. 

The size of the Layout Window in the Clipboard is automatically matched to the 
size of the area used on the DASYLab worksheet. If you arrange only a few small 
elements they will appear larger on the clipboard. 

Use the Paste function in any Windows application (usually in the Edit menu) 
to copy the metafile from the Clipboard to applications such as Paintbrush or 
Word for Windows. 

1.2.4 Layout 

Save as…  

Use this command to save a Layout Window with a new name or to place it into an-
other directory. 

You can select the file name, the directory and the disk drive where the file is to 
be stored. 

� Type the file name in the File Name box. (Note that the file name 
must be chosen in accordance with MS-DOS conventions.) 

� If you do not type an extension, DASYLab automatically adds its 
standard extension for Layout file names (∗.LAY). (DASYLab always 
saves Layout files in a specific format, even if you select an extension 
other than ∗.LAY.) 

� You can… 
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… Select one of the file names offered on the list by double-
clicking on the file name. The file will be replaced with the Lay-
out. 

… Select a different directory (double-click the directory name) 

… Select a different drive for the new file 

… You can select the type of files in the List Files of Type box (de-
fined by their extension) to be listed in the box above. 

If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to 
move from one field to another; select items from the lists by pressing ↑, ↓, 
SPACE and the ENTER key. 

ª You can specify a standard directory for Module Bar files (Options menu command). 
 

Load…  

Choose this command to load a Layout previously saved to a file. 

Type the file name in the File Name box. (Note that the file name must be cho-
sen in accordance with MS-DOS conventions.) 

You can… 

… Select one of the file names presented in the list by double-clicking on 
the file name. 

… Select a different directory (double-click the directory name),  

… Select a different drive for the new file. 

… You can select the type of files in the List Files of Type box (defined by 
their extension) to be listed in the box above. 

If you wish to use your keyboard, press the TAB or the SHIFT+TAB keys to 
move from one field to another; select items from the lists by pressing ↑, ↓, 
SPACE and the ENTER key. 

1.2.5 Module Bar 
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The Module Bar, at the left of the DASYLab window, displays a selec-
tion of frequently used modules in icon form. 

Use the left mouse button to click the icon for the module you want to 
add to your worksheet or select the module from the Modules menu. 
Since there are only a limited number of spaces on the Module Bar, not 
every module can be displayed. 

You can customize the Module Bar by clicking on a square in the Mod-
ule Bar with the right mouse button to assign any of the modules 
available in DASYLab to that button. You can customize a Module Bar 
for individual experiments. 

The menu commands provide the functions necessary to modify the 
Module Bar for your requirements and to organize the Module Bar 
files. 

New provides a blank Module Bar to be configured 

Open… opens a saved Module Bar 

Save As… saves the current Module Bar configuration to a 
file under a name of your choice 

Set to Default opens the default Module Bar 
 

ª To enlarge the work area for your worksheet, Remove the Module Bar 
from the screen. The visible work area will extend to the left border of the 
DASYLab window. Use the Module Bar command on the View menu to 
remove and to re-display the Module Bar (see page 4-37). 

After you have removed the Module Bar, you can still use all the modules 
by choosing the Module menu commands. 

Ö All of the Module Bar settings are automatically saved with information 
about the window size and position when you exit the program and 
when you choose the Save or Save As… commands from the File 
menu. 

New  

Choose this command to create a new Module Bar. The current Module Bar on the 
DASYLab screen will be cleared and you can assign the module of your choice to each 
button. 

Click on a square in the Module Bar with the right mouse button to assign any 
of the modules available in DASYLab to that button. A dialog box appears pre-
senting the complete list of modules including their Module Bar icons. 

� To select a module in this list, type the first letter of its name to move 
to the first matching module. Type the letter again to move to the 
next module that starts with that letter. 

� Click the Help button to obtain information on the selected module. 
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� Choose OK, or press ENTER, to install the selected module on the 
Module Bar. The Module Bar will now display the new icon. 

The Module Bar settings are automatically saved when you exit the program. 

ª To save a configuration permanently, or to configure several Module Bars for 
individual experiment tasks or users, choose the Save As… command from the 
Edit / Module Bar menu. 

Open… 

Choose this command to open a saved Module Bar. 

You can select the Module Bar file from a list of files presented in a dialog box, 
using the standard Windows conventions. The default file extension (.DML) 
will be used to create a list of DASYLab Module Bar files. 

Type a different extension here if you have saved DASYLab Module Bars with 
extensions other than .DML. 

Ö DASYLab can only open Module Bar files in its own DML format, no matter 
what extensions the files have. 

Ö When you open a Module Bar file, any modifications of the current Module Bar 
on the screen are lost, unless you have saved them using the Save As… com-
mand from the Edit / Module Bar menu. 

ª You can specify a standard directory for Module Bar files (Options menu com-
mand). 

Save As… 

Choose this command to save the current Module Bar on the DASYLab screen to a 
file. 

You can select the file name, the directory and the disk drive where the file is to 
be stored. If you do not type an extension, DASYLab will add the standard ex-
tension for Module Bar file names (.DML). 

ª You can specify a standard directory for Module Bar files (Options menu com-
mand). 

Set to Default 

Choose this command to open the default Module Bar configuration onto the DASY-
Lab screen. 

Ö The default Module Bar will be installed without further dialog. Any modifi-
cations of the current Module Bar on the screen will be lost, unless you have 
previously saved them. 

Ö The default Module Bar is not saved in a DML file but is saved internal to 
the program. Therefore, you cannot change its setup. 

The DASYLAB.DML file always contains the Module Bar configuration that 
was active when you last exited the program. 
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1.2.6 Undo 

Choose this command to undo the last autorouter operation (moving or connecting 
modules).  

Other worksheet changes like changing module settings, adding or deleting 
module input or output channels cannot be restored. Choose this function using 
the menu or by the ALT+Backspace key combination. 

1.2.7 Cut, Copy, Paste or Delete Flow Chart Parts 

Modules and module groups with connections can be deleted, moved or dupli-
cated. 

Selection: First select the modules: click and hold the left mouse button inside 
the worksheet and select the area by dragging the cursor across the area. When 
you release the mouse button, the selected modules are highlighted. You can se-
lect or deselect single modules by clicking the left mouse button on the module 
while pressing the SHIFT or CTRL key. 

Cut: To move modules around the worksheet, choose the Edit/Cut menu com-
mand or the SHIFT+DEL or CTRL-X key combinations. All connections to 
unselected modules are deleted. 

Copy: Choose the Edit/Copy menu command or the CTRL-INSERT or CTRL-
C key combinations. The selected modules will be inserted onto the worksheet 
with their channel settings intact. 

Paste: Paste the stored worksheet part by choosing the Edit/Paste menu com-
mand or by pressing SHIFT+INSERT or CTRL-V at any position on the 
worksheet. The mouse cursor changes after activating the insert mode. Choose 
the position where the selection should appear. The entire worksheet can be 
used. The window is scrolled automatically when the mouse cursor moves out-
side the window border. Once the mouse cursor is at the destination press the 
left mouse button to paste the cut chart modules into the worksheet, if there is 
enough room for the operation. The paste operation can be repeated. 

Ö You can use the cut and paste function to integrate worksheet parts into a black 
box, but references to those modules in Actions will need to be edited to reflect the 
new name. 

ª You cannot cut or copy hardware modules, including analog/digital inputs, out-
puts, counter modules or black boxes. 

1.2.8 Delete 

Choose the Delete menu command or the Delete key to delete the selected 
modules. 

1.2.9 Search for Module 

This function offers you an easy way to find each module used in complex work-
sheets. This menu item opens a list box, in which all used modules are listed (in-
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cluding their position in black boxes). Double mouse click on one of the listed 
modules to move to the module and mark it. This function is also available in 
the popup menu that will be open with a left mouse click on any empty area of 
the worksheet. 

The modules may be sorted by name, module type or by Black Box. 

Double click on one of the listed modules to move to the module and mark it. 
This function is also available in the popup menu that will be open with a left 
mouse click on any empty area of the worksheet. 

The Open Button at the bottom of the list window opens the Properties dialog 
box for the selected module. 

1.3. Module Menu 

Full details for each module are in the DASYLab Module Reference Guide, pub-
lished as a separate volume. 

1.3.1 Module Groups 

Use the Module menu functions to select any of the modules provided by DA-
SYLab to insert into your worksheet. 

Within the Module menu, select a Module Group. A Module Group is made up 
of a number of modules providing similar functions. The Module menu provides 
the following module groups: 

Input/Output  

Trigger Functions  

Mathematics  

Statistics  

Signal Analysis  

Control  

Display  

Files  

Data Reduction  

Network*  

Special  

Add-On**  

                                                                  

*  This Module Group is available only with DASYLab-Net 

**  This Module Group is available only with the purchase of the Optional modules. 
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1.3.2 Modules 

Choose a module group to display a submenu with the individual modules be-
longing to that group. Modules that are available in the DASYLab basic version 
or the full (+) version are indicated by symbols as described in Chapter 1 of the 
Module Reference Guide. 

Module Symbols 

A module represents a functional element in the DASYLab experiment setup 
(worksheet). A worksheet can contain up to 256 modules. Each Black Box mod-
ule can also contain up to 256 modules, including other Black Box modules. 

The functions symbolized by the modules provide all the operations required for 
an experiment, 
� From data acquisition (by a data acquisition board) or signal genera-

tion (simulated by a virtual generator) 

� To data analysis, evaluation and processing (mathematics, statistics, 
control, trigger and other functions) 

� Up to their presentation on screen (display instruments) or export for 
documentation purposes (printer, metafile, etc.). 

Each of the available modules in DASYLab is shown in two forms, both indicat-
ing the module’s function: Module Bar icons and worksheet symbols. 

A limited number of module icons can be installed on the Module Bar. They can 
be placed on the worksheet by a single mouse click on the Module Bar icon. Any 
module can be installed on the Module Bar, including Black Boxes that you 
have previously saved.  

ª You can configure the Module Bar according to your specific requirements. You can 
save various configurations to files for later use. For details, please refer to Chapter 4 of 
this manual. 

Installing Modules 

A module can be installed on the worksheet either by choosing it from the Mod-
ule menu or by clicking its icon on the Module Bar. Either way, the module will 
be placed on the worksheet as a module symbol. For modules that provide more 
than one basic operation, you must also select the function type. 

Choose a Module Group from the Modules menu to display a submenu with the 
individual modules that belong to that group. The submenus list all the modules 
currently available. You can select any of the modules by clicking on its name. If 
a module is not available in your version of the software it will be gray, and you 
will be unable to select it. 

A worksheet can contain up to 256 modules, including Black Box modules. 
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Configuring Modules 

Use the left mouse button to double-click on the module’s worksheet symbol to 
open the Properties dialog box to configure the module. The following parame-
ters can generally be specified in the dialog box: 

� The Module Name, 

� A short Description, 

� The number of inputs/outputs (up to 16 for most modules). 

Once you have activated more than one channel, you can select each of them to 
display and define specific channel parameters. 

Use the F7/F8 function keys to easily configure several channels for one mod-
ule. 

For specific module settings, please refer to the individual module descriptions. 
The general parameters are described in the Module Reference Guide. The spe-
cific module settings are described in the sections for each module. 

Connecting Modules 

A data channel is the connection between the output of a module and the input 
of another module. Data is transferred between modules via these connections. 

In the DASYLab work area, lines like the ones shown below show connections, 
which always connect the output and input symbols of the module symbols. By 
creating junction points and branches, you can connect each module output to 
up to 16 inputs of other modules. 

 

Data channel 

junction points and branches 

no connections 
For details on how to create, delete and rearrange data channels and branches, 
refer to Chapter 3 of this User’s Guide. 

ª While the experiment is running, you can hold the CTRL Key while you left click on 
the data channel to get further information about the connected modules. 

Moving Modules 

A module can be moved to any position on the worksheet by dragging and 
dropping its worksheet symbol. Click on the worksheet symbol with the left 
mouse button and, while holding the mouse button down, drag it to any posi-
tion. When the mouse button is released, the module symbol will automatically 
be aligned based on the spacing value entered in the Window Setup box of the 
Options menu. 
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Select Modules 

Click on the worksheet symbol with the left mouse button or draw a box around 
the module (or modules) while holding the mouse button down. All modules 
within the frame will be selected. 

Copy Modules 

Selected modules can be copied using the Main Menu command Edit: Copy.  

Paste Modules 

Selected modules can be pasted into the worksheet using the Main Menu com-
mand Edit: Paste. 

Deleting Modules 

Modules can be deleted by double-clicking the worksheet symbol with the right 
mouse button. This opens a dialog box allowing you to remove the module or to 
delete its input or output connections. Modules also can be deleted using the 
Edit command of the Main Menu. 

Search for Modules 

You can search for installed modules with the Search for Modules command. 
You can select the command from the Edit menu or from the dialog box that 
appears when you double-click on the worksheet symbol with the right mouse 
button. The Search for Modules command opens a list box with all installed 
modules and black boxes. When you double click with the left mouse button on 
the desired module, DASYLab jumps to the module icon in the worksheet. 

1.4. Experiment Menu 

The most frequently required commands from this menu can also be chosen by 
clicking the corresponding icons on the Function Bar or by using keyboard 
shortcuts (Hotkeys). 

 Start F5 Start experiment 

 Stop CTRL+F5 Stop experiment 

 9Pause/Resume CTRL+F6 
Pause or resume 
paused experiment 

 Start/Stop at Time…   

 Remote Control (DASYLab-Net only)  

 Auto Start   

 Select Driver…   
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 Hardware Setup…   

 Experiment Setup…   

 Time Base Setup   

 Serial Devices   

1.4.1 Start 

 
Choose the Start command from the Experiment menu or click this 
Function Bar icon, or press F5, to start an experiment. 

1.4.2 Stop 

 
Choose the Stop command from the Experiment menu or click this 
Function Bar icon, or press CTRL+F5, to stop an experiment completely. 
All pipes will be cleared of data. 

1.4.3 Pause/Resume Experiment 

 
Choose the Pause command from the Experiment menu or click 
this Function Bar icon, or press CTRL+F6, to pause the running 
experiment. (√ indicates that the experiment has been interrupted.) 

This command stops the acquisition of new data, for example from a signal 
generator module, an A/D or digital input module, a PID or manual control. Data 
already acquired and still in the pipes will be retained, however, and processed 
completely. 

The Pause/resume command is available only if the worksheet does not contain 
any module accessing the data acquisition hardware. The reason is that DASY-
Lab derives its own clock from the board's master clock. This is not available if 
the measurement is paused. To pause a running experiment, use the Stop mod-
ule. 

1.4.4 Start/Stop Experiment at Time… 

Choose this command to start, stop, and repeat an experiment at a specified time. 

The dialog box that appears provides three fields where you can specify the time 
at which an experiment is to start, the duration of that experiment, and the in-
terval after which that experiment is to be repeated. 

Select the function by clicking its option button: Start Experiment at Time, 
and/or Stop Experiment after Time, and/or Restart Experiment after Time. A 

check mark (9) next to the option button indicates that the function has been 
activated. 
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Then enter the time specifications: 

� Start Experiment at Time/after delay: Specify the time at which the 
experiment is to begin. The default setting is the current date and time 
plus five minutes. You may either type the values for the date, the 
hour, the minutes, and the seconds, or press the UP ARROW (↑) or 
DOWN ARROW (↓) keys to scroll, or choose the values from the drop-
down list. 

� Stop Experiment after Time: Specify the duration of the experiment. 
The default setting is five minutes.  

� Restart Experiment after Time: Specify the interval after which the 
experiment is to be repeated. There is no default setting for this inter-
val. When this function has been activated, the experiment will be re-
peated according to the specified data until you: 

o Stop the experiment, or 

o Deactivate this function by clearing the option button in this 
dialog box, or 

o Modify the current worksheet, or 

o Open or create another worksheet. 

While any of the Start/Stop by Time functions are active, a message is displayed 
on the status bar reminding you of the time at which an experiment is due to 
start or stop. 

Ö The settings specified here are not saved when you exit the program nor with the 
worksheet when you choose the Save or Save As… commands from the File menu. 

1.4.5 Remote Control (DASYLab-Net only) 

The Remote Control Dialog box allows you to define whether this computer acts 
as a Client or a Server. In Client mode (default) you can list all controlled servers 
by name. This option won’t appear in Server mode. See DASYLab-Net: Com-
munication with Other DASYLab Programs on page 5-11. 

1.4.6 Auto Start 

Choose Auto Start, indicated by a check mark (9), to prepare the experiment 
setup for an automatic start later on. Enter the DASYLab command followed by 
the worksheet file name (for example, in the DOS Command Line box of the 
Program Item Properties dialog box of the Windows Program Manager) to start 
the experiment directly. 

See Automatic Experiment Start in Chapter 6 for further details. 
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Ö This setting is automatically saved with information about the window size and 
position when you exit the program. The same configuration will appear the next 
time you start DASYLab.  

These settings are not saved with the worksheet when you choose the Save or Save 
As… commands from the File menu. 

1.4.7 Select Driver… 

DASYLab supports a wide range of data acquisition hardware from different 
vendors. You will typically need a different hardware driver for each manufac-
turer’s data acquisition hardware. If you have more than one hardware driver in-
stalled on your system you may switch between them using the Select Driver 
function. 

Note that only one driver can be used at a time. 

The Select Driver dialog box lets you select one out of the installed hardware 
drivers. The change only occurs after exiting and restarting DASYLab. 

If you do not see your hardware driver in the list, ensure that you have correctly 
installed the driver. 

1.4.8 Hardware Setup… 

 
If you have installed a data acquisition device in your system, you 
must set its parameters in this box. 

, The values entered here must correspond exactly to the configuration of 
your data acquisition hardware to ensure correct data processing by 
DASYLab. 

Choose the Help button, or press F1, or choose Hardware from the Help menu, 
to obtain help on the settings. 

If you have to exchange worksheets between several PC’s (as in runtime applica-
tions), you must guarantee that the selection and sequence of measurement in 
DASYLab is exactly the same as in your target PC. 

ª Read the Hardware Installation Manual for further information concerning in-
stallation and operation of your data acquisition device. 



Main Menu  

4-24 

1.4.9 Experiment Setup… 

 
Use this command to set the general parameters for data acquisition 
and measurement control. 

Together with the resources provided by your system and the size of the work-
sheet you have designed, these settings determine the overall data processing per-
formance as well as the response time of the individual functions. Available set-
tings are: 

� The Sampling Rate per Channel 

� The Global Block Size 

You can use Global Variables to define the sampling rate and block 
size settings. The variables are read once at the start of the experiment. 
You CANNOT use variables to change these settings while the ex-
periment is running. 

� The global settings for Analog Output and Digital Output 

� The Synchronization mode that determines the clock source for all in-
ternal data sources of DASYLab (Generator, Slider, etc.). The two 
modes available are PC Clock and Data Acquisition hardware. 

� Disk Streaming options  

� The Driver Settings, which contain - depending on the installed hard-
ware - the driver buffer size, the acquisition mode and the connected 
parameters Blocks per Series and Delay. 

ª To internally equalize measurement time and system time in the analog input, 
digital input and counter hardware modules, use the following settings: 

• Synchronization: PC clock 

• Sampling rate: ≤ 5 Hz 

• Block size: = 1 

Sampling Rate per Channel 

If you operate channels at differing sampling rates, enter the highest sampling 
rate here. The value entered here always defines the sampling rate for all the 
channels. You can specify whether this value represents Hertz, Kilohertz or 
Megahertz or minutes, seconds or milliseconds respectively. 

You can also use Global Variables to define the sampling rate and block size set-
tings. The variables are read once at the start of the experiment. You CANNOT 
use variables to change these settings while the experiment is running. 

If you wish to operate some channels at lower rates, you must reduce the data 
rate by using the Separate or Average modules. This procedure yields channel 
rates that are true divisors of the fastest rate (the global rate). 



DASYLab®   Worksheet Window Menu 

 4-25 

ª If you set a sampling rate which is too high for the data acquisition board type in 
your system, or if the overall sampling rate is too high because you have too many 
channels at high sampling rates, you will be alerted by DASYLab, either before 
exiting this box, or before exiting the Analog Channel selection box. The sam-
pling rate will automatically be rounded up or down to the nearest acceptable 
value. 
 

With many of the data acquisition boards supported by DASYLab, the board it-
self generates the sampling rate. It is possible to enter a value not supported by 
the hardware. However, DASYLab will automatically adjust the value. 

If you use interrupt-driven boards at acquisition speeds too high for the system, 
some interrupts and the corresponding samples may be missed. The indicator at 
the bottom left of the DASYLab window right to the buffer indicator shows 
whether DASYLab has detected such a situation. If this indicator flashes in yel-
low, interrupts have been lost, If the amount of lost samples is greater than 2%, 
the experiment is aborted. 

Some boards are not able to indicate lost interrupts by a hardware flag. In this 
case, DASYLab tries to look for lost interrupts by software. This software solu-
tion does not guarantee that all lost samples are detected. With these boards it is 
possible that samples are lost without any indication. 

Driver Buffer 

Use this option to specify the temporary driver buffer memory size for the hardware 
driver to use to store data.  

The hardware Driver Buffer temporarily stores data coming in from the data ac-
quisition hardware before the software processes it. The driver first stores the ac-
quired data to this buffer, and then DASYLab reads the data from the buffer. 

During time-consuming operations, such as moving windows on the screen, the 
driver continues writing data to the buffer, so that no data is lost. Data acquisi-
tion will be stopped when the buffer memory is full. You may see the error 
Sampling Rate too Fast when this happens. 

You can enter a driver buffer size between 4 Kbytes and 16,384 Kbytes. The de-
fault setting is 64 Kbytes. If the on-board memory resources of your computer 
are limited, enter a smaller value. You will be warned if the value you have en-
tered is not valid. 

Ö The board driver will use the memory buffer selected; neither DASYLab nor 
Windows can use it. 

Ö The buffer size should be increased if you use a high global acquisition rate. Note 
that the driver buffer setting should not exceed 50 to 75% of the total available 
physical memory. 



Main Menu  

4-26 

Block Size 

Use the Block Size to set the number of samples that will be processed by worksheet 
modules during a single processing cycle.  

Any value from 1 to 32768 can be entered here; powers of 2 are preferred. 

The input modules collect the specified number of samples before passing them 
on to other modules. 

You can also use Global Variables to define the sampling rate and block size set-
tings. The variables are read once at the start of the experiment. You CANNOT 
use variables to change these settings while the experiment is running. 

Computing the data in blocks increases the speed of the measuring process con-
siderably; but it strongly influences the real-time performance of the system. 
Therefore, the block size should be selected carefully, taking the following prin-
ciples into account: 

� For a high data transfer rate, but a long latency period where the re-
sponse time of subsequent modules, like control modules, is slower, 
use a large block size.  

� For a short latency period, where the response time of subsequent 
modules is faster, but the data transfer rate is lower, use a small block 
size.  

The actual data transfer capacity of a system depends upon many factors, there-
fore, a general formula for how to determine the ideal block size cannot be pro-
vided. 

Generally, fast data acquisition operations require large block sizes, while small 
block sizes work well for slow data acquisition and control operations. 

We suggest that you initially set the block size to half the sampling rate (the de-
fault setting), and then try out various other values to determine the best value 
for your individual task. 

Acquisition Mode 

The available Acquisition modes depend on the installed hardware and the modes 
supported by the driver.  

� Continuous mode: When continuous mode has been activated, indi-
cated by a check mark (9), the data will be acquired without interrup-
tion at the specified sampling rate and processed by DASYLab. 

� One Series: After the experiment start, the data will be acquired with-
out interruption at the specified sampling rate the amount of data de-
fined by the parameter Blocks per Series setting has been reached. 

� Running Series: This mode is a repeated one series mode. After the 
specified number of blocks the acquisition is interrupted for at least 
the time specified by delay. If the delay is too short for DASYLab to 
process the data, the acquisition is delayed for a longer time. 
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The display modules do not recognize the delays. That means that in 
this mode there is no correspondence of time of day for the data sam-
ples. They are treated as continuous in DASYLab. 

This mode is especially useful for fast scope applications. 

� Isolated Series: This is the same mode as the Running Series, except 
that DASYLab recognizes the gaps. The resulting data stream is not 
continuous. 

Quite obviously, this method leads to acquisition gaps between the 
blocks. Their size depends on the number of active channels, on the 
block size, on the complexity of the ensuing processing arrangement, 
and on the hardware resources. 
This mode may be useful in cases where a high sampling rate is essen-
tial, while continuous high-speed data acquisition and processing can-
not be realized, e.g. due to limited hardware resources. 

If you wish the acquisition to stop after a certain time, enter the corre-
sponding number of values in the Count field. (This value can be 
freely specified for each channel.) After that number of data has been 
acquired, the acquisition will be stopped automatically. (The default 
setting for this field - zero - means that the acquisition process is not 
supposed to be aborted when a certain number of values have been ac-
quired.) 

Analog Output and Digital Output 

Set the general output parameters for analog and digital output individually. 

Output Mode: The output mode determines whether the data samples are sent 
out synchronously with the acquisition rate or asynchronously, which means as 
fast as possible but in undetermined intervals. 

� In the synchronous mode, data samples are sent out according to the 
acquisition rate specified for each output channel. 

� In the asynchronous mode, data is sent out as fast as possible. The 
maximum rate depends on your hardware, the speed of your PC and 
the complexity of the worksheet. You should experiment with these 
rates to find out the best combination for your individual task. 

Output Buffer 

� If the Fill once option is selected, the output buffer will be filled only 
once, with the first block of data coming in after the experiment start. 
When the buffer is full, that first block of data will be sent out repeat-
edly, always beginning with the first data again. Any further values 
coming in from the worksheet will be ignored. 

� If Continuous refill is chosen, the output buffer will continuously be 
filled with the data samples coming in from the worksheet, and these 
samples will then be sent out. 
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� Output Rate: The output frequency defined in this list box only takes 
effect when the synchronous mode is selected. Only frequencies that 
are an integer divider of the global acquisition rate are allowed. 
Changing the global acquisition rate also affects the output rate. 

� Output Start: The value entered in the Output Start list box defines the 
number of samples that are to be collected before the analog output 
actually starts. This value must be the same as the global block size, or 
a multiple of it. This feature can be used for a defined delay or to syn-
chronize the values that come from the worksheet. 

Disk Streaming 

This option enables or disables the fast storage of measurement data samples as they 
are acquired. 

Disk Streaming provides the ability to write DASYLab data onto a mass storage 
media. Unlike the Save Data module that writes data of the data stream of up to 
16 data channels into a file, Disk Streaming stores the data of all channels in a 
highly compressed 2-byte integer format. The amount of required mass storage 
space is reduced and the time to write the data procedure is much faster since 
only a fractional part of the data is produced. Additionally, the conversion of the 
integer data of the driver into the floating-point data of DASYLab is skipped. 
This is the main reason why Disk Streaming can write data sampled at high Ac-
quisition rates to the mass storage device.  

ª No other channels should be connected to the A/D, Digital or Counter input mod-
ules, since this would significantly reduce the time advantage. 

Disk Streaming settings are made in the Experiment Setup dialog box. 
Disk Streaming can be enabled or disabled by checking the Active box. 

Select the File Name button to change the name of the streaming file. Then, a 
file selection window opens to enter a file name. 

Ö You can set the Default Directory for Disk Streaming files in the Options menu. 

Data samples are stored in the DASYLab data format (Universal Format 0). You 
can find a description of the data format in Chapter 6 of this manual. 
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Options 
� Warning if Channels are Connected: If this option is enabled, a warn-

ing message will be issued and the measurement is immediately 
stopped if channels are connected to the Analog, Digital or Counter 
Inputs. 

� Don’t Overwrite Existing Files: This option prevents overwriting an 
existing Disk Streaming file. The measurement is stopped immediately 
after starting. A message is displayed if a file with the specified name 
exists and would be overwritten. 

� Circular Buffer: This option implements an in-memory buffer, con-
taining the last n Blocks per Channel. 

Disk streaming files are read (as other data files) using the Read Data module. If 
the file to be loaded is a Disk Streaming file, the information Universal 0 is 
shown in the Data format text field of the dialog box of the Read data module. 
DASYLab data files written without Disk Streaming are stored in the Universal 1 
data format. 

Use the Channel group combo box to select which channels you want from the 
data stream: Analog 0 identifies the first 16 scanned analog channels, Analog 1 
the next 16 scanned analog channels and so on. The same applies to Counter X. 
For Digital port X the selected port will always be displayed, as it was saved with 
the original worksheet. 

Hints for Optimal Measurement Settings 

Block Size/Sampling Rate 
The performance of DASYLab depends primarily on the sampling rate and block 
size. 

The sampling rate controls the resolution of the received signal (data bytes). The 
block size affects the response time of the worksheet. The response time is de-
termined by the ratio of sampling rate and block size (S/B ratio). A poor setting 
causes data to accumulate in the driver buffer, shown by the Status Bar (the 
green/red bar lower right in the worksheet main window.) If the driver buffer is 
filled, DASYLab displays the “Experiment stopped. Sampling rate too fast!” er-
ror message. 

General Hints for Sampling Rate and Block Size 
In the data acquisition program the data is sent as data blocks via the connected 
data channels between modules. DASYLab works in a block dependent mode. 
Each module output has a 64 Kbyte buffer to hold the processed data. The 
module at the end of a branch periodically checks whether a data block is avail-
able in the buffer. If the answer is yes, the block is transmitted, processed and 
placed in the output buffer to be processed by the next module.  

Each block contains measurement data, called samples, and a block header. The 
header contains information about the block, including the data type, the start 
time of the block and the sample interval. The program calculates a time stamp 
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for each sample. Many modules verify the time stamp and data type to ensure 
that only samples with the same characteristics are processed together. 

Many multi-channel modules start processing data only if all inputs have data 
with the same time stamp. If there is no data at available one input, the module 
cannot process data at other inputs, and may start to block the data flow. 

The module input buffer will fill until it is full. Because that module is unable to 
process data, the buffer of the preceding module will be filled up.  
The end result is that several branches of a worksheet will stop to work.  

The first hint will be the “Animation bar” shown at each output in each module 
symbol. If the animation stops, the module is no longer processing data. De-
tailed information can be found in the channel debugger. Left click with CTRL 
key pressed on the data channel (with measurement running!). Important entries 
are “FIFO blocks” (max. buffer size) and “used” (buffer usage).  

If you use different kinds of data in a multi-channel module (sampling rate, 
block size or type of channel...), the module can't process the different samples 
together. DASYLab will show a message like “Time information or block size is 
different. These channels can't be processed together. ” and measurement stops.  

The response time of DASYLab depends mainly on the ratio of block size and 
sampling rate. 

� The block size defines how many samples are collected as a data packet 
and are sent as a block to subsequent modules.  

� The sampling rate defines how fast the data is generated or acquired 
by the data acquisition board. 

The resulting update interval of the worksheet depends on the fact that a new 
block will only be released and processed once it is filled with samples.  

The following example will show the context: 

The following response times are will be expected with different setting for block 
size and sampling rate.  

Block size Sampling rate (1/sec) Minimum response time 
(sec.) 

1 1 1 

1 1000 0.001 

1000 1 1000 

The smaller the ratio of block size to sampling rate, the more frequently the work-
sheet will refresh (Visualization/Display elements).  

Ö If you use too small a block size (e.g. 1) the message ”Measurement stopped. Sam-
pling rate too high” may appear, and the program stops! 

Explanation of Response Time 
When a new module is placed on the worksheet, it is placed in a module man-
agement list. The DASYLab dispatcher manages the distribution of CPU time to 
each module in that list. There is a physical speed limit that depends on the size 
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of the worksheet (number of modules and data channels) and the hardware con-
figuration of the PC, because the dispatcher has to process all modules during 
the refresh time. For example, take a worksheet with 100 modules/data channels 
and a sampling rate/block size ratio (S/B ratio) 1/1000. In this case, the dis-
patcher has just 1 msec to process 100 modules. Each module gets 10 µsec to 
process the received data. That time simply is too short, data will start to back 
up, and eventually the program will be halted!! An accurate examination of your 
experiment should define the sampling rate (resolution) of your measurement. 
The dispatcher’s cycle time is defined by the block size and parallels the time to 
process the acquired data. The block size also defines boundary conditions such 
as the refresh rate of the visualization elements, range of the FFT and so on.  

Ö In our experience it is advisable to select a S/B ratio from 1 to a maximum of 10. 

Ö DASYLab has the option to show the system capacity usage (ratio of needed CPU 
time and max. available CPU time). You can see at the start at the measurement 
whether your system has enough capacities to fulfill the requirements of the measure-
ment. 

Hints for the resulting amount of data 
The quantity of data to be transferred that loads the system also depends on the 
S/B ratio and increases with a rising S/B ratio. Each block of data includes a 
26 Byte sized Header that has to be transferred with each block. If you use a 
block size of 1, the block has 4 actual data bytes and 26 bytes Header data, caus-
ing the system to transport more overhead information than actual data. 

Example: 

S/B ratio: 1000 

Block size 1; Sampling Rate 1 kHz; 100 Data channels 

Data Bytes:4 Byte * 1000 Hz *100 = 400.000 Byte 

Header:26 Byte * 1000 Hz*100 = 2.600.000 Byte 

Sum: 3.000.000 Byte 

S/B ratio: about 2 

Block Size 512; Sampling Rate 1 kHz; 100 Data Channels 

Useful Bytes:4 Byte * 1000 Hz *100 = 400.00 Byte 

Header:26 Byte * 1000 Hz/512*100 = 5.078 Byte 

Sum: 405.078 Byte 

The same principle has to be considered when storing data to hard disk when us-
ing the DASYLAB file format. Long duration measurement sessions with small 
block sizes may create unexpectedly large files. For low speed, long duration files, 
consider using the ASCII or IEEE32 file formats to minimize file size. You may 
want to experiment with different settings to determine the optimum configura-
tion. 
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1.4.10 Time Base Setup 

Time Base Global Setting  

 
Use this command to configure the available time bases for your ex-
periment. 

You can use different Time Bases to synchronize data flow.  

All time base settings can be configured here. Each available Time Base generates 
a tab on the top of the dialog box, to directly select the corresponding time base 
setup. 

Basically DASYLab offers two time bases: 

� PC Clock: The standard time base is a free-running timer synchro-
nized with the PC clock. The default setting for the sampling rate is 
10Hz, with a block size of 1. You can change these settings to meet 
your specific requirements. Use this time base in modules that don’t 
have a direct connection to the regular driver based data flow (e.g. 
Switches to control actions). 

� Driver: The driver time base is synchronized with the driver interface 
and is used for data acquisition with the installed hardware. The avail-
able settings depend on the installed DAQ Hardware.  

There are additional DLL drivers that use their own sampling rates (NI-DAQ, 
NI-CAN, instruNet, etc.). If one or more of these drivers are installed, the Time 
Base Setup… will display additional tabs in the dialog box. 

Selecting Time Bases in a Module 

Data generating modules (such as Generator without Modulation, Switch, 
Slider, Coded Switch, TTL Generator, Time Base without control input, and 
Sequence Generator without control input) provide a setting to select one of the 
available time bases allowing you to synchronize the module to a specific data 
flow. In most cases you don’t need to use a control input or synchronization. 

Tips for using different Time Bases 

If you need a quick reaction to an event, it is recommended that you use small 
block sizes (1 if possible). If you set up your flowchart with a “useful” relation 
between sampling rate and block size (~ 1:10), you must set the block size from 
100 up to 1000 using a sampling rate of 1 kHz. That block size is too large to 
get a fast reaction. You can now use the second time base PC Clock with a sepa-
rate setting of the block size to 1. 

(Also see Hints for Optimal Measurement Settings on page 4-29.) 
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Time Bases of imported (reloaded) worksheets 

Ö A time base (controlled by hardware), that was used while the worksheet was created, 
but is not available on the PC at the time that the worksheet is loaded, is still shown, 
but placed in brackets in the time base dialog. 

Example: The worksheet was created on a system using the NI-CAN hardware. Now 
it is loaded on a PC without the NI-CAN hardware. In the time base dia-
log you will find the entry for the NI-CAN time base placed into brackets 
indicating that time base hardware isn’t available. 

Regardless, all settings can be made for the unavailable time base and these set-
tings will be stored in the worksheet. If you run the worksheet without the 
hardware, all modules that use that time base are synchronized to the PC clock. 
It is likely that they will work correctly with only a small time shift. Please use 
caution, and ensure that you test the worksheet with the correct hardware to en-
sure that all timing related functions work correctly. For example, a relay con-
trolled by a PC-clocked switch may work correctly in this mode, but may fail 
when the actual hardware time base is available. 

1.4.11 Serial Devices 

You can set up multiple Serial Devices using saved configuration files. This dia-
log links serial devices to a saved configuration file. When you insert a Serial or 
ICOM Input or Output module into the flowchart, available linked devices are 
shown in a selection list. You don’t need to load an additional configuration file. 

Ö 
Please note that any settings made directly in the module properties after saving a con-
figuration file are not automatically stored with the flowchart. To save these changes 
you must use the Save button in the module dialog box. Please pay attention that you 
select the correct configuration file name linked to the selected device name. 

Selection of the Type of Serial Module 
You can select one of the available module types: 

� Serial In (Master) 

� Serial In (Slave) 

� Serial Out 

� ICom Input (Master) 

� ICom Input (Slave) 

� ICom Output 

Buttons 
� OK: Verifies and saves the changes and closes the dialog box. 

� Cancel: Closes the dialog box without any changes. Any changes to 
settings are lost. 

� Help: Opens the DASYLab Help. 

� Add: Adds a new entry to the list of predefined devices. You can name 
the new configuration and link an existing configuration file to that 
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entry. If you don’t enter a name DASYLab will create a default name 
by using the name of the assigned configuration file. 

The file types to link are 

� for RS232 Input Master module = (*.SIM) 

� for RS232 Input Slave module = (*.SIS) 

� for RS232 Output module = (*.SOU) 

� for ICOM Input Master module = (*.IIM) 

� for ICOM Input Slave module = (*.IIS) 

� for ICOM Output module = (*.IOU) 

ª Use a descriptive name to save your configuration files to easily identify a specific 
device. Then you do not need to enter a specific name for configuration because DA-
SYLab creates a suitable name. 
� Remove: Deletes an entry from the list of devices. You cannot cancel 

the deletion in the dialog. To restore the entry, leave the dialog using 
the Cancel button. 

� Change: You can rename an entry or change the link to the configura-
tion file using that button. 
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1.5. View Menu Commands 

The commands of this menu allow you to change the appearance of the DASY-
Lab worksheet on the screen. You can click on the corresponding Function Bar 
icons to choose some of these functions. 

 

 

 

 

 

 Overview  

 Animation (Worksheet View only) 

Block State 

FIFO State 

 Function Bar 

 Module Bar 

 Status Bar 

 All Windows 

 
Make Visible (Show) 

 
Make Invisible (Hide) 

 
Minimize  

 
Restore 

 Select Windows 

 Make Visible (Show)… 

 Make Invisible (Hide)… 

 Minimize … 

 Restore… 

 Save Window Arrangement 

ALT-x Select Window Arrangement (1-8) 

 Delete Current Window Arrangement 
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1.5.1 Overview 

Choose this option to display the complete DASYLab worksheet at a reduced size in a 
separate window.  

The display gives you an overview of your complete worksheet. The display is 
automatically scaled so that the entire worksheet is shown in the window. A 
check mark (9) indicates that this function has been chosen. 

Ö You cannot edit or change the worksheet in the overview window. 

1.5.2 Animation 
Choose this option to visualize the data flow by switching the animation (Block 
Status and FIFO Status) of the worksheet on or off. A check mark (9) indicates that 
the function has been activated. 

When Animation is active, small colored indicators in the output symbols of each 
module will display the data flow and buffer (FIFO) status.  

Block Status: Displays the status of data block processing. The bar will toggle 
from red to green, indicating that the module is processing data.  

FIFO Status: Choose this option to switch the animation of the FIFO Status in 
the worksheet on or off (√ indicates that this function has been activated.) 
When Animation is active, the load of the FIFO buffer of each module will be 
displayed by a bar indicator replacing the output symbols of the respective mod-
ules above the small bar indicator of the Block Status indicator). The size of the 
bar changes in steps of 10 % depending on the load of the buffer. 

To guarantee that the worksheet runs smoothly, the bar should not exceed 10 %. 
Larger values point to data flow problems that may cause delayed actions, loss of 
data and, in the worst case, may force the program to stop. 

Ö Data may be processed more slowly when the Animation function is active, since 
graphics operations use more system resources. 

1.5.3 Function Bar 

Choose this option to display or remove the Function Bar below the Main Menu Bar 
of the DASYLab window.  

A check mark (9) indicates that the Function Bar is displayed. 

The Function Bar displays a selection of icons that provide easy access to menu 
functions often used during experiments. Click the icon representing the func-
tion. (For a detailed description of the Function Bar configuration, refer to 
Chapter 3 of this manual.) 

To enlarge the work area for your worksheet, remove the Function Bar from the 
screen. With the Function Bar removed, use the menu commands or hot-keys. 
To start an experiment, for example, choose Start from the Experiment menu, or 
press the ALT, X, S keys, or press F5. 
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When the mouse pointer is pointing at a Function Bar icon, a QuickInfo tag with 
the name of that function will appear. You will find such tags in all of the mod-
ule windows providing a Function Bar, such as the display windows of the 
Y/t Chart or the List Display modules. 

To redisplay the Function Bar, choose this command from the View menu. 

1.5.4 Module Bar 

Choose this option to display or to remove the Module Bar on the left hand side of the 
DASYLab window.  

A check mark (9) indicates that the Module Bar is displayed. 

The Module Bar displays a selection of frequently used modules in icon form. 
Use the left mouse button to click on the icon that symbolizes the module you 
want to add to your worksheet. (For a detailed description of the Module Bar 
configuration, refer to Chapter 3 of this manual.) 

To enlarge the work area for your worksheet, you can remove the Module Bar 
from the screen. With the Module Bar removed, use the Module menu com-
mands to add modules to the worksheet. For example, choose Display from the 
Module menu, and then choose Chart Recorder. 

To redisplay the Module Bar, choose this command from the View menu. 

1.5.5 All Windows 

You can use the View Menu to control the state of the Display Windows. There 
are two mode: Visible/Invisible, and Restored/Minimized. Invisible windows are 
hidden from view, whether restored or minimized. Invisible windows cannot be 
restored or minimized. The follow commands apply to All Windows. To change 
one or more windows, use the Select Windows command of the View menu. 

All Windows: Make Visible 

 
Choose this function, or click the icon on the Function Bar, to show all 
the hidden display windows and icons contained in the worksheet as 
restored windows or in icon form. This command does not restore 
iconized windows. 

To show only selected hidden display windows, see the Select Windows: Make 
Visible function. 

All Windows: Make Invisible 

 
Choose this function or click on the icon on the function bar, to hide all 
display windows contained in the worksheet. Minimized windows (rep-
resented by an icon at the bottom of the screen) are also hidden. 

To hide selected display windows, see Select Windows: Make Visible function. 
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All Windows: Restore 

Choose this function or click on the icon on the function bar, to restore 
all the minimized display windows contained in the worksheet. This 
command has no effect on invisible windows or icons. 

Ö When you first activate several display windows of the same type (e.g. Y/t Charts or 
Bar Graphs) using this function, they will all be automatically opened in the center 
of the screen, on top of each other. Drag the top window to one side to view the next 
display window. 

All the minimized display windows will be restored. To restore only one display 
window, double-click its icon at the bottom of the computer screen or choose 
Select Windows: Restore from the View Menu.  

All Windows: Minimize 

Choose this function or click on the icon on the function bar, to minimize 
all activated display windows contained in the worksheet.. 

To minimize one display window, click its Minimize button (in the upper right-
hand corner of the display window). 

To re-activate all the display windows contained in your worksheet, choose 
Normalize Display Windows from the View menu, or click the corresponding 
Function Bar icon.  

1.5.6 Select Windows 

You can use the View Menu to control the state of the Display Windows. There 
are two modes: Visible/Invisible, and Restored/Minimized. Invisible windows 
are hidden from view, whether restored or minimized. Invisible windows cannot 
be restored or minimized. The follow commands apply to one or more selected 
Windows. To change all windows, use the All Windows command of the View 
menu. 

To select more than one window at a time, use the standard windows controls: 
click and drag to select a contiguous range of lines; SHIFT-click to select con-
tiguous lines; or CTRL-click to select any two or more lines. 

Select Windows: Make Visible 

Choose this function to open a list box with all hidden (invisible) display win-
dows or display icons contained in the worksheet. To show one or more display 
window, select them from the list. Press the OK button to accept the selection 
and leave the dialog box. The selected will be shown as a restored window or an 
icon, depending on the state that it was in when hidden. 

Select Windows: Make Invisible 

Use this function to hide one or more display windows or icons. A list of all visi-
ble display windows and icons will be listed. To hide one or more display win-
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dows or icons, select them from the list, and press OK to accept the selection and 
leave the dialog box. 

Select Windows: Restore 

Use this function to open a list box with all visible iconized windows. To restore 
one or more display windows, select one or more from the list and press the OK 
button to accept the selection. The selected windows are restored and shown as 
windows. 

Select Windows: Minimize 

Choose this function to open a list box with all visible restored display windows. 
To minimize one or more display windows to an icon, select them from the list 
and press the OK button to accept the selection. The selected windows are 
minimized and shown as icons at the bottom of the Windows Desktop. 

1.5.7 Window Arrangements 

Save Window Arrangement 

 Choose this function to save the sizes and positions of all the activated display windows 
and to define an identifying tag for that arrangement. 

Use this function to easily switch between different display window arrange-
ments even while an experiment is running. You can save up to 8 different dis-
play window setups. 

To activate this function, 

� Press ALT+SHIFT+Arrangement Number (1-8) on your keyboard, 
or 

� Choose the Save Window Arrangement command from the View 
menu. 

The Window Arrangement dialog box appears, displaying the Arrangement -
Number and Text either of the current setup, or, if you have used the keyboard 
shortcut, of the setup whose number you have typed after ALT+SHIFT. 

You can now save the current arrangement under any Arrangement Number 
from 1 to 8 and add a name or short description of your choice in the Text field. 
Click OK, or press ENTER, to complete the procedure. If an arrangement has al-
ready been saved under this number, you will be warned. 

The name or description you have entered in the Text field appears in the list of 
window setups on the Function Bar. 

Ö Choose Select Window Arrangement to re-arrange the display windows in one of 
the arrangements you have previously saved. 

Ö Choose Delete Current Window Arrangement to delete the current setup from the 
list of saved arrangements. 
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Select Window Arrangement 

Choose this function to re-arrange the activated display windows on the screen 
in one of the arrangements you have previously saved. Each of the activated dis-
play windows appears in the same position and size as previously saved. 

Additional display windows (not contained in the arrangement when it was 
saved) remain in their positions while the others return to their defined places on 
the screen. 

To activate this function, 

� Click on the list box on the Function Bar (or on the down arrow on 
its right), or 

� Press ALT+0 on your keyboard, or 

� Choose the Select Window Arrangement command from the View 
menu. 

In the Function Bar list box, the nametags of all the saved arrangements are 
listed. Click on the name of the arrangement that you want to restore, or choose 
that tag by pressing the arrow keys on your keyboard; then press ENTER. 

Using a keyboard shortcut, you can select any of the saved arrangements by 
pressing ALT+Arrangement Number (1-8). 

ª If you restore one of the saved window arrangements as described, the sizes and 
positions of the current display windows will be lost, unless you have saved them 
under another Arrangement Number. 

ª If you delete one of the display modules contained in the saved window arrangement 
from the worksheet, its display window is permanently removed from the saved 
arrangement, too. To restore the original setup, you must re-install the display mod-
ule in the worksheet, and save the display window arrangement again. 

Ö Choose Save Window Arrangement to save the current sizes and positions of all 
the activated display windows. 

Ö Choose Delete Current Window Arrangement to delete the current setup from the 
list of saved arrangements. 

Delete Current Window Arrangement 

 Choose this function to delete the currently displayed setup of display windows from the 
list of saved arrangements. 

Only the information concerning the sizes and the positions of the dis-
play windows are removed; the display windows themselves remain in the work-
sheet unchanged. 

To activate this function, press ALT+CTRL+Arrangement Number (1-8) on 
your keyboard, or choose the Delete current Window Arrangement command 
from the View menu. You will be asked to confirm your decision before the in-
formation is actually deleted. 

Ö Choose Save Window Arrangement to save the current sizes and positions of all 
the activated display windows. 
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Ö Choose Select Window Arrangement to re-arrange the display windows in one of 
the ways you have saved before. 

1.6. Options Menu  

The commands of this menu allow you to change the display of the DASYLab 
worksheet and to switch the Autorouter function on and off. 

 Global Setup… 

 Directories… 

 Default Fonts… 

 Hot Keys… 

 Colors… 

 Autorouter 

 Global Worksheet Parameters 

 Password Protection… 

 Password Definition 

 Screen Locking 

 Key Events… 

 List of Actions 

 Overview of Actions 

 Global Variables and Strings… 

 Define Global Strings… 

 Define Global Variables… 

 Export Global Strings/Variables 

 Import Global Strings/Variables 

 Overview of Global Strings/Varables 

 Configure Startup Dialog 

 Copy Channel Names 

 Switch to Runtime 
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1.6.1 Global Setup… 

Choose this command to change the DASYLab screen settings and program start op-
tions. 

Ö The settings are automatically saved when you exit DASYLab. The same win-
dow setup will be used the next time DASYLab is started. These settings are 
not saved with the worksheet when you choose the Save or Save As… com-
mands from the File menu. 

Window Type 
Select this option to place a background grid on the worksheet.  

Type of Grid 
� Dots The grid intersections will be marked by dots. 

� Lines A complete grid will be displayed. 

Spacing 
Choose a value between 8 and 48 points to specify the minimum distance be-
tween the module symbols in the work area and to specify the size of the screen 
grid. 

After setting the spacing, new modules will be placed using this setting. When 
the spacing value is changed, it will not affect the layout of existing modules on 
the worksheet. When you move a module, it will be positioned using the new 
settings. 

Ö The spacing value should be at least 16 points, to ensure that there is enough 
space for data channels between the module symbols. 

Start Options 
� By default, DASYLab copyright information is displayed at program 

start. In the Show Copyright Information box you can choose if you 
wish this information to be displayed each time or not. 

� When you open a worksheet, the Module Bar settings that were saved 
with it will be loaded, possibly modifying the current Module Bar set-
tings that you'd rather maintain. 

o Activate the Load Module Bar with Flow Chart box if the current 
Module Bar configuration is to be replaced with the new one 
from the worksheet file. 

o Deactivate this box if you wish to retain the current Module Bar 
configuration whenever you open a worksheet file. 

Common Options 
� Choose Open dialog box when Module is created to automatically 

open the module properties dialog box when the module is added to 
the worksheet. 
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� Choose Show File Information with Flow Chart to display the File 
Info each time the experiment starts. 

� Choose Show Warning if Data Stream stops to cause the program to 
display a message if one module isn’t able to process the incoming 
stream of data. 

� Choose Show Warning if Flow Chart changed to cause the program to 
display a message if the worksheet has not been saved when the pro-
gram is closed.  

� In all write data operations, the Create Directory if Necessary option 
causes DASYLab to create the named directory when it does not exist  

Example: 

Bad entry in Edit field:  

Default Directory: C:\DASYLAB\DATA  
New Directory: C:\DASYLAB\DATA\  

Correct entry in Edit field: 

Default Directory: C:\DASYLAB\DATA  
New Directory: C:\DASYLAB\DATA\${STRING_001}  

Where {STRING_001} contains the advanced path and file name, 
such as <NEW-DIR\FILE1>. 

The full path of the newly created directory and file will be: 
C:\DASYLAB\DATA\NEW-DIR\FILE1.DDF 

For example, creating new directories is useful when writing files into 
subdirectories with a time stamp, such as creating day, month or year 
to store the files into them using an event driven action. 

To create the time stamp, don’t use the global string ${DATE}, be-
cause the punctuation marks (dots) in this string may be incompatible 
with the Windows file structure. Instead, combine the ${DAY}-
${MONTH}-${YEAR} strings and use another punctuation mark. 

� The Hide Flowchart Load Progress Bar option turns off the progress 
bar when the elements of the worksheet are loaded. 

� Choose Create Module via Drag & Drop to insert new modules onto 
your selected location on the worksheet under user control. The mod-
ules are not inserted at default places, but DASYLab first shows an in-
sert cursor to allow you select the position the new module will be 
placed. 

� If the Release CPU time if idle Option is active DASYLab releases the 
reserved CPU time to other programs 

� Choose Load user defined colors from Flow Chart to import the user-
defined colors of a worksheet. These colors are then available as addi-
tional colors in all color dialog boxes.. 

� Choose Show Module Tooltips to enable the program to display a 
small box with information about the module under the mouse cursor.  
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Start/Stop Options 
� If the Save Backup Flow Chart setting is active, the current worksheet 

is saved under the file name LAST.DSB when the DASYLab work-
sheet is started. 

� The Copy Channel Names at Start of Experiment option enables or 
disables the DASYLab default setting to Copy The Channel Names of 
the connected modules into newly connected modules  

� The Switch to Displays at Start of Experiment option allows you to 
specify that the Worksheet view will be hidden, and the Display Win-
dow view will be activated when the experiment starts.  

� The Switch to Layout 1 at Start of Experiment  option allows you to 
specify that the Worksheet view will be hidden. The VITool Window 
will be activated with Layout page 1 when the experiment starts. 

� The Switch to Worksheet at Stop of Experiment option allows you to 
specify that the Worksheet view will be restored when the experiment 
stops. 

1.6.2 Default Directories 

Use this menu item to set and modify the locations of drives and directories that 
DASYLab uses by default for loading or saving files. Different directories can be 
set up for various file types. 

When you select this menu item, a dialog box is opened, displaying each file type 
with the currently valid directory. Clicking on the respective switches can change 
the setup. 

Default drives and default directories can be specified for the following file types: 

Item File type 

Worksheet DASYLab worksheet files (extension ∗.DSB) 

Streaming data files for fast disk streaming 

Data data files of the Write Data module 

Devices configuration files for the serial interface and the 
IEEE interface 

Other Module Bar, Interpolation and other files 

By clicking on a switch a dialog window opens allowing the selection of a drive 
and a directory. New directories can also be created here. 

The drives and directories specified here are only used as defaults. If a file name 
must be assigned while working with DASYLab, these pre-set locations are 
shown in the input window for the respective file type. If required, a different 
drive and directory can be selected. 

After the initial installation, the DASYLab installation directory is used for all 
default settings. 
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The settings made here are saved in the DASYLAB.INI file in the Windows di-
rectory. 

1.6.3 Fonts 

This option allows you to define the module display windows font style and size. 
Choose from the following 4 options: 

� One Font, Fixed Size 

If this option is used, all text elements of the display windows use the 
same type of fonts. The size is fixed and is always used even if the dis-
play window is stretched or compressed. Use the Font... button to se-
lect type and size. 

� One Font, Variable Size 

If this option is used, all text elements of the display windows use the 
same type of fonts, but the size is adapted to the proportions of the 
text areas of the display window if the window is stretched or com-
pressed. 

� Variable Font, Fixed Size 

This setting allows you to select several types of fonts for the elements 
of the display window. Use the buttons on the bottom of the dialog 
box to select individual font styles and sizes for these elements. The se-
lected fonts size is always used even if the display window is stretched 
or compressed. 

� Variable Font, Variable Size 

This setting allows you to select several types of fonts for the elements 
of the display window. Use the buttons on the bottom of the dialog 
box to select individual font styles for these elements. The size of fonts 
is adapted to the proportions of the text areas of the display window if 
the window is stretched or compressed. 

Ö The buttons to select the different text elements in display windows depend on 
the kind of display window module. For example the buttons names for the 
Digital Display module are Channel Name..., Value... and Scale..., or while the 
Status Lamp module only shows Channel Name... and Status text.... 

Ö If you activate these functions from the Options menu, the setting is applied to 
all newly created modules on the worksheet; but existing modules are not af-
fected. You can change this default setting by opening the individual text dia-
log box of the modules. 
� Apply Button 

Use this button to change the font of all text elements to the chosen 
default type. All existing modules are changed. 

1.6.4 Hotkeys 

Use this command to assign combinations of keys to all available DASYLab menu 
functions. After a Hotkey is assigned to a function, it can be used by simply pressing 
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the key or key combination. Use the Hotkeys menu command to open a window list-
ing all defined Hotkeys. 

Add Button 
� Click the Add… button to open a window, listing all available menu 

function/instructions in form of a menu tree. To assign a Command 
to a Hotkey or hotkey combination select the command in the tree, 
click in the New Key edit field and press the keys you want to assign. 

� If a combination of keys is assigned to a selected menu instruction, it 
is shown in the Current combination of keys field.  

� You can also use the Free H(ot)Keys button to open a list with all 
available unused keys and key combinations. You can select the Hot-
key directly in this list and click OK to close the window and move the 
selection into the New Key Combination field. 

Delete Button 
� The Delete button removes the selected HotKey. 

Defaults Button …. 
� The Defaults Button deletes all user-defined Hotkeys and loads the 

default  settings. 

Ö Some keys and combinations of keys are reserved by Windows. These keys are not 
available for redefinition. 

1.6.5 Colors 

Use this command to choose the colors for the DASYLab worksheet display. You can 
specify colors for the background, the grid and the data channels wire core and sleeve. 

Ö The settings are automatically saved with information about the window size 
and position when you exit DASYLab. The settings are not saved with the work-
sheet when you choose the Save or Save As… commands from the File menu. 

Standard Colors 
� Select the item you want to change. The Windows color selection dia-

log box appears. 

� Click on the color of your choice in the Standard Colors palette using 
the left mouse button.  

� If you prefer to create your own custom color, click Edit Colors. 

Edit Colors 
You can create custom colors for the background, the grid and the data chan-
nels, wire cores and sleeves. 

� Select the item you want to change. The Windows color selection dia-
log box appears. 

� Click on the color you want to edit using the left mouse button. 
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� Choose Edit Colors. 

� To increase or decrease the amount of primary color, brightness 
and/or saturation used in a color, drag the crosshairs and/or the verti-
cal scroll bar keeping the left mouse button depressed. 

You can also type numbers from 0 to 255 in the corresponding boxes. 
The resulting color is displayed in the Custom box. 

To reset all the values for the standard color that comes nearest to the 
custom color you have just defined, double-click the Standard box. 

� Choose the OK button to change the color of the selected screen ele-
ment to the custom color. 

� To save the custom color you have defined: 

o Click any of the boxes in the Custom Colors palette first. 

o Then modify its color as described above. 

o Click Add Color to Palette. 

o Specify further colors from the Custom Colors palette and 
modify them. 

o Choose the OK button to change the color of the selected 
screen element to the custom color. 

o To return to the color originally displayed on the screen, 
choose the Cancel button. 

1.6.6 Global Worksheet Parameters 

Activate the Error Handling function to increment the specified global variable 
by 1 if the stream of data in worksheet has blocked.  

This setting is stored in the worksheet. 

 
The global variable used in this dialog is not shown in the Global 
Strings/Variables overview! 

1.6.7 Autorouter 

Choose this option to switch the Autorouter function on or off. A check mark (9) 
indicates this function has been activated. 

When the Autorouter is active, DASYLab automatically finds the correct paths 
for your data channels. DASYLab ensures that the data channels do not run 
across modules or hide other data channels. The Status Bar displays the progress 
of the autorouting operation. 

When the Autorouter is not active, you can determine the paths of your data 
channels. 
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Ö The Autorouter function cannot automatically rearrange existing data channels to 
take the shortest or most direct way between modules. You must manually rearrange 
a data channel or move a junction point to a different position to improve the clarity 
of your worksheet structure. 

1.6.8 Password Protection/Password Definition 

Use a password to protect a worksheet against unauthorized use or modification. A 

check mark (9) indicates that this function is active.  

Password protection is activated by 

� Clicking the Password Protection command, 

� Specifying the password itself by using the Password Definition com-
mand, 

� And then saving the worksheet. 

Password protection applies to the entire worksheet. Black Boxes may also be 
protected via Passwords. The settings are made in an active Black Box in the 
Edit: Black Box Properties. 

If Password Protection is activated without entering a password at the same 
time, you will be prompted to specify the password when the worksheet is saved. 

Once Password Protection has been activated and the worksheet has been 
stored, it can only be opened again by entering the correct password. 

This function is only relevant when you save a worksheet or use the 
Screen Locking function. It does not affect any other function or module. 

Ö If you have forgotten or do not know the password of a worksheet, you will not be 
able to open the worksheet. Take this into consideration when you choose a pass-
word, and take adequate precautions so that you will always remember your pass-
words. 

A password must contain at least 4 and up to 10 alphanumeric characters. If the 
number of entered characters is less than 4, a warning message will appear when 
you close the dialog box. 

For security reasons, the password must be entered twice. If the two passwords 
are not identical, you must reenter the password. 

While you type the password, the characters are not echoed, but appear as aster-
isks (∗). Password recognition is case-sensitive; the same combination of upper 
and lower case characters must be specified. 

A correctly entered password is valid 

� Until you exit DASYLab, or 

� Until a different password is entered, or 

� Until you open a different worksheet requiring a different password, 
and you enter that new password correctly. 
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1.6.9 Screen Locking 

Activate Screen Locking to disable all keyboard and mouse inputs after starting 
measurement.  

To unlock, use the ESC key. If Password Protection is active, the password will 
be requested. You must enter the correct password to Unlock. 

Screen locking also can be activated and deactivated via Event Driven Actions.  

When Screen Locking is activated, Key Events, as defined in the Options Menu, 
are available. 

1.6.10 Key Events 

Use Key Combinations to cause actions on the worksheet. 

It is possible to cause all Actions of modules that are used in a worksheet by us-
ing an Action module or using key or key combination (1 or 2 Special key + one 
normal key for example CTRL+SHIFT+S). 

Select the option menu command key events. If the Show Window with defined 
Key Events switch is set, the window shows all defined key actions. You can hide 
single key events in the dialog box define key events 

The New button opens a key events dialog box where you can define parameters 
used by the key actions. 

To change existing Key Events, choose the line and click the Change button. 
The dialog box will show the active parameters. Click in the parameter field to 
change them. 

The Delete button deletes selected key action. 

The Reset button deletes all defined key events. 

To use Key Events you need: 

� The key or key combination, 

� The Receiver for the action, 

� The Action itself and 

� The Action-dependent Parameters 

Receiver 

The Receiver entry specifies the module that is to execute the initiated action. 

� In the Module pull-down list box, all the modules in the worksheet 
(which can perform actions) are listed together with the DASYLab 
main window. 

� Use Channel to specify which channel(s) of the selected module is to 
perform the actions. Individual channels can be separated with spaces 
or commas. Channel groups are entered with hyphens. 

Example: To use the channels 1, 3, 7 and 9 up to 12 of the Receiver 
module for the event, enter: 1 3 7 9−12 or 1,3,7,9−12. 
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This setting does not influence actions relating to the entire module. 

Parameters 

You can define Parameter values to be used by the action (Worksheet name, 
Layout number, Global String, etc.). 

Screen Lock mode 
You can allow key events while Screen Locking is active. The default setting is 
Do Not Execute Action. 

Description 
While the Show Window With Defined Key Events option is active, key actions 
will be displayed in an overview window. The default is Display. You can insert a 
descriptive text string in the entry field that will be shown in the window. If the 
string is empty, the Action text will be displayed. 

1.6.11 List of Actions 

The List Actions ... item opens a dialog box that allows you to copy a description 
of any actions and their parameters, as defined in the worksheet, into the clip-
board or to store it into a text file.  

You can select one of the defined action modules from the list window. The pa-
rameters of the selected action module are shown in the display area. 

You can also select one of the actions defined in the selected module. The pa-
rameters of the selected action are shown at Event Parameter, Receiver Channel 
and Parameter of action (Number, Value). 

Buttons 
� Copy: This button opens a dialog box to copy the data into the clip-

board. You can select whether the parameters of the selected or all de-
fined action modules are copied. Click on OK to start the copy. 

� Save: This button opens a dialog box to save the data into a text file. 
You can select whether the parameters of the selected or all defined ac-
tion modules are stored. 
The File name button opens the file menu to select/create the file the 
data become stored. Click on OK to start saving data. 

The text file has the following format: 
Module name: Action00 
Channel: 0 
Channel name: Action 0 
Event: Rising Edge 
Receiver: <DASYLAB> 
Receiver Channels: All Channels 
Action: Activate Layout 
Layout: 1 
Asynchronous action 
 
Channel: 1 
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Channel name: Action 1 
Event: Falling Edge 
Receiver: Generator00 
Receiver Channels: All Channels 
Action: Change Amplitude 
To: 2,0000 
Asynchronous action 
 ... 
Module name: Action01 
Channel: 0 
Channel name: Action 0 
Event: Rising Edge 
Receiver: <DASYLAB> 
Receiver Channels: All Channels 
Action: Activate Layout 
Layout: 2 
Asynchronous action 
And so on. 

1.6.12 Overview of Actions 

The Overview of Actions… command opens a list box, showing all Event Driven 
Actions defined in the actual flowchart.  

The four columns show the name of the action module, the defined condition, 
and the event such as the receiver of the action. You can choose each of these 
four items to be displayed in each column. The entries in the list will be ordered 
alphabetically. 

� Copy: This button opens a dialog box to copy the data into the clip-
board. You can select whether the data of the selected or all defined ac-
tions are copied.  

� OK button starts copying the information 

� Save: This button opens a dialog box to save the data into a text file. 
You can select whether the parameters of the selected or all defined ac-
tions are stored. 

� File Name opens the file menu to select/create the file where the data 
will be stored. 

� OK button starts saving data. 

To get more detailed information about the defined actions you can use the List 
of Actions... command. There you can select each action module defined in 
worksheet and display all of its settings and parameters. 

1.6.13 Global Variables and Strings 

This Options menu item allows you to configure Global Strings and Variables. 
The next sections describe each menu item. 

1.6.14 Define Global Strings  

Global Strings allow you to define and modify ASCII text strings used in DA-
SYLab while a measurement is running. You can pass text strings to DASYLab 
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worksheets running in succession (See the Working Example below). You can 
define up to 999 Global Strings. When the measurement is running a Global 
String can be defined or modified using the menu command Define Global 
Strings. Defined strings are stored with the worksheet. 

You can display Global Strings as text objects in Layout Windows. Use the 
placeholder ${STRING_xxx} in the line text object. Replace xxx with the num-
ber of the string. 

Several System/Program Information strings and variables (such as Free Mem-
ory, System Resources, Author, Company, etc.) are implemented in DASYLab as 
fixed placeholder strings/variables. If an Edit field will accept placeholders, right 
mouse click in the Edit field to open a Popup menu with the Global Strings dis-
played as a menu item. This Item opens a list with all available strings. Double-
Click on the requested placeholder to insert it into the Edit field 

You can use the RS232 Input module to receive strings instead of measurement 
values and then assign them to a Global String. 

Optionally, you can to load a Global String after starting a worksheet or save a 
string into the DASYLAB.INI file when you stop. Other applications are able to 
modify strings via DDE. And, you can define, load or save a Global String using 
Event Driven Actions or key events. 

Each Global String consists of a number, text (max. 255 char.) and options. The 
Reset button sets all strings in the list to the default settings. The Reset all but-
ton deletes all strings. 

You can select and modify more than one string simultaneously using the 
SHIFT and CTRL keys to select the strings. 

You can define the following Options to handle Global Strings: 

� Read from INI file at start of experiment 
� Write to INI file at stop of experiment 
� No DDE access to Global String 
� Write to data file (DASYLab or ASCII) Header 
� Show Global String in window  
� Type In at start of experiment 
� Do not overwrite description 
� Input is required to close dialog box 
� File Name Dialog 

You can also define a short description.  

Buttons 

There are several buttons to the right of the dialog box: 

� Reset 

� Reset All 

� Extended… 

� Overview… 
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� Copy… 

� Save… 

Reset 

Return the selected variable to default settings. Any values, names, Extended op-
tions and parameters will be lost. 

Reset All 

Return all variables to default settings. Any values, names, Extended options and 
parameters will be lost.  

Extended… 

Click on the Extended button to make additional settings for Global Strings. 

� Name: You can define a name to be used with variables and strings. 
You can refer to the String/Variable using the defined name: ${NAME} 
or by its number {$VAR_xxx} or {$STRxxx}. 

� Expressions: If the Calculate Expression automatically option is acti-
vated you can define a mathematical expression similar to the Formula 
Interpreter. The expression is allocated to the variable or string. If one 
of the parts in the expression is changed, the variable or string is 
automatically recalculated. 

Each expression is a special type of data (numeric <variable> or alphanumeric 
<string>). You only can link string expressions with strings and numerical ex-
pressions with variables; otherwise the program generates an error message. 

The numerical expressions are the same as in the Formula Interpreter.  

Mathematical functions: 
+ Addition  - Subtraction  

* Multiplication  / Division  

> greater  < less than  

>= greater than or equal <= less than or equal  

= equal <> not equal 

^ raise to a power  MOD Modulo remainder of Division 
operation  

OR logical OR XOR logical XOR  

AND logical AND  NOT logical NOT  

Trigonometric functions: 
sin Sine sinh Hyperbolic Sine 

arcsin ArcSine cos Cosine 

cosh Hyperbolic Cosine  arccos Arc Cosine 

tan Tangent tanh Hyperbolic Tangent 

arctan ArcTangent sqr Square 

sqrt Square root  frac Fractions 

trunc Truncate round Round 
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abs Absolute value rand Pseudo random function 

exp Exponential function ln Logarithm, base e 

log Logarithm, base ten  sign Sign 

String functions: Relational Operators 
+ Link/concatenate   

> Greater than < Less than 

>= Greater or equal <= Less than or equal 

= Equal <> Not equal 
Results are: true=1; false=0 

Ö For comparison operations with strings, the characters of the strings are weighted 
corresponding to the value in the ASCII Table, shown in the ASCII Table on 
page C-1. The strings are checked character by character and sorted by priority. 

Additional String Operations  
Operation Parameter Description 

strlen (String) Length of strings (numerical result) 

strind (String, Search-string) Position of the search-string in a string (numerical 
result) 

strval (String) String-value, Numerical value of the strings. 

substr (String, Start, Length) Substring, Result is a substring with defined length 
and start position (Start and Length are numerical 
and also may be expressions!). 

upper (String) Convert characters of string to upper case 

lower (String) Convert characters of string to lower case 

strsel (Condition, TrueString, 
FalseString) 

Select string depending on a special condition 

Constants 
PI Pi (π) E e function 

True Is true (=1) False Is false (=0) 

( Open parenthesis ) Close parenthesis 

Priority of Strings 
 Sort => 1st Step 2nd Step 

= Result 

sand Position 1 Sand(1) SAND(1.1) 

Sand Position 2 SAND(1) Sand(1.2) 

sAnd Position 3 sand(2) sAnd(2.1) 

SAND Position 4 sAnd(2) sand(2.2) 

SAND > Sand > sAnd > sand 

 Sort => 1st Step 2nd Step 3rd Step 4th Step 
= Result 

Sund Position 1 Sund(1) Sand(1.1) Sand(1.1.1) Sand(1.1.1.1) 

sOnd Position 2 Sand(1) Sund(1.2) Sund(1.2.1) Sund(1.2.1.1) 

Sand  Position 3 sOnd(2) sOnd(2.1) sOnd(2.1.1) sOna(2.1.1.1) 

sOna Position 4 sOna(2) sOna(2.1) sOna(2.1.1) sOnd(2.1.1.2) 



DASYLab®   Worksheet Window Menu 

 4-55 

Sand > Sund > sOna > sOnd 
Characters that influence the sort are bold! The priority after each step is shown 
in the brackets. If all strings have a different priority, the operation is aborted be-
cause the resulting step is reached. 

Value of Strings 
The string has to start with a numerical character or decimal point (point or 
comma); otherwise the string value is 0. Leading blanks are ignored. If there is a 
blank within a numerical string it is interpreted as an alphanumerical character. 
Any following numerical characters are lost. 

String Value String Value 

1.0 1 .2 0.2 

1.05 1.05 12. 35DM 12 

1 DM 1 1DM 95Pf 1 

3.045.23 3.045 DM 1.05 0 

Overview… 

Click on the Overview… button to open a dialog box that shows all available 
global variables and strings in a tree view. Use this overview to easily and quickly 
explore the places where variables and strings are used in the worksheet.   

Global Strings used in Modules 

Most modules can process Global Strings. DASYLab is constantly improving, 
and adding places where you can use Global Strings. One way to determine if a 
parameter box permits a Global String is to right click in the parameter box. If 
the popup menu shows Global String… then you can use a string successfully in 
that location. 

Predefined Global Strings 

The global strings in the following list are predefined and are offered in selection 
list for quick insert: 

Strings with System Information: 
String Description 

${DATE} Current Date 

${TIME} Current Time 

${DAY} Day of current date (numeric, 1-31) 

${MONTH} Month of current date (numeric, 1-12) 

${YEAR} Year of current date (e.g. 2001) 

${HOUR} Hour of current time 

${MINUTE} Minute of current time 
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${SECOND} Second of current time 

${DAY_LZ} Current day with leading zero (e.g. 07) 

${MONTH_LZ) Current month with leading zero 

${YEAR_2) Current year with last two digits (e.g. 01) 

Worksheet specific Strings 

String Description 

${FLOWCHART} Name of Flowchart without path 

${FULL_FLOWCHART) Name of Flowchart with full path 

${CREATION_DATE} Date of Worksheet Creation 

${CREATION_TIME} Time of Worksheet Creation 

${MODIFY_DATE} Date when Worksheet was last changed 

${MODIFY_TIME} Time when Worksheet was last changed 

${START_DATE} Measurement Start Date  

${START_TIME} Measurement Start Time  

${AUTHOR} Author, as defined in DASYLab File Info 

${COMPANY} Company, as defined in DASYLab File Info 

${DEPARTMENT} Department, as defined in DASYLab File Info 

${TITLE} Title, as defined in DASYLab File Info 

${DRIVER_MESSAGE} Driver specific message 

1.6.15 Define Global Variables 

You can define and modify Global Variables while a measurement is running. 
You can pass variables to subsequent worksheets running in succession (see the 
Working Example below). You can define up to 999 Global Variables. When the 
measurement is running a Global Variable can be defined or modified using the 
menu command Define Global Variables.  

Ö Defined variables are stored with the worksheet. 

Optionally, you can load a Global Variable after starting a worksheet or save a 
variable into the DASYLAB.INI file when you stop. Other applications are able 
to modify variables via DDE. And you can define, load or save a Global Variable 
using Event Driven Actions or Key Events. You can display Global Variable as 
text objects in Layout Windows. Use the placeholder ${VAR_xxx} in the line 
text object. Replace xxx with the number of the variable. 

Several System/Program Information strings and variables (such as Free Mem-
ory, System Resources, etc. /Author, Company, etc.) are implemented in DASY-
Lab as fixed placeholder strings/variables. If an Edit field will accept placehold-
ers, right mouse click in the Edit field to open a Popup menu with the additional 



DASYLab®   Worksheet Window Menu 

 4-57 

menu item Global Variable.... This Item opens a list with all available variables. 
Double-Click on the requested placeholder to insert it into the Edit field 

Ö Use the Action module to save the variable to the INI file while the experiment 
is running 

Each Global Variable is composed of a number, numerical value (max. 255 
char.) and one or more Options. The Reset button sets all variables in the list to 
the default settings. The Reset all button deletes all variables. 

You can select and modify more than one variable simultaneously using the 
mouse to select a range, using the SHIFT key to select a contiguous range and 
the CTRL key to select non-contiguous variables. 

You can define the following Options to handle Global Variables.  

� Read from INI file at start of experiment 
� Write to INI file at stop of experiment 
� No DDE access to Global Variable  
� Write to data file Header (DDF and ASCII) 
� Show Global Variable in window  
� Type In at start of experiment 

� Do not overwrite description 

You can also define a short description.  

Buttons 

There are several buttons to the right of the dialog box: 

� Reset 

� Reset All 

� Extended… 

� Overview… 

� Copy… 

� Save… 

Reset 

Return the selected variable to default settings. Any values, names, Extended op-
tions and parameters will be lost. 

Reset All 

Return all variables to default settings. Any values, names, Extended options and 
parameters will be lost.  

Extended… 

Click on the Extended button to make additional settings for Global Strings. 
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� Name: You can define a name to be used with variables and strings. 
You can refer to the String/Variable using the defined name: ${NAME} 
or by its number {$VAR_xxx} or {$STRxxx}. 

� Expressions: If the Calculate Expression automatically option is acti-
vated you can define a mathematical expression similar to the Formula 
Interpreter. The expression is allocated to the variable or string. If one 
of the parts in the expression is changed, the variable or string is 
automatically recalculated. 

� The settings made in the Extended… dialog box are not permanent 
until the main Define Global Variables... dialog is closed using the OK 
Button. 

1.6.16 See Global Variables and Strings 

This Options menu item allows you to configure Global Strings and Variables. 
The next sections describe each menu item. 

Define Global Strings Buttons 

There are several buttons to the right of the dialog box: 

� Reset 

� Reset All 

� Extended… 

� Overview… 

� Copy… 

� Save… 

Reset 

Return the selected variable to default settings. Any values, names, Extended op-
tions and parameters will be lost. 

Reset All 

Return all variables to default settings. Any values, names, Extended options and 
parameters will be lost.  

� Extended… on page 4-53 for details of the settings and features. 
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Global Variables used in Modules 

The following list shows you the modules that can process Global Strings. DA-
SYLab is constantly improving, and adding places where you can use Global 
Variables. One way to determine if a parameter box permits a Global Variable is 
to right click in the parameter box. If the short menu shows Global Variable… 
then you can use a variable successfully in that location. 

Predefined Global Variables 

The global variables in the following list are predefined and are offered in the se-
lection list for quick insert: 

Variables with system information: 

Variable Description 

${SYS_RES} Free System Resources: This variable shows the load of the 
Windows system resources. If the value decreases (in %), 
the load increases. 

${GDI_RES} Free GDI Resources: This variable shows the load of the 
resources of the Windows Graphic Device Interface. If the 
value decreases (in %), the load increases. 

${USER_RES} Free User Resources: This variable shows the load of the 
Windows user resources. If the value decreases (in %), the 
load increases. 

ACTUAL_YEAR} Actual Year: shows actual year as numerical value, shown 
in 4-digit format (yyyy). 

${ACTUAL_MONTH} Actual Month: shows actual month as numerical value.  

${ACTUAL_DAY} Actual Day: shows the actual day as numerical values.  

${ACTUAL_HOUR} Actual Hour: shows the actual hour as numerical values.  

${ACTUAL_MINUTE} Actual Minute: These Variables show the actual time 
(Year, Month, Day, Hour, Minute or Second) as numeri-
cal values.  

${ACTUAL_SECOND} Actual Second: actual time (Second) as numerical value.  

${WEEK_DAY} Actual Day of the week: This Variable shows the day of 
the week as numerical value. The order starts with Sunday 
(value=0) end ends with Saturday (value=6).  

DASYLab / Worksheet specific Variables 

Variable Description 

${BLOCK_SIZE} Global Block Size: This value shows the preset global 
block size 
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${SAMPLE_RATE} Sampling Rate: This value shows the preset global sam-
pling rate 

${TOTAL_LOAD} Total Program Load in percent: This variable shows the 
loading of the data acquisition program. Values of 100% 
and higher are displayed if the program is fully loaded or 
overloaded. In this case, it threatens to interrupt the 
running measurement by the program. To reduce the 
load, decrease the sampling rate, increase the block size, 
disable the animation and so on. 

The displayed value isn’t very precisely calculated be-
cause the time base used is 55 msec. So fluctuations in 
display are normal. 

${TOTAL_DELAY} Total Program Load in milliseconds  

Time delay shows the time a sample needs to pass all 
modules in worksheet. This may give an impression of 
the processing time that is needed to perform all opera-
tions defined by the function modules. The displayed 
value isn’t very precisely calculated because the time base 
used is 55 msec. Fluctuations in the display are normal. 

${USED_BUFFER} Used Driver Buffer: This value (in %) shows the usage of 
the driver buffer of the program. If the buffer is com-
pletely filled (100%), the measurement stops with an 
error message Sampling rate too high.  

First check your flowchart and optimize it as much as 
possible (see also Tips & Tricks in the User Guide). 
Then check the buffer settings in Experiment setup and 
increase if possible. Also check whether other applica-
tions are running in the background, which may delay 
data processing in the program. Decrease the sampling 
rate and/or increase the block size. 

${DAPx_FREE_MEM} Free Memory on DAP Boards x (x=1 ... 8): This value 
(in %) shows the usage of the driver buffer of the Micro-
star DAP board. If the buffer is completely filled 
(100%), the measurement stops with an error message 
Sampling rate too high.  

First check your flowchart and optimize it as much as 
possible (see also Tips & Tricks in the User Guide). Also 
check whether other applications are running in the 
background, which may delay data processing in the 
program. Decrease the sampling rate and/or increase the 
block size.  

${DRV_DATA_LOST} Driver specific: shows the number of values lost in the 
driver since the start of measurement. May indicate per-
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formance problems with the driver’s ability to capture 
data at the specified sampling rate. 

${ELAPSED_TIME} Elapsed time of measurement in seconds from the start 
of measurement 

Options for Global Strings and Variables 

Read from INI File at start of experiment 

If this option is chosen, entries in the INI file will be read and imported as actual 
settings. DASYLab will start the experiment with these Global Strings and Vari-
ables. 

Write to INI File at stop of experiment 

If this option is chosen, all defined Variables or Strings are written to the INI file 
when the experiment stops. These Global Strings/Variables are available in INI 
File the next time you start the experiment. 

No DDE access to Global String/Variable 

If this option is chosen, there is no DDE access to Variables or Strings. The De-
fault setting is DDE access allowed. 

Write to data file Header (DDF and ASCII) 

When this option is chosen, this Variable/String is written into the file header 
when you save data using the DASYLab or ASCII format file formats. When us-
ing the ASCII format you must define whether the strings/variables should be 
written as readable entries or just as information in the Write Data module. This 
information can be read back using the Read Data module. 

Ö If Take variables or Take strings option in the Read Data module is active, 
previously defined strings or variables will be overwritten. 

Show Global String/Variable in Window 

Choose this option to open a display window showing the contents of selected 
Global Strings and Global Strings. The display will update when the values 
change. The description and the contents are displayed, but not the number of 
the Variable or String. Use this option to display the current file name when the 
File Name -> Global String option is selected in the Read Data or Write Data 
modules. 

Type In at Start of Experiment 

When this option is chosen, a dialog box will open when the experiment starts. 
All defined Strings or Variables are listed in the input area. Up to 10 Strings and 
Variables are displayed on each page. If there are more than 10 entries, you can 
select the next page. You can change each String or Variable before starting 
measurement. 
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If the Read from INI File at start of experiment option is also chosen, all entries 
in the INI file are read and displayed in the dialog box. 

Click the Start button to start measurement with the defined parameters. If you 
choose Cancel, measurement will not start and the program will switch to the 
DASYLab worksheet window. 

To change the order of the Variables/Strings shown in the startup dialog box, 
use the Design Startup Dialog command in the Options menu. 

Do not overwrite description 

If this option is chosen, only the value or string of the global variable or string 
stored in the INI is read (at start of experiment or via action), but not the text 
used as description. 

Input is required to close dialog box 

With this option activated, the input dialog box will not close unless at least one 
character is entered into the entry field. This option affects the input of global 
strings at start of measurement or using event driven actions. 

File Name Dialog 

Select this option to specify that the string will be used as a file name. At the start 
of the experiment or via an Event Driven Action, an Explorer window will be 
opened to select an existing file name. Double click on the file name to copy it 
directly into the string window. In the Pull down window you can select the type 
of file to be loaded. Choose whether the selected file will be used to load data 
(Read Data) or to write it (Write Data). 

Working Examples of Global Strings and Variables 

Global Strings and Global Strings are useful in several modules. To use Global 
Strings, an identifier ${STR_xxx} is inserted into an arbitrary alphanumeric 
string, where xxx is a numeric character from 1 to 999 (${STR_0001} to 
${STR_999}). Spelling is not case sensitive. You cannot have blanks between the 
$ character and the curly bracket. Terms that are not recognized return an empty 
string. Global Strings are specified by the identifier ${VAR_0001} to 
${VAR_999}. DASYLab automatically recognizes whether it should be used as 
text or as a numerical value. The preset format is used for text. Maximum num-
ber of characters in Strings or Variables is 256. 

To manipulate Global Strings or variables via DDE, there are 4 new DDE items 
available to the Menu topic: SetGlobalString, GetGlobalString, 
SetGlobalVar and GetGlobalVar. With both Get functions, only the 
number is transferred as an ASCII value (in which case DASYLab acts as a DDE 
Server. The connection is a Cold Link). The result is sent back by DASYLab as 
an ASCII value. When there is no result (wrong number, etc.) DASYLab answers 
with a string containing “Parameter Error.” To set Strings or Variables (DASY-
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Lab acts as a DDE Server. Connection has to be a DDE Poke) the number and 
the defined character string or the numerical value is sent separated by a semico-
lon. DASYLab doesn’t send an answer message. 

Input strings/variables using actions 

The Action Module has two global (DASYLab) actions: Set Variable and Set 
String which allow you to enter strings and variables. In the Action Module pa-
rameter settings you can define any string that will then be displayed as the title 
of the input window. 

These entries are only accepted if each global string With Input Required ... con-
tains at least one character. 

To access the variable/string No 1, the entry in channel 1 has to be 0, for No 2 
use 1, in No 3 use 2 and so on. Only first 16 variables or strings can be accessed 
(channel = 0 ... 15) 

Automatic Creation of directories with time stamp 

To store data files automatically into separate directories with names containing 
the actual month and day in their name, and with the hour of storing in the file 
name, use the following entry in the Write Data module: 

C:\DASYLAB\DATA\${MONTH}-${DAY}\${HOUR}h 

Additionally, the worksheet has to contain an Action module with the 
Close/open worksheet action with the Global String has changed event on two 
channels. The event parameter for the first channel is the ${DAY} string and on 
the second it is the ${HOUR} string. On the third channel, the Save Data ac-
tion must be initialized on the ${HOUR} event. 

After measurement has started the following actions will happen: 
(Starting date and time of measurement: May, 28th, 1998, 13:30)  

Reaching the next full hour, a new directory  

C:\DASYLAB\DATA\05-28 is created and the file 14h.ddf is stored in 
that directory. 

When starting the next full hour, a new the file 15h.ddf is written into the 
same directory and so on, until midnight is reached.  

Now the new sub-directory 05-29 is created in ..\DATA\ and the first file 
00h.ddf. Until the next change of date is reached, each hour a new file is writ-
ten into the sub-directory. 

This cycle repeats until measurement stops. The following file structure is cre-
ated: 
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1.6.17 Export and Import Global Strings and Variables 

Use this menu commands to export or import all Global Variables and Strings 
into or from a file with the extension *.VAR. This feature allows you to ex-
change the of Global Strings and Variables settings between several worksheets. 

This file format is binary, so you cannot edit it directly.  

In addition to the *.VAR file format (generated by the Global Variable Export 
function) you can now select the *.CSV and *.TXT (Excel format) file formats. 
To import an Excel table the values need to be separated by a comma. The en-
tries to configure the global variables are (Strings are not valid.): 

Col 1 , Col 2 , Col 3 , Col 4 , Col 5 , Col 6 , Col 7 

Num-
ber 

, Name , Descrip-
tion 

, No. 
Chars 

, No. 
digits 

, Value , Expres-
sion 

In this way you can configure the global variables in an Excel table. It is very easy 
to use Copy and Paste functions to create similar configurations. You must use 
caution to ensure that you do not enter the same entries several times into the 
global variable dialog box.  

Blanks at the beginning and end of the entries are removed. If the entry is longer 
than the maximum length (name 19, description 23, and expression 255), it is 
truncated.  

If errors in are found when the file is read (for example, if the name contains a 
reserved character, VarNumber is out of range, the expression is not defined, 
etc.) then the offending entry is ignored. If the Expression field is empty then no 
expression is defined for the variable. 

You cannot import Variables/Strings while the worksheet is running. 

1.6.18 Design Startup Dialog 

Use this command to configure the order of the dialog box that is displayed 
when the program starts. All Strings/Variables with the Type in at Start of Ex-
periment option activated are listed in the dialog box. Only the Short description 
is displayed (not the String/Variable number.) If there is no description the line 
is empty, but is still available. Use the mouse or the cursor keys to select an en-
try. Use the arrow button to move the selected line up or down. When the ex-
periment starts the next time, the Startup dialog shows the Variables/Strings in 
the new order. 
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If you disable the Type in at Start of Experiment option for one or several Vari-
ables/Strings, the entries are removed from the list and the following items move 
up to the next free position. If you subsequently re-enable the option, the Vari-
ables/Strings are re-inserted at the first line of the list. 

1.6.19 Variable/Strings Overview 

Use this menu command to open an additional window that shows all available 
global variables and strings figured in a tree-view.  

Use this overview to easily and quickly explore the places where variables or 
strings are used in worksheet.  

The left side of the window shows a tree with all variables and strings and its use. 
The right side of the window shows any additional information that may be 
available for the selected element at the left.  

Variables or strings that might be written in multiple places are marked in red to 
highlight possible conflicts. 

Free Variables/Strings are shown separately, so you can easily find available (un-
used) ones.  

You can open the variables/strings overview window from different places in the 
program:  

� Main Menu: Options -> Global Variables and Strings ->  Overview 
Global Variables/Strings. 

� Use the Overview… button in the Select global Variable, Select 
Global String, Define Global Variables and Define Global Strings dia-
logs 

� Use the context menu command by right-clicking in Dialog box pa-
rameter Edit lines.  

 
If there is a global variable or string placed in the edit box, it will already be se-
lected when the Overview is started. To change the variable/string you may select 
another directly from the variable overview and insert it into the edit box by 
right-clicking and choosing the Return with Variable command “. 

The Overview Window 

Elements of the window 

The left of the Overview window shows the following items: 

� Used Variables 

� Free Variables 

� Used Strings 

� Free Strings 

� Modules to check manually 

Only those items are shown which contain information. 
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Used Variables/Strings: Variables/Strings are marked as used if they 
are defined at one of the following places in the worksheet: 

 Variables/String supporting … 

� Modules 

� Layout Objects 

� Variables Expressions 

� Keyboard Actions 

� Sequencer Actions 

� Time Bases 

Free Variables/Strings: Variables/Strings are marked as unused if they 
don’t match the definitions for “Used Variables/Strings”. The “Used” 
definition is not fulfilled if only a value or name is assigned to the 
variable or string. 

Modules to check manually: The overview mechanism has to ex-
change information with all modules to be able to check whether a 
module uses variables or strings. This function was first implemented 
in **Name1 Version 8. If a custom made module is used in the work-
sheet, the overview engine may not be able to connect to the module. 
To show the user these unchecked modules, they are listed as an addi-
tional entry in the window. You can check the modules manually for 
used variables or strings.  

Hints and Restrictions 

Read or Write Access indicates the possibility that variables or strings 
might be written or read or both when the experiment is started. The 
check for real reading or writing a variable or string is not imple-
mented. The variables/string check is only performed in the Off-line 
phase. A check for “real” access to variables or strings when the work-
sheet is running is not available.  

The Variables Overview is not able to detect the following usage of 
variables or strings: 

� The global Variable used in the Dialog Global Worksheet 
Parameter is not shown in Overview of the Global Vari-
able/Strings!  

� NiDAQ and DAP (Microstar Laboratories) have an option 
to write the load of the internal buffer into a global variable. 
The usage of that variable is not detected by the variable 
overview algorithm. 

� The Read File module also allows you to read global vari-
ables from the header of a file. These variables are not rec-
ognized by the variables overview (also because the file 
name can be build by global variables and so the file name is 
determined only while the worksheet is running.) 
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Status Line  

The Status line shows messages and progress information in reading 
the variables/strings information. If no message is available and the 
reading of information is completed the text of the selected entry is 
shown (may be in modified style). You can copy that information into 
the clipboard. 

Main Menu 

File 
• Refresh: The worksheet is completely checked again for the 

usage of variables and strings. The tree-view is refreshed. Use 
this option if you have modified any string or variable in 
some module dialog. Automatic refreshing is not imple-
mented so you should use the Refresh function each time 
you change global variables/strings settings.  

•  Exit: Close the Overview-Window. If you opened the win-
dow from an edit box there will be no change to the value in 
the edit box although you may have made a change. To 
keep the changed value you must right click to open the 
context menu and select the Close and return variable 
command. 

Help: Opens this help page. 

Context Menu 

The context menu opens if you click with the right mouse button on 
one of the elements in tree. 
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� Expand: Opens recursive all sub-entries of the selected item.  

Available in: All items in tree. 

� Collapse: Reduces recursive all sub-entries of the selected item. If you 
expand the branch again all previously opened displayed branches are 
shown collapsed, as opposed to reducing the tree using the minus sign 
at the beginning of each open branch. In this case, all branches are 
shown as before (open or closed) when you click the plus sign in front 
of the branch. 

Available in: All items of tree. 

� Collapse all: Reduces recursive all entries of the tree. It works like the 
Collapse command performed at the first level entry Variable Over-
view  

Available in: All items of tree. 

� Sort by Variable Names: By default, the entries are sorted numerical 
order. This command changes the order to alphabetical by name. 
Variables without a defined name are listed after the named variables 
(ascending order). 

Available in:  

• Used Variables 

• Free Variables 

• Used Strings 
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• Free Strings 

� Sort by Variable Numbers: By default all variables are sorted in as-
cending order. 

Available in: see "Sort by Variable Name" 

� Go to…: Some of the displayed elements in tree can be accessed di-
rectly from tree.  

Available in: 

• Modules 

• Layout-Objects:  Text line, Text block, Text grid, linked Text 

• Time base. 

 

If the Variables Overview wasn’t opened from the main 
menu, this command is not available. 

� Open Dialog: The properties for some of the tree objects can be 
opened directly from the variable overview to allow you to easily 
change its properties.  

 

After making a modification in the properties dialog box, use 
the Refresh command to bring the Variables Overview up-
to-date, correctly reflecting the actual status of the worksheet. 

Available in: Modules 

• Layout-Objects: Text line, Text block, Text grid, linked Text 

• Time base. 

 

If the Variables Overview wasn’t opened from the main 
menu, this command is not available. 

� Search: This command allows you to search recursively for strings in 
the structure of the tree. The search is restricted to the entries in the 
left side of the window. Items in the right are not searched. 

Available in: All entries in tree. 

 

� Continue Search: You can continue the search, looking for the next 
matching entry using this command. The search starts at the last 
found entry. If you mark another entry in the tree, the search will still 
start at the last found search string. Use the <F3> key as a shortcut key 
to continue the search. The search direction is always down. You can-
not search back up through the tree. 
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Available in: All entries in tree, if the last search has found any 
string. 

� Level: Offers the selection of “level 0" to "level 6". Choose one of the 
levels to expand all entries up to the level n. The selected entry defines 
the level 0. 

Available in: All entries in tree. 

� Close and Return Variable: Shut down the Variable Overview win-
dow and returns the Variable or String of the selected entry to the dia-
log box where the variable overview was selected.  

Available if: The Variable Overview was called up from a context 
menu of an edit box. If the edit box only allows numerical variables 
only these values are returned to the modules. 

Global Variables/Strings are called up using one of the following dia-
logs: 

• Select Global String 

• Set Global String 

• Select Global Variable 

• Set Global Variable  

1.6.20 Copy Channel Names 

This function causes DASYLab to copy the channel names from each module to 
connected modules. By default, the option is activated in the module dialog box 

1.6.21 Switch to Runtime 

Choose this function or click on the icon on the function bar, to reduce the DA-
SYLab worksheet window to its Runtime size. In its place, a minimized control 
panel appears which contains only the status bar (displaying the current time and 
the buffer status) and the control icons from the function bar which allow you to 
start, stop, pause and continue the experiment.  

Additionally, all active display windows (analog/digital meters, scopes etc.) are 
displayed on screen. 

This option allows you to determine how your worksheet will appear when 
loaded with the DASYLab Runtime version; you can concentrate on those ele-
ments that are essential for the control and evaluation of the actual experiment. 

1.7. Window Menu 

Use the commands of this menu to switch between Worksheet, Display and 
Layout windows or to create new VITool Layout pages. 

New Layout 

Control Sequencer 
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Display Windows 

Worksheet 

Layout 

DASYLab lists the names of all created windows, starting with the display and 
followed by name of the worksheet. Then all Layout windows are listed. Click 
on the name to activate a window. The Menu Bar will change depending on the 
type of the activated window (Control Sequencer, Display, Worksheet or Lay-
out). 

You can also switch between display modes by clicking on the function bar icon. 

 

1.7.1 New Layout 

Use this command to create a new Layout Window. The name of worksheet and 
the first nine Layout Windows are displayed below the menu commands. If 
there are more than ten windows you can use the More command to see them. 

1.7.2 Control Sequencer 

 
Use this command or click on the function bar icon to switch to the Con-
trol Sequencer View. 

1.7.3 Display Windows 

 
Use this command or click on the function bar icon to switch to the Dis-
play Tree View 

1.7.4 Layout 

 
Use this command, or click on the function bar icon, to switch to the 
Layout View 

1.7.5 Worksheet 

 
Use this command, or click on the function bar icon, to switch to the 
Worksheet View. 

2. Control Sequencer Menus 

The commands of the Control Sequencer File menu enable you to save and 
open Control Sequence files, to print worksheets, to manage your worksheet 
files, and to exit the program. 
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Control Sequencer File 
To control a multi-step application consisting of more than one DASYLab 
worksheets calling each other, DASYLab offers a new tool, shown as new display 
window (analogous to the worksheet, display and VITool windows), called the 
Control Sequencer Window. The contents of the window is stored in a new type 
of file, the Control Sequencer file (saved with the suffix *.DSQ.) 

The window shows a tree display of the control sequence. You can add any 
number of worksheets into the Control Sequencer File, whose name is shown as 
root of the tree.  

You can also multiple actions for each inserted worksheet to control the flow of 
the worksheets.  

In the Control Sequencer window you can load and save *.DSQ files using the 
main menu file commands: New, Open, Save and Save As…. 

To insert flowcharts or actions you need to use the pop-up context menu that 
appears when you right mouse click on one of the junction points on the screen. 
Depending on the junction (flowchart or action) the pop-up menu offers several 
commands to add, delete or to edit the object. 

Ö The Sequence file is a binary file type. You cannot edit it with ASCII Editor 
programs such as Notepad. 

2.1. File Menu 

See Worksheet Window Menu: File Menu (page 4-1). 

2.1.1 New 

Choose this command to create a new Control Sequence file. The DASYLab 
Control Sequencer work area will be cleared completely. 
If there is already a Control Sequencer file loaded on the screen that has changed 
since you last saved it, you will be asked to 
� save that file before beginning work on the new one, 

� or to reject those changes, 

� or to recall the New command. 

After creating the new Control Sequencer file you can save it to a file by select-
ing the Save or the Save As... commands from the File menu. 
Click on the Save icon in the function bar to save the current file. 

2.1.2 Open...  

Choose the Open command, or click the function bar icon, to open a Control 
Sequence file that has been previously saved. The DASYLab Control Sequence 
work area will be cleared completely. 
If there is already a Control Sequencer file loaded on the screen that has changed 
since you last saved it, you will be asked to 
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� save that file before beginning work on the new one, 

� or to reject those changes, 

� or to recall the Open command. 

After choosing the Open command you can select the file on which you want to 
work from a list of files. 

You can ... 
� open one of the files from the list directly by double-clicking the file 

name, 

� select a different directory by double-clicking the directory name, 

� select a different file format for the file display, or 

� select a different drive. 

To use your keyboard, press the TAB or the SHIFT+TAB keys to move from 
one field to another; select items from the lists by pressing -, ¯, SPACE and the 
ENTER key. 
In the File Name box you can define the filter for the file list. The default setting 
for the filter (*.DSQ) will create a list of DASYLab Control Sequencer files, 
which usually have the extension *.DSQ.  
Type a different extension, or use wildcards (like *.*), to display lists of different 
groups of files. For example, if you have saved DASYLab Control Sequencer files 
with extensions other than *.DSQ (using the Save As... command from the File 
menu). 

However, DASYLab can only open files in the special own DSQ format no mat-
ter what extension the files have. 

2.1.3 Save...  

Choose the Save command, or click the function bar icon, to save a Control Se-
quence file. 
If you have created a new Control Sequence file (New from the File menu) 
without saving it to a file (untitled is displayed in the DASYLab window title 
bar), you can select the file name, the directory and the disk drive where the file 
is to be stored: 

� Type the file name in the File Name box. 

� If you do not type an extension, DASYLab will automatically add the 
standard extension (*.DSQ). DASYLab always saves worksheet files in 
its own format, even if you select an extension other than *.DSQ.  

� You can... 

� select one of the file names in the list by double-clicking the file 
name. The file that was originally saved under that name will 
then be replaced with the new worksheet. A warning message will 
first appear, asking you to either confirm the procedure or to 
cancel it. 
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� select a different directory by double-clicking the directory name, 
or 

� select a different drive for the new file. 

(To use your keyboard, press the TAB or the SHIFT+TAB keys to move from 
one field to another; select items from the lists by pressing -, ¯, SPACE and the 
ENTER key.) 
If you have previously saved the Control Sequence to a file (using the Save As... 
or Save commands from the File menu), or if you have opened an existing file 
(command Open... from the File menu), its name is displayed in the DASYLab 
window title bar. 

Select the Save command, or click the function bar icon, to save the current 
Control Sequence file. The existing file will be replaced without further mes-
sages. 

2.1.4 Save As… 

Choose the Save As command to save a Control Sequence with a new file name, 
in a different directory, or on a different drive. 
After you have chosen the Save As... command from the File menu you can se-
lect the file name, the directory and the disk drive where the file is to be stored. 
� Type the file name in the File Name box. 

� If you do not type an extension, DASYLab will automatically add the 
standard extension (*.DSQ). DASYLab always saves Control Se-
quence files in its own binary format, even if you select an extension 
other than *.DSQ.) 

� You can... 
� select one of the file names in the list by double-clicking the file 

name. The file that was originally saved under that name will 
then be replaced with the new Control Sequence. A warning 
message will first appear, asking you to either confirm the proce-
dure or to cancel it. 

� select a different directory by double-clicking the directory name, 
or 

� select a different drive for the new file. 

�  (To use your keyboard, press the TAB or the SHIFT+TAB keys 
to move from one field to another; select items from the lists by 
pressing -, ¯, SPACE and the ENTER key.) 

2.2. Edit Menu 

This view does not include an Edit Menu. 

2.3. Experiment Menu 

See Worksheet Window Menu: Experiment Menu (page 4-21). 
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2.4. View Menu  

See Worksheet: View Menu (page 4-35). 

2.5. Options Menu  

See Worksheet: Options Menu (page 4-85). 

3. Tree View Menus 

3.1. File Menu 

See Worksheet Window Menu: File Menu (page 4-1). 

3.2. Edit Menu 

This view does not include an Edit Menu. 

3.3. Experiment Menu 

See Worksheet Window Menu: Experiment Menu (page 4-21). 

3.4. View Menu  

See Worksheet: View Menu (page 4-35). 

3.5. Options Menu  

See Worksheet: Options Menu (page 4-85). 

3.5.1 Tree Display Setup 

Use the menu command to change the properties of the Display Window.  

Display: 

� Normal: In the 32-bit version, this setting shows the measurement 
setup as a structured tree similar to the Windows Explorer. Click onto 
the elements of the tree to open the next branch or an accompanying 
dialog box. 

In the 16-bit version, the window is empty. 

� Bitmap: Choose this option to insert any picture in BMP or WMF 
format into the Window. Use the Bitmap... button to select the bit-
map file. 

Ö The bitmap is not stored with the worksheet, but only a link to that 
file is stored. The specified bitmap file has to exist in the named direc-
tory to be displayed. 

� Sorting (not available in 16 bit version): Select the order the modules 
are displayed in the tree: 
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Alphabetically: All modules are listed in alphabetic order. 

Alphabetically, Black Boxes separately: All modules are listed alpha-
betically, but the modules inserted into Black Boxes are listed sepa-
rately. 

Class of modules: Modules are assigned to the several module groups 
and then are listed in alphabetic order. 

 Creating order: Modules are listed in the order they were inserted into 
the worksheet. 

� Bitmap Display: The Original Size of Bitmap option shows the in-
serted bitmap scaled 1 / 1 (Pixels) centered in window. The back-
ground of the window is colored as selected in the Option Menu of 
the Worksheet Window. 

The Stretch Bitmap switch adapts the Bitmap to the window frame. 
Proportions of picture may be distorted. 

The Tiled setting fills the complete frame with pictures of the bitmap 
(sized 1/1). 

� Background: Click on this button to choose a color for the back-
ground. 

3.6. Window Menu 

The options of this menu are described in Worksheet: Window Menu (page 4-4-
71). 

4. Layout Window Menus 

4.1. File Menu 

See Worksheet Window Menu: File Menu (page 4-1). 

4.2. Edit Menu 

The commands of the Edit menu allow you to copy, paste and delete the DASY-
Lab Layout Elements displayed on the screen. 

 Layout to Clipboard (Metafile) 

 Layout to Clipboard (Bitmap) 

 Layout… 

 Undo  

 Select 

 
Cut 



DASYLab®   Layout Window Menus 

 4-77 

 
Copy 

 
Paste 

 Delete 

4.2.1 Layout to Clipboard (Metafile or Bitmap) 

Use this command to copy the Layout Window as a Windows Metafile (WMF/CLP) 
or as a Bitmap (BMP) to the Clipboard. 

The layout is always copied to the Clipboard as displayed on screen, including all 
the changes made since last saving it. The Layout itself will not be modified. 

The Size of the Layout Window in the Clipboard is automatically matched to 
the size of the area used on the worksheet. If you arrange only a few small ele-
ments they will appear larger on the clipboard.  

Use the Paste function in any Windows application (usually in the Edit menu) 
to copy the meta or bitmap file from the Clipboard to applications such as 
PaintBrush or Word for Windows. 

4.2.2 Layout… 

Use this command to save or load Layout Windows onto the worksheet. See 
Worksheet Window Menu: Layout (page 4-12). 

4.2.3 Select Layout Window  

Use the menu function to activate the toolbox selection tool. 

4.2.4 Undo 

Use this command to undo the last operation. All changes to Layout Objects 
(like modifying colors, size or other properties) are canceled. Choose this func-
tion using the Undo menu command or by using the ALT+Backspace or 
CTRL-Z key combinations. 

4.2.5 Object Cut, Copy, Paste and Delete 

You can copy and paste objects of the Layout Window including their proper-
ties: 

� Selection: First select the objects: click and hold the left mouse button 
inside the worksheet and select the area by dragging the cursor. When 
you release the mouse button, the selected modules are highlighted. 
You can select or deselect single objects by clicking the left mouse but-
ton on the module while pressing the SHIFT or CTRL key. 
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� Copy: Choose the Edit/Copy menu command or the CTRL-INSERT 
or CTRL-V key combinations. The selected objects are inserted 
onto the worksheet with their properties settings intact. 

� Cut: To move modules around the worksheet, choose the Edit/Cut 
menu command or the SHIFT+DEL or CTRL-X key combinations 
to remove the objects from the worksheet and to save them for a Paste 
operation. 

� Paste: Now paste the stored objects by choosing the Edit/Paste menu 
command or pressing SHIFT+INSERT or CTRL-V. After acti-
vating the insert mode, the mouse cursor changes. Choose the position 
where the selection should appear. The window is scrolled automati-
cally when the mouse cursor moves outside the window border. Once 
the mouse cursor is at the destination, press the left mouse button to 
paste the objects into the Layout Window. The paste operation can be 
repeated. 

� Delete: Choose the Delete menu command or the Delete key to delete 
the selected objects 

4.3. Object Menu 

Choose the objects you want to insert into the Layout Window. You can also 
choose objects using the Layout Window Toolbox. The Properties command al-
lows you to change the characteristics of the selected object. 

 Drawing Elements 

 Visualization 

 Text Elements 

 Properties 

 Placement 

4.3.1 Drawing Elements 

Choose this command to select Drawing Elements to be inserted into the Layout: 

� Line 

� Bitmapped Graphics 

� Ellipse – filled or not filled (outline) 

� Rectangle – filled or not filled (outline) 

You can also choose an element by using the Tool Box buttons. 

Click the left mouse button inside the Layout Window to define the start posi-
tion of the Element. Click and hold the mouse button to draw a frame that de-
fines the size of the element. Release the left mouse button to complete the 
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command. To set properties of an element, select it with a left mouse click. Dis-
play the Properties Dialog Box by double clicking on the frame. 

Properties (all objects) 

Placement: Units for Position and Size are set in Centimeters or Inches depend-
ing on the settings in Main Menu File: Page Format. 

Color: Use the Color button to select the color in the Windows Color Menu 
Box. The object will be drawn in the selected color. 

Bitmapped Graphics Properties 

Drawing Mode: 

This Option changes how the imported bitmap is shown in the frame. 

� Adjusted: The Bitmap is resized to the borders. Because the aspect ra-
tio is not maintained, the picture can be contorted. 

� Scaled: The picture is completely shown in the frame. It is dis-
played enlarged or reduced with original aspect ratio 

� Original: The Bitmap is displayed in its original pixel size (number of 
pixel in the bitmap = number of pixels on the screen). If the frame is 
smaller than the bitmap, all parts of the picture rising above the lower 
and right border are cropped (not displayed). 

File Name: This entry shows the name of the Bitmapped Graphics File that will 
be displayed. You cannot edit this entry. To change the File you must use the 
File… Button. 

The left window of the dialog box shows all available files in directory, the right 
window shows the directory file structure. The File Format command selects the 
Bitmapped Graphics File Format (*.BMP, *.WMF). The Drive command selects 
the drive you want to read from. 

Ö External Bitmapped Graphics are not stored in the worksheet. Only the name and 
path of the files will be stored. To display the specified bitmap, the file must be avail-
able in the specified directory. Bitmapped Graphics inserted by using the clipboard 
are stored with the worksheet. 

4.3.2 Visualization 

Choose this command to select a Visualization Element to be inserted into the 
Layout. These elements are linked with the Display Modules of the worksheet. 
You can create a maximum of 512 linked elements in the VITool Layout Win-
dows. 

� Text  

This Visualization Element shows the contents of the alphanumerical 
displays such as List module or Digital Meter module as dynamic text 
elements on the Layout page. Only the alphanumeric characters are 
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displayed but not window elements such as borders or window cap-
tion. 

� Graph 

This Visualization Element shows the contents of the display modules 
on the Layout page. Only the contents of the display area are dis-
played but not window elements such as borders or window caption. 

You can also choose an element by using the Tool Box buttons. 

Click the left mouse button inside the Layout Window to define the start posi-
tion of the Element. Click and hold the mouse button to draw a frame that de-
fines the size of the element. Release the left mouse button to complete the 
command. To set properties of an element, select it with a left mouse click. Dis-
play the Properties Dialog Box by double clicking on the frame. 

Properties (all objects) 

Placement: Units for Position and Size are set in Centimeters or Inches depend-
ing on the settings in Main Menu File: Page Format. 

Linked Text Properties 

Link: Choose the name of the module that will send the strings. 

Text: Insert the text that should be shown in front of (pre) and after (post) the 
linked string. 

Options 
Alignment: Text can be aligned right, left or centered. 

90° Rotation: The text Frame will be rotated 90° counter clockwise.  

Font: Use the Font button to select font and size in the Text Menu Box. 

Ö Use only TrueType fonts with rotated Linked Text Objects to prevent problems. 

Linked Graph Properties 

Link: Choose the name of the module that will send the graphical information. 

Auto Update: If this option is turned off, the display of linked graphical objects 
is not updated when new data is received. To update manually, use Key Events 
or Event Driven Actions. 

Sync Event Handling: Use this function with synchronous Event Driven Actions 
to synchronize the Layout display with an event driven action. While this func-
tion is disabled, there may be incorrect or inconsistent data when printing a 
Layout Window (premature or late blocks). 

Fast Draw Function: While this Option is active, only the dynamic Elements of 
the Graphical Object are updated. You will get a better screen view, with less 
“flashing” as the data is updated. 

Display: 
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� Background: While this option is active, the background in the object 
frame will not be transparent but will be opaque and colored. To se-
lect the color, use the Color... button. 

� With frame: While this option is chosen, the object frame will not be 
transparent but will be visible and colored. To select the frame color, 
use the button Color.... 

� Frame as shadow: While this option is chosen, a shadow is displayed 
on the object frame. 

� Width: This entry defines the thickness of the drawn object frame. 

Zoom: X/Y, Y/t or Recorder Chart modules can be zoomed as well as in the dis-
play windows on worksheet: 

� Zoom-In: With the Ctrl-key pressed, you can draw a rectangle with 
left mouse button pressed. The marked area will be scaled to the size 
of the display area in the graph link.  

� Zoom-Out:You can resize the zoomed display with Ctrl-key pressed 
and a right mouse click in the display area. 

Cursors: If there are cursors shown in the display window in worksheet or dis-
play views, they are also shown in the linked object in the VI-tool Layout Win-
dow. You can move the cursors using the mouse. If you want to display the cur-
sor data on your layout page, you must activate the SurveyÆ Print Cursor Data 
in VI-Tool menu command in the display window menu. You can access this 
menu in from the Layout Windows object by right-clicking the mouse. A tear-
off menu will appear where you can select command. 

Setup: This button opens the Display window Setup dialog of the module 
linked to that graphic object. 

4.3.3 Text Elements 

Choose this command to select between two types of Text Elements that can be in-
serted into the Layout. 

� Text Line 

� Text Block 

� Text Grid 

Also you can choose the Elements by using the Tool Box buttons. 

Click the left mouse button inside the Layout Window to define the start posi-
tion of the Element. Click and hold the mouse button to draw a frame that de-
fines the size of the Element. Release the left mouse button to complete the 
command. To set properties of an Element; select it with a left mouse click. Dis-
play the Properties Dialog Box by double clicking on the frame. 

Text Line / Block Properties 

Placement: Units for Position and Size are set in Centimeters or Inches depend-
ing on the settings in Main Menu File: Page Format. 
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Text: Insert the text that will be shown on Layout.  

Ö A Text Line is always shown in one line. It will be cut (truncated) at the end of 
the line. The text of a Text Block will be broken at the end of the line and contin-
ued in the next line. 

Ö A Text block is always shown in one complete block. It will be broken at the end 
of line and continued on the next line.  

ª You can use placeholders to insert special system information including the date, 
time, file name, or global variables and strings. 

Grid Text Properties 
Select the following Properties: 
� Placement: Units for Position and Size are set in Millimeter or Inches 

depending on the Main Menu File: Page Format settings. Depending 
on the number of columns, the List is split into columns of the same 
width. The height of rows depends on the selected font size. 

� Setup: The list is shown with the defined number rows and columns.  

� Text Setup: The input of row and column number selects the cell to 
be edited. The text has to be inserted into the edit field below. You 
can use placeholders to insert special system information (e.g. data, 
time...). 

Ö Text in the cells will not be wrapped at the cell border but written above the text 
of the next cell 

� Alignment: You can set the alignment to left, right or centered. 

� Font: Use the Font button to select the font and color in the Text 
Menu Box. The font size takes effect to the height of the rows of the 
list on the layout.  

� Display 

Background: when this option is active, the background in the object 
frame will not be transparent but will be opaque and colored. To se-
lect the color, use the Color... button. 

With frame: when this option is chosen, the object frame will not be 
transparent but will be visible and colored. To select the frame color, 
use the button Color.... 

Frame as shadow: when this option is chosen, a shadow is displayed 
on the object frame. 

Width: This entry defines the thickness of the drawn object frame. 

Options 
Alignment: Text can be aligned right, left or centered. 

90° Rotation: The Text Frame will be rotated 90° counter clockwise.  
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Font: Use the Font button to select the font and size in the Text Menu Box. 

Ö Use only TrueType fonts with rotated Linked Text Objects to prevent problems. 

Placeholders in Text Objects 

You can use placeholders to insert special system information including the date, 
time, file name, or Global Strings and Strings. The following placeholders are 
available: 

Placeholder Information Inserted  Available in 

${DEPARTMENT} Department from File Info Text line 
${AUTHOR} Name of Author from File Info Text line 
${DATE} Actual System Date Text line 
${COMPANY} Name of Company from File Info Text line 
${TIME} Actual System Time Text line 
${KEY_ACTIONS} List of defined Key Actions Block text 
${STRING_[No]} String No X, defined in Options 

Menu 
Text line 

${STR_[No]} String No X, defined in Options 
Menu 

Text line 

${VAR_[No]} Variable No X, defined in Options 
Menu 

Text line 

Ö Insert Strings and Variables Number without the square bracket inside the 
curly brackets, for example, ${STRING_33} will insert the Global String 
number 33. 

 Right-click on the text entry box to see a pop-up menu that allows you to 
choose from available Global Strings or Variables, including system vari-
ables. 

4.3.4 Properties 

This command opens the Properties Dialog Box for the Layout page or for the selected 
Layout object. 

4.3.5 Placement 

Choose this command to change the position of layered elements. You can move the 
selected element one layer Up or Down or move them into the Front or Background. 

4.4. Experiment Menu 

See Main Menu: Worksheet Window Menu: Experiment (page 4-21). 
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4.5. View Menu  

The commands of this menu allow you to change the appearance of the DASY-
Lab layout on the screen. Some of these functions can be chosen by clicking the 
corresponding icons on the Function Bar. 
 Function Bar 

 Module Bar 

 Status Bar 

The above options of the menu are described in the Worksheet: View Menu 
(page 4-35). 

 Zoom / View 

 Full Screen 

Zoom / View Layout Window 

Use this command to zoom the Layout Window (25% to 200%). Use command 
Fit to Screen and Fit to Page to adapt the Layout Window format of the screen 
or the page. 

Full Screen 

Use this command to show the Layout Window in Full Screen Mode. Its size 
will be adapted to show the whole Layout Window. All elements such as Func-
tion Bar, Menu Bar and so on are hidden. Use the ESC key to change to normal 
mode. 

Ö To get best results for Full Screen Display use the screen Page Format. You 
can select it using the properties command of the Object Menu. 

4.6. Options Menu  

The commands of this menu allow you to change the display of the DASYLab 
Layout window. 

 Global Layout Properties 

 Layout Page Properties 

 Default Directories 

 Hot Keys… 

 Password Protection 

 Password Definition 

 Screen Locking 

 Key Events 

 Define Global Strings 
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 Define Global Variables 

 Variables/Strings Overview… 

The above options of the menu are described in Worksheet Window Menu: 
Options Menu (page 4-41). 

 Layout Window… 

 Layout Page… 

4.6.1 Global Layout Properties 

This option allows you to define the starting options of all defined Layout Win-
dows. These options apply to all layouts of the open worksheet. The following 
settings are available: 

� Mouse: While Mouse To Interact With Instruments is active, you can 
only operate elements like switches or push buttons. You are not able 
to create objects or modify them. 

To create or modify elements in the Layout Window, you have to 
switch to the Mouse to interact with Layout Window option. 

� View: Choose the Load As Full Screen option to load the first Layout 
Window into the foreground when DASYLab is next started. If the 
worksheet window was active when DASYLab was closed, it will be 
placed in the foreground. 

4.6.2 Layout Page Setup 

Use this menu command, or double click anywhere on the Layout Window to 
open the Properties dialog box. You can change the following: 
� Format: Select between DIN or US page formats (Landscape or Por-

trait) or choose Screen format.  
� Name: In the edit field below the format you can define an individual 

name for this layout window. Instead of the default name, Layout X, 
the title of the Layout window will be Name X. The layout number is 
still used by in Action modules to control switching between several 
layouts. 

� Border: You can define Borders. All text objects outside the defined 
border will be cut off. The Visible option allows you to fade out/in 
lines that mark the defined borders. The Use border switch activates 
the clip function. 

� Grid: The Snap to grid option places all objects according to the de-
fined grid. 
The default Distance of the grid is 5 mm (0.2 inch). To display the 
grid on the screen, activate the visible option. 
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The following settings control the display properties of layout objects.  

Object Display: 

� Show objects only: Only the origin object is displayed on the layout. 

� Objects with frames: Objects with their position borders are shown. 

� Only frames: Only the position borders are shown. 

Objects outside the page 

� Hide objects: This selection hides all objects that are placed out of the 
defined working area. 

� Show objects: This option shows all objects, regardless of where they 
are placed. 

� Delete objects automatically: All objects placed out of the working 
area are deleted automatically. 

Moving Objects via keyboard: 

This setting defines the steps objects are moved using they arrow keys of key-
board: 

� Pixel Size: The selected objects are moved pixel by pixel. Absolute 
movement of object depends on the chosen zoom factor and resolu-
tion of screen. 

� Steps of XXX mm: All objects move in steps of millimeters. Relative 
width of step on the screen depends on the chosen zoom factor and 
defined size of page. 

� Grid Distance: The objects move in steps of the chosen width of grid. 
Relative width of step on the screen depends on the chosen zoom fac-
tor and defined width of grid. 

Color Buttons  

� Use the background... or Grid... color button to change the colors of 
the background of the layout sheet or the grid. 

� The Default button loads the default settings of that dialog box. 

4.7. Window Menu 

The options of this menu are described in Worksheet: Window Menu (page 4-
71). 
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5. Help Menu  

The commands of the Help menu allow you to obtain on-line help for the fol-
lowing program functions and for your data acquisition hardware. It also pro-
vides overviews and on-line tutorials. 

5.1. Index 

This option activates the Help system and displays the index of topics for which help 
can be obtained.  

5.1.1 Instruction 

Click this button to display on-line instruction on 
how to use the DASYLab Help System. 

Printed instructions on how to use the Help system are found in Chapter 2 of 
this manual. 

Further information on how to use the Windows Help system can be obtained 
by pressing the F1 function key while using a Help window, or by choosing Us-
ing Help from the Help menu. 

5.1.2 References 

Alphabetic Index of Help Topics / Alphabetic List of Modules 
Choose this menu function to view the alphabetical lists containing all the topics 
for which help is available. Use the scroll bars or press the ↑, ↓, PgUp or PgDn 
keys to scroll through the lists then click on the topic for which you want infor-
mation. You can also select a topic by pressing the TAB key until the topic is 
highlighted, then press ENTER. 

ª Click the Search button at the top of the Help window or press the S key on your 
keyboard for information on a specific topic. 

Glossary 
Choose this menu function to view the alphabetical list of terms with definitions 
that can be displayed as pop-ups on the screen. 

Ö A line indicates the end of each of these definitions. If a line does not appear at the 
bottom of the text box, your Help window is too small. Enlarge its size by dragging 
its borders or corners while pressing the left mouse button, and click the term again. 
Or, you can use the Scroll Bar to move around the window. 

Main Menu Options 
Choose this menu function to view the Help pages for all of the DASYLab menu 
options and commands. 
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Module Selection Menu 
Choose this menu function to view the Help pages for all of the module groups 
and modules. 

5.1.3 Step by Step Instructions 

The Elements of the DASYLab Screen 
Choose this menu function to view the overview of the DASYLab screen ele-
ments found in Chapter 3. 

Module Configuration and Manipulation 
Choose this menu function to view general comments on how to install, config-
ure, connect, move and delete modules. This information can be found in Mod-
ule Reference Guide.  

Creating your First Worksheet 
Choose this menu function to view the instructions found in Chapter 2 of this 
manual. 

5.1.4 Surveys 

How to Start/Stop an Experiment 
Choose this menu function to view the overview of the menu commands and in-
structions for automatic experiment control methods that can also be found in 
Chapter 6 of this manual. 

Customizing the DASYLab Screen 
Choose this menu function to view the information found in Chapter 3 of this 
manual. 

Worksheet Examples 
Choose this menu function to view instructions for using the sample worksheets 
that are installed with DASYLab. 

DASYLab by Keyboard 
Choose this menu function to view the instructions found in Chapter 6 of this 
manual. 

5.2. Hardware 

If you have installed a data acquisition board in your system, choose this menu 
function to obtain specific help about that board. 

ª Read the Hardware Installation Manual for additional information concerning 
installation and operation of your data acquisition device. 
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5.3. Glossary 

Choose this menu function to view the alphabetical list of terms with definitions 
that can be displayed as pop-ups on the screen. 

5.4. Using Help 

This option provides help for how to use the online help system. 

5.5. Getting Started Tutorial 

 
This symbol in the Online Help will mark all modules/items with an available 
Getting Started Tutorial. Click on the symbol to start Getting Started! 

Click the Getting Started Button in the Online Help or choose this command from 
the Help Menu. 

The Getting Started guide is a supplement to the Online Help and the manuals. 
The different parts of the program are shown in several worksheets that will 
show you the function and interaction of the different modules in the data flow. 
They include suggestions for creating your own worksheets and make it easier 
and more meaningful to use the functions of the software and to take full advan-
tage of the power of the software. The worksheets shown run without external 
DAQ hardware. Exceptional cases are indicated.  

The Getting Started Tutorial supports new DASYLab users with useful tips and 
examples for creating typical worksheets. You can open demonstration work-
sheets in a second DASYLab session and test them in parallel to the user’s own 
worksheet.  

The Getting Started Guide shows the function mode and cooperation of the dif-
ferent DASYLab modules. The tutorial contains different worksheets that de-
scribe the module functions in the data flow. They are intended to give you sug-
gestions using the actual structure of the worksheet and to make it easier to use 
the DASYLab functions meaningfully, taking full advantage of the potential of 
this powerful software. This tutorial is in addition to the on-line help and the 
manuals supplied with the program. The example diagrams are mostly usable 
without external hardware. Exceptions are marked.  

The Getting Started Tutorial covers the following topics: 

Data Acquisition 

Data Acquisition 

Signal Sources without Hardware 

Signal Sources in Dasylab 

Data Processing 

Time-Critical Data Processing 

Signal Data Transformation 

Signal Amplitudes Modification 
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Signal Flow Control 

Signal Output/Visualization 

Data output on Hardware, on Displays 

Data storage  

Special DASYLab Functions 

Additionally, some information and examples are included for the “special” fea-
tures that make DASYLab a flexible, powerful application development tool:  

The Black Box 

The Worksheet Sequencer 

Global Strings/Variables 

The Event-Driven Action 

Other Functions 

In the appendix of the Getting Started Tutorial includes references that are in-
teresting for the ongoing use of DASYLab: 

Dasylab In Context Of Other Software And Computers 

The Different Operating Systems And Dasylab 

The Data Backup Module 

The E-Mail Module 

5.6. Report… 

Choose this menu function to view information on your hardware, operating 
system, Windows version, system resources, etc. 

5.7. About DASYLab… 

Choose this menu function to view information on the current DASYLab ver-
sion. 

ª Your own company logo can be displayed in the INFORMATION box (see Chapter 
6 for details). 
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6. Customizing the Main Menu: External Programs 

You can easily insert menu items into DASYLab’s main menu to start external 
programs directly from within DASYLab.  

Use a text editor, such as Notepad, to make the following entries in the 
DASYLAB.INI file (located in the DASYLab directory): 
[External Tools] 
ToolNumber=number 
 
ToolMenuText1=&name1 
ToolMenuText2=&name2 
……Etc. 

 

ToolPathName1=path\programname1 
ToolInitialDir1=startingdirectory1 
ToolArguments1=startingparameters1 
ToolAskArguments1=0 

 

ToolPathName2=path\programname2 
ToolInitialDir2=startingdirectory2 
ToolArguments2=startingparameters2 
ToolAskArguments2=0 

……Etc. 

Each external program has a separate entry as described above. Items shown in 
italic text must be replaced with the actual name, path, and any parameters nec-
essary to start your program. Up to 16 external programs can be defined. 



 



 

 

 



 

 

 



DASYLab®  Files and File Formats 

 5-1 

Chapter 5: Files and File Formats / DDE / Network 

1. Files and File Formats 

1.1. Worksheet Files (.DSB) 

A worksheet file (standard extension .DSB) contains the complete worksheet 
with its most important settings. 

The following worksheet settings will be saved: 

� The type and screen position of all the modules, 

� The number of inputs and outputs of each module, 

� The settings specified in each module configuration dialog box, 

� All the data channels, branches and their exact positions, 

� Global settings including the acquisition rate and the block size (Ex-
periment menu), 

� All the entries in the File Info dialog box (File menu). 

The following environment settings will be saved with the worksheet: 

� The mode (normal, minimized…), position and size of the main win-
dow and the visualization window, 

� The Module Bar configuration, 

� All the entries in the Page Format dialog box (File menu). 

The following settings will not be saved with the worksheet: 

� The settings of the Start/Stop at Time functions (Experiment menu), 

� The settings of the Auto Start function (Experiment menu), 

� The View menu settings for the display of the Module Bar, the Func-
tion Bar, and the Animation function, 

� The Options menu settings (Window Setup, Colors, and the Auto-
router function). 

A worksheet file can be viewed in part by using the MS-DOS command TYPE. 
Some global information like the current time and date, comments, etc., is con-
tained in human readable format at the beginning of the file. 

1.1.1 Worksheet Exchange Files (*.DSA) 

The file with the extension *.DSA stores a worksheet with the same informa-
tion as the original DASYLab worksheet file (*.DSB), but formatted in ASCII. 
This format is uses to exchange worksheets between different program versions 
(16 bit and 32 bit). Saving ASCII format will take a longer time and needs more 
disk space than storing in DSB format 
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Ö In addition to the *.DSA file DASYLab creates a file with the extension DMX, 
which contains the graphical matrix of the worksheet, such as data channels posi-
tion of modules and so on. To load a worksheet as ASCII file both files *.DSA and 
*.DMX has to be available. 

1.1.2 Worksheet Text Files (*.TXT) 

This file format with the extension *.TXT contains simple text, which describes 
the modules and settings used in the worksheet. This file is only useful to rebuild 
worksheets manually. DASYLab is not able to reload these files, because all 
graphical information, such as position of modules or data channel links, is not 
stored  

1.1.3 HTML Text Files (*.HTM) 

This file format is used to save worksheets as HTML files, using HyperText 
Markup Language, as used in the Web. These files contain all elements and im-
portant settings of a worksheet. The files cannot be reloaded but are a powerful 
help for documentation and rebuilding your projects 

1.2. Control Sequencer Files (*.DSQ) 

To control large application controlled by more than one worksheet calling each 
other use the Control Sequencer Window. The contents of this window is stored 
in a binary file, the Control Sequencer file with the suffix *.DSQ. 

You can add any number of worksheets into the Control Sequencer File and also 
you can define several actions for each inserted worksheet to rule the course of 
the worksheets. 
The contents of the Control Sequencer File is shown and edited as new display 
window (in analogy to the worksheet, display and VITool windows). 

Ö The file format type is binary, so you cannot edit it in a standard ASCII 
Editor. 

1.3. Module Bar Files (.DML) 

These files contain configurations of the Module Bar and are used to define DA-
SYLab environments for different application areas. They can be created by 
choosing the Save As… command from the Module Bar submenu of the Edit 
menu. 

The current configuration of the Module Bar will be saved by DASYLab in the 
file DASYLAB.DML. This file will by default be used for the next start of DA-
SYLab. 

1.4. Layout File (.LAY) 

These files contain configurations of the Layouts and are used to save user de-
fined Layout settings to import into different worksheets. They can be created by 
choosing the Save As… command from the Edit submenu: Layout… 
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1.5. Serial Port Settings (.SIN/.SOU) 

The settings of the serial interface are stored in these files. They can be created by 
choosing the Save Button in the module dialog box of the serial modules. Load 
these files to quickly configure the ports with previously defined settings. 

1.6. ICOM Port Settings (.IIN/.IOU) 

The settings of the ICOM interface are stored in these files. They can be created 
by choosing the Save Button in the module dialog box of the serial modules. 
Load these files to quickly configure the ports with previously defined settings. 

1.7. Initialization File (DASYLAB.INI) 

DASYLab automatically creates this file in the Windows directory. It contains 
the current global settings concerning the main windows and parts of the file 
info. Also in these files defined Global Strings or variables are saved. If necessary 
DASYLab can read them while measurement is running. 

1.8. Files with Reference Points (.DPF) 

These ASCII files contain lists of reference points that are required for Interpola-
tion in the Scaling module. Use an ASCII editor such as Windows Notepad or 
any other non-formatting text editor to create such a file. 

The file can be created as one channel file or multi channel file and must be 
structured as follows: 

Line 1: INTERPOLATION 
Line 2: identifier (maximum 40 characters) 
Line 3: number of columns (minimum 2) 
Line 4: number of pairs of data 

The lines containing the data pairs follow. 
Their total number must correspond exactly 
to the value specified in line 4. 

Last line: EOF 

The reference pairs are arranged in one line with the independent value first and 
the dependent value second. Blanks or Tabs must separate the two columns. The 
lines must be sorted in increasing order. 
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Example of an Interpolation file: 
INTERPOLATION 
This is an example file. 
2 
5 
-2000 0 
-1500 1.5151 
-100 3.7456 
10 7.78569 
400 0.12 
EOF 

Example of a Multi Channel Interpolation file with 3 channels separated by 
blanks: 

INTERPOLATION  
This is a 3-channel example file.  
3  
5  
-2000 0.00 1.00  
-1500 1.5151 2.50  
-100 3.7456 3.5678 
10 7.87569 2.222 
400  12.587 3.334 
EOF  
 

1.9. Data Files 

DASYLab can store data in different formats so that data can be used by other 
applications. It can read data stored as IEEE-32 or ASCII formats, in addition to 
its own format. Use the Read File and Write File modules from the Files module 
to read and write files. 

ASCII Format (.ASC) 
Data is stored as ASCII strings, so that it can be read without an additional con-
verting program. 

Ö Only continuous time-dependent data can be stored in the ASCII format. 

IEEE Format (.I32) 
Data is stored as IEEE 32 bit floating point values in the Intel format. 

Ö Only continuous time-dependent data can be stored in this format. 

External Formats 
DASYLab supports saving data in any of the following formats: 

Format Extension Format Extension 

ASCII *.ASC IEEE-32 *.I32 
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DADiSP *.DSP Remus *.DAT 

DIA/DAGO *.DAT Signalys *.VH, *.K??, *.D?? 

Famos *.DAT   

Ö FFT, Histogram, or Relay data cannot be stored in the DIA/DAGO 
format. The same block size and sampling rate must be specified for all 
the channels if data is to be stored in this format. 

There are no restrictions for the Famos or the Signalys formats. 

DASYLab Data Format (.DDF/.DDB) 
This format is the DASYLab format that exactly fits the requirements of DASY-
Lab. 

Data can be stored and read in this format. All types of data can be saved and the 
full information is stored together with the raw data. 

Please refer to the section 1.10 for further details. 

1.10. DASYLab Data Format (.DDF/.DDB) 

(Extended Version 1.01 / Oct. 1994) 

1.10.1 Basics 

The header can either be stored in the same file as the data or in another file with 
a different extension. 

The extension for the main file is .DDF (“DASYLab® Data Format”). If a sepa-

rate data file is created, its extension will be .DDB (“DASYLab® Data Block”). 

The format itself is not fixed completely, but contains options for future devel-
opment. Any variants of the format that are not described explicitly here are not 
fully developed and should not be used. 

1.10.2 Basic File Structure 

Each file consists of four sections, of which the one containing the data may be 
stored in a separate file: 

1. Two global headers, 

2. A number of channel headers (one for each channel), 

3. One or several series of data blocks, 

4. The End of File mark; 

Or 

1. Two global headers, 

2. A number of channel headers (one for each channel), 

3. The End of File mark, 

Plus an additional file containing only the series of blocks of data. 

The current version allows only one series of blocks of data.  
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1.10.3 Storing Different Types of Data 

Binary data are stored following the conventions of the Intel Format. This 
documentation uses the following identifiers for data types: 

o CHAR single character 
o CHAR[n] an array of exactly n characters 
o INT 2 Byte signed 
o LONG 4 Byte signed 
o WORD 2 Byte unsigned 
o DWORD 4 Byte unsigned 
o DATUM date and time in the current MS-DOS format 
o FLOAT 4 Byte real 
o DOUBLE 8 Byte real 
o STRING a series of characters with NULL Byte termi-

nator  (variable size) 
Strings will be encoded according to Windows 3.1 conventions. 

1.10.4 The First Global Header 

The first global header has the following structure: 

CHAR[4] fixed file identifier: 'D', 'T', 'D', 'F' 
CHAR fixed file identifier: CTRL-M ($0D) 
STRING data source, comments, etc. (see below) 
CHAR fixed terminator: CTRL-Z ($1A) 
CHAR[2] fixed CPU identifier: 'I', 'N' 
WORD size of this header in Bytes 
WORD file type (see explanation below) 
WORD version number (currently: 1) 
WORD size of the second global header in Bytes [*]  
 (see explanation below) 
WORD size of a channel header in Bytes [*] 
WORD size of a block header in Bytes 
WORD flag for a separate data file 
WORD number of channels 
DOUBLE time delay between two samples 
DATUM start time 

The “Data Source” string is structured by DASYLab as follows: 
DASYLab V 3.00 [APRIL 15, 1993] -- Copyright 
(c) 1992,93,94,95 by NATIONAL INSTRUMENTS 
WORKSHEET = WIND.DSB 
AUTHOR = W. Inner 
COMPANY = Faster Than Light Inc. 
DIVISION = Development 
TITLE = Wind channel experiment 4711 
SAMPLE RATE = 1000.0 Hz 
DATA FORMAT = 1 
DATA CHANNELS = 5 
START TIME = MAY 25, 1995 11:55 
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If data blocks are stored in a separate file, the following line is added: 

DATA FILE = NAME.DDB 

You can view this information using the MS-DOS command TYPE. 

 “File Type” may be one of the following values: 

0 streamer format (data are raw data in WORD 
format, coming directly from the DAQ) 

1 Universal Format 1 (FLOAT) 
2 Universal Format 2 (DOUBLE) 
3 – 1000 reserved  
1001 – 65535 unused 

Currently only File Type 1 is supported. 

The second global header is dependent on the file type. 

For the above sizes marked with an asterisk [*] (and only those), strings are 
counted as 1 Byte each. Otherwise the real size will be entered. The data block 
headers cannot contain any strings. 

The flag for separate data files may have either of these values: 

0 (FALSE) one file only / header and data are in the same file. 

1 (TRUE) separate file for data blocks. Both files must have the 
same file names, but the extension of the main file is 

.DDF (“DASYLab® Data Format”), and the exten-

sion of the separate data file is .DDB (“DASYLab® 
Data Block”). 

1.10.5 End of File Mark 

The end of file is marked by: 

CHAR[4] fixed label: 'D', 'T', 'D', 'F' 

1.10.6 The Universal Format 1 

This is the standard format of DASYLab. All the different types of signals can be 
stored in this format. 

Global Header for Universal Format 1 
This header has the following structure: 

WORD size of this header 
WORD number of channels 
(with multiplexed data total amount of channels) 

WORD Flag, whether the data are multiplexed 
(0=no; 1 = yes)  

WORD[16} Array of the channels collected on each input channel 
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Channel Header for Universal Format 1 
Each channel has its own header: 

WORD size of this header 
WORD channel number 
WORD maximum size of a block in samples. The maximum 

value is 8192. The actual sizes of the blocks may be 
smaller. 

DOUBLE time delay between two samples in this channel 
WORD channel type (see explanation below) 
WORD channel flags (see explanation below) 
DOUBLE unused, must be 0.0 for future extensions 
DOUBLE unused, must be 0.0 for future extensions 
STRING channel unit 
STRING channel name 

 The following channel types may be used: 

  Value for a channel containing data of the following 
type: 

Channel Type = 0 continuous time dependent signals 
Channel Type = 10 frequency dependent data (full block size) 
Channel Type = 11 frequency dependent data (half block size) 
Channel Type = 20 Histogram values  
Channel Type = 21 Histogram values with time information 

The channel flags may be used for special properties of a signal or block; cur-
rently only one flag is defined: 

Channel Flag $0001 data in this channel may have gaps 
Channel Flag $0002  this channel may contain shorter blocks 

The different channel headers follow one by one without gaps. The first header 
corresponds to channel 0, the second to channel 1 and so on. 

1.10.7 Data Block Header for Universal Format 1 

Each series of data blocks is preceded by a small header structured as follows: 

CHAR[4] fixed label: 'D', 'A', 'T', 'A' 
WORD overall number of bytes in this channel 
DATUM start time for the following blocks 
DWORD unused, must be 0.0 for future extensions 
DWORD unused, must be 0.0 for future extensions 

This header is followed by the corresponding series of data blocks, each of which 
is again introduced by its own separate header. 

The individual pairs of headers and blocks directly follow each other. The blocks 
are not sorted according to channels but according to their start time. 

Channels of types 0, 1, 10, 11 or 12 have headers as follows: 

WORD channel number 
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DOUBLE start time 
DOUBLE time delay between samples 
WORD block size 

This header is immediately followed by the data in 4-byte float format. 

Channels of type 20 (Histogram data) have the following header: 

WORD channel number 
DOUBLE position of the first histogram value 
DOUBLE width of the classes 
WORD number of samples 

This header is immediately followed by the data in 4-byte float format. 

These data are not provided with time information. 

1.10.8 The Universal Format 0 

Universal Format 0 is used for streaming data. It may contain more than 16 
channels and it may contain data in raw integer format. 

Global Header for Universal Format 0  
This header has the following structure: 
WORD overall number of bytes in this header 
WORD  number of analog channels 
WORD number of counter channels 
WORD number of digital ports 
WORD number of bits in each digital port 
WORD original block size when data was stored 
DWORD sample number of the first sample (when cyclic 

buffer is not activated, always zero) 
DWORD number of samples per channel 

Channel Header for Universal Format 0 

WORD number of bytes in this header 
WORD channel type 0: analog, 1: digital, 2: counter 
CHAR array 16 by 24 with channel names (channel names 

with 24 chars for digital ports) 
WORD data format 0 unsigned integer, 1: signed integer 
DOUBLE factor for calculation of Volts 
DOUBLE offset for calculation of Volts 

1.11. Vector File (*.VEC) 

The vector file (Extension *.VEC) stores information used in the module Con-
volution. 

You can create this file with an ASCII editor such as Windows Notepad or any 
other non-formatting text editor. The file must be structured as follows: 

 (Quotation marks are inserted for better view. They are not allowed to be used 
in original vector file!) 
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1st line: “VECTOR“ 

2nd line: Name (free text, max 40 characters) 

3rd line: Number of columns; only „1“ is allowed 

4th line: Number of data lines 

Next lines: Data (number of lines exactly as defined in previous line) 

Last line: „EOF“ 

Example of Vector file 

VECTOR 

Example of vector file name 

1 number of columns „1“  

5 number of data lines „5“ 

121 Data line 1 

244 Data line 2 

305 Data line 3 

476 Data line 4 

599 Data line 5 

EOF 

1.12. FGEN File (*.TXT) 

The FGEN file (Extension *.TXT) stores Coefficients of Filter, which are used 
in the Convolution module. 

It is possible to use the program FGEN for Windows (Version 1.00, 20 October 
1995, Microstar Laboratories) to import immediately coefficients of digital filters 
into the convolution module. Because the FGEN program isn’t able to store the 
coefficient matrix you must use the menu item „View...“ to show the coefficient 
values and copy them into the clipboard.  

You can import this data into an ASCII editor such as Windows Notepad or any 
other non-formatting text editor and store it as a TXT file. 

Example FGEN FILE 
; vector v: Taps = 95, Type = Lowpass, Window = Blackman 

; vector v: Actual Taps = 101 (before zero stripping) 

; vector v: Edges = 0,09, 0,14 

; vector v: Scale = 8 

vector v = (-1, -1, -2, -1, 1, 6, 14, 24,  

    35, 43, 44, 34, 8, -36, -97, -170,  

    -243, -300, -321, -284, -173, 20, 288, 608,  

    937, 1214, 1369, 1332, 1045, 479, -356, -1398,  

    -2530, -3589, -4372, -4665, -4268, -3023, -848, 2246,  

    6140, 10610, 15343, 19968, 24091, 27345, 29429, 30147,  
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    29429, 27345, 24091, 19968, 15343, 10610, 6140, 2246,  

    -848, -3023, -4268, -4665, -4372, -3589, -2530, -1398,  

    -356, 479, 1045, 1332, 1369, 1214, 937, 608,  

    288, 20, -173, -284, -321, -300, -243, -170,  

    -97, -36, 8, 34, 44, 43, 35, 24,  

    14, 6, 1, -1, -2, -1, -1) 

 

2. DASYLab-Net: Communication with Other DASYLab 
Programs 

DASYLab-Net  is able to control other DASYLab-Net programs running on 
connected machines. A typical configuration is a central computer that controls 
all functions (a master) and many measuring points that are controlled (slaves). 

There are always two machines involved in any communications connection. 
Usually they are called Client/Server. Also we will use the terms Master/Slave or 
Active/Passive Partner. 

The computer that actively builds and controls the connection is the Client, 
Master or Active Partner. It sends commands and performs supervising func-
tions. It also sends or receives data initiated by itself. The Client or Master com-
puter always has the main control. 

The Server, Slave or Passive Partner is the computer that waits for another com-
puter to contact it. It accepts commands, receives data and sends data controlled 
by the far side. Server or Slave computers are not able to operate without the 
control inputs of the Server. It only executes commands of the Master unit. 

Each DASYLab-Net can be defined as Client (= Master) or Server (= Slave). The 
DASYLab Server is able to send data to several Clients; the DASYLab Client is 
able to control several Servers. 

The Remote Control Dialog Box allows you to define DASYLab-Net as Client 
or Server. With Server mode there are no further settings. With Client mode you 
can define a list of Servers that should be controlled. The settings of each of these 
Servers can be defined using the Option button or the servers can be ordered to 
execute immediate instructions. 

The Options Dialog Box defines the settings of the remote control operations. 

� Start/Stop simultaneously  

When this option is active, the Server starts and stops each time the 
measurement starts and stops. Please note that Clients and Servers 
never start at exactly the same time because the transmission of the 
start command is dependent on the utilization and capacity of the 
network. Also network configuration, speed of network boards, etc., 
will affect the speed of the transfer. 
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� The Start, Stop and Load Options are executed immediately. Start 
measurement, stop measurement or loading a worksheet will be per-
formed on the remote side “instantly.” 

2.1. TCP/IP Network Protocol 

The TCP/IP Protocol is the basis of DASYLab-Net’s functions. It is not in-
cluded in the standard Windows or Windows for Workgroups installations. You 
will need to install the TCP/IP Stack to use the DASYLab-Net functions. 

Availability 
Several manufacturers provide TCP/IP Protocol Stacks as a supplement to Win-
dows 3.1 and/or Windows for Workgroups 3.11. DASYLab-Net only works cor-
rectly with TCP/IP Stacks that include a WINSOCK DLL file. This file should 
meet the Windows Sockets Specification Version 1.1, Jan 20, 1993. 

MS TCP/IP-32 
The TCP/IP-32 Protocol Stack is provided free of charge by Microsoft. This 
stack (in contrast with others) cannot only be used with Windows 3.1 but also 
with Windows for Workgroups 3.11. It is very easy to install. New operating sys-
tems such as Windows 95 will contain the TCP/IP Protocol in the standard dis-
tribution. 

The following section refers to the MS TCP/IP-32 Protocol stack. 

Installation 
MS TCP/IP-32 installation is started using the network setup from the Network 
Group. You can install it as an additional protocol using the driver options. 

Typically you would first install the Microsoft Windows Network with an in-
stalled Ethernet board. Then install the TCP/IP-32 as an additional protocol. 

Installation of additional Network protocols (such as Novell Net or others) is 
not required because each additional protocol running on the network dimin-
ishes the overall performance. 

IP-Address 
During the installation of TCP/IP, all mounted computers must have an IP Ad-
dress (= Internet Address). The string is constructed of 4 numbers divided by 
decimal points (for example: 192.153.120.3) and has to agree with established 
declarations (for example, the first number defines the Address Type.) 

If you want to connect your local network with the worldwide Internet, you 
must request the first three numbers from the network provider. The last num-
ber will define the local computer. 

Also, while the network will work, local Internet conventions must be obeyed. 
For example, usable addresses are 192.153.120.x in which each local computer 
gets its station identification defined in the x component (range: 1 up to 255). 
The first three numbers of all local computers must be identical. Each local ma-
chine must be named unambiguously. This name is also used by DASYLab-Net. 
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2.2. Bibliography 

Reviewing the literature, there are many books, articles, etc., which discuss 
TCP/IP, Internet and Windows Sockets. 

References with subjects of Ethernet, FDDI, Using IP-Addresses, etc., are inter-
esting if you want to install a TCP/IP Network. 

Subjects of FTP, TELNET, NFS, EMAIL, WWW (Worldwide Web), 
GOPHER, and so on are descriptions of public domain services that are not 
necessary to run DASYLab-Net. 

You won’t need descriptions of Windows Sockets. You only need to know that 
DASYLab-Net needs Windows Sockets. The software manufacturer has to de-
liver them with the TCP/IP Stacks. 

3. DDE: Communication with Other Applications 

DDE (Dynamic Data Exchange) is defined as a dynamic data exchange between 
Windows applications using a defined protocol. Although this conversation is 
two-way, the role of each program is determined by the protocol. The program 
asking for data is called the Client. The called program is defined as the Server. 

The Client always initiates a DDE conversation. It sends an initialization mes-
sage (WM_DDE_INITIATE) to all running tasks. The parameters describe the 
general type of the required data. A program with that data type responds with 
an acknowledgment and declares itself to be the Server. A DDE conversation is 
restricted to two partners. 

3.1. DASYLab as DDE Input 

Using the Windows DDE Interface, external programs are able to initiate DA-
SYLab functions (load file, start measurement…) in a running DASYLab pro-
gram. Other Windows applications can control DASYLab. In this case DASY-
Lab is the Server, a Visual Basic application, for example, is the Client. 

The format of the DDE instructions has to conform to the following rules: 

Service: DASYLab 
Topic: Menu 
Item: Command e.g. Load 

The name of the application (service) DASYLAB and the topic Menu starts the 
DDE conversation. Available items are Command (standard menu command) 
with start measurement, stop measurement, pause measurement and continue 
measurement functions and the item Load to load file.  

There are 6 additional DDE items to manipulate Global Strings or Variables us-
ing DDE:  

� SetString 

� GetString 
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� SetVar 

� GetVar 

� GetData  

� SetData 

In both GET functions the number is chosen as item and the function as topic 
(DASYLab is the DDE server. Connection is a Cold Link). DASYLab will send 
back the result as an ASCII value. If there is no result (wrong number, etc.), 
DASYLab will send back the string ‘Parameter Error’. To set strings or variables 
(DASYLab is DDE server, connection is defined as DDE Poke) the number and 
the defined alphanumeric string or numerical value separated by a semicolon will 
be sent. DASYLab gives no feedback. 

Protocol 
Application: DASYLab 

� Start measurement, stop measurement, pause measurement, con-
tinue measurement: 

Topic: Menu 
Item: Command 
String: START, PAUSE, CONT, STOP 
Communication: Poke  

� Load file: 

Topic: Menu 
Item: Load 
String: FILEname 
Communication: Poke  

� Set Global String: 

Topic: Menu 
Item: SetString 
String: Number;String 
Example: 3;test.ddf 

Communication: Poke  

� Get Global String: 

Topic: Menu 
Item: GetString 
String: Number 
Communication: Cold link 

� Set Global Variable: 

Topic: Menu 
Item: SetVar 
String: Number;(ASCII)Value 
Example: 2;5.923 
Communication: Poke  
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� Get Global Variable: 

Topic: Menu 
Item: getVAR 
String: Number 
Communication: Cold link 

� Get DDE data 

Topic: GetData 
Item: MODULEname 
String: Line with x channels, 

(ASCII) 
Communication: ColdLink or HotLink 

� Set DDE data 

Topic: SetData 
Item: MODULEname 
Communication: Poke 

Visual Basic - example 
Private Sub cmdPoke_Click() 
    txtData.LinkMode = vbLinkNone 
    txtData.LinkTopic = "DASYLab" & "|" & "Menu" 
    txtData.LinkItem = "Load" 
    txtData.LinkMode = vbLinkManual 
    txtData.Text = "c:\DASYLab\last.dsb" 
    txtData.LinkPoke 
End Sub 
Private Sub cmdRequest_Click() 
    txtData.LinkMode = vbLinkNone 
    txtData.LinkTopic = "DASYLab" & "|" & "GetVariable" 
    txtData.LinkItem = "1" 
    txtData.LinkMode = vbLinkManual 
    txtData.Text = "" 
    txtData.LinkRequest 
End Sub 

In VisualBasic 5.0 the type of communication is declared as follows: 

Poke: Linkmode:txtdata.LinkMode = vbLinkManual 
 Initialization: txtdata.Poke 

ColdLink: LinkMode: txtdata.Linkmode = vbLinkManual 

 Initialization: txtdata.Request 

HotLink:  LinkMode: txtdata.LinkMode = vbAutomatic 

 



Tips & Tricks  

5-16 

When the connection is successful, an acknowledgment signal (“CONNECT”) 
will be sent. 

Net DDE 
It is also possible to exchange data between programs running on different ma-
chines using an available network. 

You need to ensure the following: 

� On the server side there must be one or more DDE shares entries. 
This authorizes other applications (in the following example Excel) 
to connect via Net DDE. Shares are inserted in the SYSTEM.INI file 
section [DDEShares]. 

Example: 
[DDEShares] 
CHAT$=winchat,chat,,31,,0,,0,0,0 
SCHAT$=winchat,chat,,31,,0,,0,0,0 
CLPBK$=clipsrv,system,,31,,0,,0,0,0 
DL_MENU$=DASYLab,Menu,,15,,0,,0,0,0 
DL_DATA$=DASYLab,DdeData,,15,,0,0,0 
XL_TAB1$=Excel,Tab1,,15,,0,0,0 

 

DASYLab requires the last three lines. 

You need to restart Windows to initiate the connection. 

� On the client side the following entries are necessary: 

When DASYLab and the other application are installed on the same 
machine: 

Application: Excel 
Topic: Tab1 
Item: R1C2 

When DASYLab and the other application are connected via 
Net DDE: 

Application: \\ComputerName\NDDE$ 
Topic: XL_1TAB1 
Item: R1C2 

Adjustments of the client must match the enabled DDE shares set-
tings.  
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Chapter 6: Tips & Tricks 

1. Demo Worksheets 

When you set up DASYLab on your hard disk, several Sample Worksheets are 
copied to the DASYLab directory. 

You can open these files onto the working area by choosing Open from the File 
menu or by clicking this Function Bar icon. 

These worksheet examples can give you some idea of the wide range of measur-
ing tasks that can be solved by DASYLab. 

If you choose the File Info command from the File menu, or click the correspond-
ing icon on the Function Bar, you will find information on that worksheet in the 
Worksheet Information box. 

2. DASYLab by Keyboard 

Most Windows applications are designed with mouse operation in mind, but the 
keyboard may also be used. The following keyboard operations can be used in 
DASYLab: 

Menu Commands 
Menu commands can be chosen by pressing ALT to move to the Menu Bar, 
then typing the underlined letter in the menu name to open the menu, and then 
typing the underlined letter in the menu command. 

Experiment Control 
Keyboard shortcuts are provided for commonly used Experiment menu com-
mands. Instead of opening the menu and choosing the command, press the key 
combination. 

These keys are listed to the right of the menu entry. The online help pages also 
list them. 

A list of the commands and their shortcut-key combinations is provided on page 
6-2. 

User Defined Hot Keys 
The Hot Keys command in the Option menus allows the user to define and as-
sign key combination to any available DASYLab function. See page 6-2. 

Module Manipulation and Configuration 
The module symbols in the worksheet can be dragged, connected by data chan-
nels, configured, or deleted. The latter two manipulations can also be done with 
the keyboard. 

Only one module in the worksheet can be selected and manipulated. It is identi-
fied among the module symbols in the work area by the inverse coloring of its 
Title Bar, where the module name is displayed. 
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� To select a module, click it once with the left mouse button or press 
the TAB key on your keyboard until that module is selected. 

� When you press the ALT+ENTER keys, the module configuration 
dialog box appears. Press the TAB or the SHIFT+TAB keys to move 
from one field or button to another; select items by pressing the arrow 
keys, the SPACE and the ENTER key. 

Ö Channel Selection can only be done using the mouse. 

� To copy settings entered for the selected channel to the other activated 
channels, use the F7/F8 Function Keys. This procedure can only be 
performed using keyboard operation. 

� To delete the selected module from the worksheet, or to delete all the 
input and/or output channels of that module, press the DEL key. In 
the dialog box, select the desired option, or choose Cancel, and press 
ENTER. 

3. DASYLab Hotkeys 

In addition to the built-in Hotkeys, you can define your own. See Chapter 4: 
1.6.4 on page 4-46 for details.  
F1 Online Help 
F2 Show Display Window 
F3 Show Display Window 
SHIFT-F3 Show Sequence Window 
F4 Show Layout Window 
F5 Start Measurement 
CTRL+F5 Stop Measurement 
CTRL+F6 Pause Measurement 
CTRL+F6 Resume Measurement 
F7 Copy selected channel properties 
F8 Copy all channel properties 
ESC or CTRL+F Switch Layout from full screen to window mode 
CTRL+F Switch Layout into full screen mode 
ALT+SHIFT+Number Save window arrangement 
Alt+Number Choose window arrangement 
ALT+CTRL+Number Delete window arrangement 

Hotkeys in junction with mouse button (Debug Window, only if measurement 
is running): 
Left mouse click on data channel Reduced Debug Window 
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CTRL-Left mouse click on the data 
channel 

Full Debug Window 

SHIFT-Left mouse click on the data 
channel 

Graphical Debug Window 

4. How to Start and Stop an Experiment 

This section contains 

� Some basic information on the options provided by DASYLab to con-
trol an experiment or data acquisition process; 

� An overview of the manual control options; 

� And a review of the methods for automatically controlling an experi-
ment. 

4.1. Start/Stop/Pause/Resume an Experiment 

DASYLab allows you to control your data acquisition procedures in various 
ways. Besides starting and completely stopping an experiment you can also inter-
rupt it and later resume it at that point. 

� When you pause an experiment, the acquisition of new data is stopped 
(for example, Generator, A/D or Digital Input, PID or Manual Control 
modules) but data already acquired will be processed completely. 

� The acquisition of new data is resumed when the experiment is con-
tinued. 

4.2. Controlling an Experiment Manually 

There are three methods for controlling an experiment manually. 

c Choose the commands from the Experiment menu: click the menu 
item, or press the ALT, X keys, then type the letter that is underlined 
in the item name. 

d Click the icons on the Function Bar. Each icon symbolizes a menu 
commands. 

e Use keyboard shortcuts. When available, shortcut-key combinations 
are listed to the right of the menu item; to use, press the key combina-
tion. 
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Icon 
Experiment 
Menu Command Hotkey Function 

 Start 
F5 Start experiment 

 Stop 
CTRL+F5 Stop experiment 

 √ Pause 
CTRL+F6 Pause experiment / 

resume experiment 

4.3. Automatic Program/Experiment Start 

The experiment setup (the worksheet) and/or the computer can be configured so 
that the experiment will start and stop automatically.  

The following describes the menu commands needed and the details on how to 
automatically set up experiments using batch files and Windows resources. 

Ö The concept of Event Driven Actions enlarges the capabilities of DASYLab in 
the field of automatic measurement control. An Action module can react to de-
tected events with certain activities, such as opening and starting a new work-
sheet, printing displays, resetting values, etc. See the Module Reference Guide for 
more information. 

4.3.1 Start/Stop via DDE 

Other Windows applications with DDE capabilities can be used to start and 
stop the DASYLab experiment. Refer to the DDE section in Chapter 6 for de-
tails on the DDE protocol. 

4.3.2 Start/Stop at Time 

Choose the Start/Stop at Time option from the Experiment menu to start, stop, 
and repeat an experiment at specified times. You can specify the time at which 
an experiment is to start, the duration of that experiment, and the interval after 
which the experiment is to be repeated. Refer to Chapter 6 for details. 

4.3.3 Using the Auto Start Function 

Use the Auto Start option from the Experiment menu to set an experiment to 
start automatically. 

� Activate the Auto Start option from the Experiment menu (indicated 
by a check mark √). 

� Choose Save or Save as… from the File menu, or click the Function 
Bar icon, to save your worksheet. When you exit DASYLab, the set-
ting of the Auto Start option is saved with other window settings. 
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� To use Auto Start, append the file name of the worksheet to the pro-
gram file name at the command line. DASYLab opens the worksheet 
and starts the experiment immediately. 

4.3.4 Starting a Worksheet from the Windows Desktop 

Drag and drop your worksheet files onto the Windows desktop. To automati-
cally start DASYLab by double clicking on the worksheet, you first have to 
manually create a link from DASYLab to the file type. First, use the Drag & 
Drop method to place a worksheet file icon on the desktop. Because there is no 
defined link to any program, double clicking on this icon will open a dialog box. 
Windows will ask you what program should be used to open that file. Select the: 
File always open with ... radio button and select the Others... button. 
Windows will open an Explorer Window that allows you to select a program. 
Choose the DASYLab installation path and select the DASYLAB.EXE program. 
Use the Open button to confirm. Leave the dialog box using the OK button. In 
the future, DASYLab will automatically start when a worksheet icon is double 
clicked. 

If you have installed several copies of DASYLab on your system, the created link 
connects only to one version of DASYLab from the Windows Program Manager 
or File Manager. 

4.3.5 Starting Control Sequence Files from the Windows desk-
top 

Using Windows 95/98 or 2000/NT you can place your Control Sequence files 
with Drag&Drop onto the Windows desktop. To automatically start DASYLab 
by double clicking on the Control Sequence file, you first have to manually cre-
ate a link from DASYLab to the file type. First, use the Drag & Drop method to 
place a Control Sequence file icon on the desktop. Because there is no defined 
link to any program, double clicking on this icon will open a dialog box. Win-
dows will ask you what program should be used to open that file. Select the: File 
always open with... radio button and select the Others... button. 
Windows will open an Explorer Window, which allows you to select a program. 
Choose the DASYLab installation path and select the DASYLab.EXE program. 
Use the Open button to confirm. Leave the dialog box using the OK button. In 
the future, DASYLab will automatically start when a worksheet icon is double 
clicked. 

If you have installed several copies of DASYLab on your system, the created link 
connects only to one version of DASYLab.  

4.3.6 Tips for starting worksheets/control sequences if you 
have more than one DASYLab version on the same computer 

If there are several versions (e.g. German and English versions) installed on your 
system, you can create links to worksheets for each version. Because DASYLab 
doesn’t use the extension to identify the worksheet file you can rename the work-
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sheets of each version to a special extension (e.g. English worksheets with *.ews). 
Now you can create a new link in Windows as previously described, and each 
worksheet will start with the corresponding DASYLab version when you double 
click on the file. You have to pay attention to previously used extensions, so that 
you don‘t affect other installed software. 

4.3.7 Various Application Icons or Batch Files 

You can customize the start-up modes described above. 

Batch Files 
Create a batch file containing the command line described above, including the 
worksheet file name and save it with a descriptive file name. Set up several batch 
files, each with an experiment setup. 

Any experiment can be then started by typing the corresponding batch file name. 

Application Icons in Windows Program Manager 
Add a new option to the DASYLab application icon displayed in the Windows 
Program Manager, or create a special icon for an experiment in your DASYLab 
program group in the Windows Program Manager. 

� To keep the current program startup option without a worksheet, 
copy the DASYLab icon first. Select it, press the F8 function key, or 
choose Copy from the Program Manager File menu. 

� Select the copied DASYLab icon with one mouse click, and press the 
ALT+ENTER keys, or, choose Properties from the File menu. 

� Type the complete worksheet file name including its drive, directory, 
and extension after the DASYLab command in the Command Line 
box. 

For example: C:\DLAB\DASYLAB.EXE D:\FLCS\FLC1.DSB 
where FLCS is the directory on drive D: where your worksheet files are 
saved, and FLC1.DSB is the experiment setup file which is to be auto-
matically started. 

� In the Description box, type a description that identifies the work-
sheet. 

� Press ENTER. 

Any experiment can be started directly by clicking on the corresponding Pro-
gram Manager icon. 
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4.3.8 Starting an Experiment at the same time as Windows 

Copy one of the experiment icons to the Windows Program Manager 
AUTOSTART group to start the experiment when Windows is started. 

4.3.9 Starting an Experiment when your Computer System Re-
starts  

Add the Windows command to the AUTOEXEC.BAT file and the experiment 
will start when you start your computer system. 

5. Exchanging Worksheets 

Between Computers 
If you have to exchange worksheets between several PCs (for example, when set-
ting up runtime applications), you must guarantee that the selection and se-
quence of measurement hardware (Experiment: Hardware Setup) in the source 
DASYLab are exactly the same as in your target PC. If not, there may be prob-
lems with hardware specific modules. This is usually only a problem when using 
more than one DAQ board (multifunctional drivers) or boards with extension 
boards. The hardware configuration specified in the hardware setup is stored as a 
list of indices in the worksheet without a board-specific indication. The result of 
a different sequence is an incorrect setup of hardware modules. 

Similarly, the hardware settings, including the base address and/or channel of the 
single components have to be identical. 

The following picture shows parts of the hardware setup of different PCs with 
the same set of measurement hardware but with a different setup sequence, 
which causes incorrect hardware assignment. 

 

Between Versions Of The Software 
DASYLab worksheet files, *.DSB, are forward compatible with newer versions of 
the software. Generally, however, a worksheet created with a newer version, such 
as V8.0, cannot be read by an earlier version, V5.0. This may also be the case be-
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tween minor revisions, such as V5.00 and V5.02, where the former, due to in-
compatible changes in the worksheet binary format, cannot read a worksheet 
created by the latter. 

To read a worksheet file with an earlier version, save the file as the worksheet 
ASCII format (.DSA). You may have to reconfigure some modules, but the older 
DASYLab is more likely to be able to read the ASCII format worksheet.  

From 16-bit version to 32-bit Version 
Use the ASCII worksheet format (.DSA) to exchange files between the 16-bit 
V5.0 and 32-bit Version 5.0 and later. 

6. Display Company Logo 

The DASYLab logo appears in the Copyright Information dialog box (About DA-
SYLab from the Help menu). You can display your company logo by creating 
the logo as a Windows Metafile (∗.WMF). Copy that file to the DASYLab direc-
tory as LOGO.WMF. The next time you start DASYLab, your logo will be dis-
played in the Copyright Information window. It may be necessary to fine-tune the 
size and proportions of the picture. 
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Appendices 
 

A: What’s included in Your DASYLab Package 
The DASYLab package consists of the following parts: 

� CD-ROM with the installation files for the DASYLab program files, 
the setup program files, and the driver files for data acquisition devices 

� Optionally, a printed User Guide, the Module Reference Guide and the 
Hands-On Guide. If these books are not included, they can be printed 
from the CD-ROM (PDF format) or downloaded from 
www.dasylab.net 

� Optionally, the Hardware Installation Manual that provides informa-
tion about the drivers for the data acquisition devices. If you did not 
receive a Hardware Installation Manual, refer to the Online Help for 
your driver that was installed in the program group during installa-
tion. 

� Optionally, the DAP Power DLL Manual, which describes features 
specific to the optional DAP Power DLL. 

� Registration card, license, and miscellaneous enclosures 
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B: Internal Data Flow and Precision Information 
Data values are represented in DASYLab as single precision floating point values. 
All calculations except the FFT are carried out in double precision (8 Byte float-
ing point).  

Single Precision Format 
Data Format: 32 Bit 

1 Bit sign 
8 Bit exponent 
23 Bit mantissa 

Range: 3.4E-38 to 3.4E+38 
Accuracy:  at least 7 decimals 

Double Precision Format 
Data Format: 64 Bit 

1 Bit sign 
11 Bit exponent 
52 Bit mantissa 

Range: 1.7E-308 to 1.7E+308 
Accuracy:  at least 15 decimals 
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C: ASCII Table 

Control Characters (not printable) 
Decimal  Octal  Hex  Characters Code  Notes 

0  000  0x00 Ctrl-@  NUL  Null prompt  

1  001  0x01 Ctrl-A  SOH  Start of heading  

2  002  0x02 Ctrl-B  STX  Start of text  

3  003  0x03 Ctrl-C  ETX  End of Text  

4  004  0x04 Ctrl-D  EOT  End of transmission  

5  005  0x05 Ctrl-E  ENQ  Enquiry  

6  006  0x06 Ctrl-F  ACK  Acknowledge  

7  007  0x07 Ctrl-G  BEL  Bell  

8  010  0x08 Ctrl-H  BS  Backspace  

9  011  0x09 Ctrl-I  HT  Horizontal tab  

10  012  0x0A Ctrl-J  LF  Line feed  

11  013  0x0B Ctrl-K  VT  Vertical tab  

12  014  0x0C Ctrl-L  FF  Form feed  

    NP  New page 

13  015  0x0D Ctrl-M  CR  Carriage return  

14  016  0x0E Ctrl-N  SO  Shift out  

15  017  0x0F Ctrl-O  SI  Shift in  

16  020  0x10 Ctrl-P  DLE  Data link escape  

17  021  0x11 Ctrl-Q  DC1  X-ON  

18  022  0x12 Ctrl-R  DC2   

19  023  0x13 Ctrl-S  DC3  X-Off  

20  024  0x14 Ctrl-T  DC4   

21  025  0x15 Ctrl-U  NAK  Not acknowledged  

22  026  0x16 Ctrl-V  SYN  Synchronous idle  

23  027  0x17 Ctrl-W  ETB  End transmission 
blocks  

24  030  0x18 Ctrl-X  CAN  Cancel  

25  031  0x19 Ctrl-Y  EM  End of medium  

26  032  0x1A Ctrl-Z  SUB  Substitute  

27  033  0x1B Ctrl-[  ESC  Escape  

28  034  0x1C Ctrl-\  FS  File separator  

29  035  0x1D Ctrl-]  GS  Group separator  

30  036  0x1E Ctrl-^  RS  Record separator  

31  027  0x1F Ctrl-_  US  Unit separator  

127  0177  0x7F  DEL  Delete or rubout 
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Printable Characters: 
Decimal Character Decimal Character Decimal Character Decimal Character 

32:   33: !  34: "  35: # 
36: $  37: %  38: &  39: ' 
 40: (  41: )  42: *  43: + 
 44: ,  45: -  46: .  47: / 
 48: 0  49: 1  50: 2  51: 3 
 52: 4  53: 5  54: 6  55: 7 
 56: 8  57: 9  58: :  59: ; 
 60: <  61: =  62: >  63: ? 
 64: @  65: A  66: B  67: C 
 68: D  69: E  70: F  71: G 
 72: H  73: I  74: J  75: K 
 76: L  77: M  78: N  79: O 
 80: P  81: Q  82: R  83: S 
 84: T  85: U  86: V  87: W 
 88: X  89: Y  90: Z  91: [ 
 92: \  93: ]  94: ^  95: _ 
 96: `  97: a  98: b  99: c 
 100: d  101: e  102: f  103: g 
 104: h  105: i  106: j  107: k 
 108: l  109: m  110: n  111: o 
 112: p  113: q  114: r  115: s 
 116: t  117: u  118: v  119: w 
 120: x  121: y  122: z  123: { 
 124: |  125: }  126: ~  127: � 
 128: €  129: �  130: ‚  131: ƒ 
 132: „  133: …  134: †  135: ‡ 
 136: ˆ  137: ‰  138: Š  139: ‹ 
 140: Œ  141: �  142: Ž  143: � 
 144: �  145: ‘  146: ’  147: “ 
 148: ”  149: •  150: –  151: — 
 152: ˜  153: ™  154: š  155: › 
 156: œ  157: �  158: ž  159: Ÿ 
 160:   161: ¡  162: ¢  163: £ 
 164: ¤  165: ¥  166: ¦  167: § 
 168: ¨  169: ©  170: ª  171: « 
 172:   173: ­  174: ®  175: ¯ 
 176: °  177: ±  178: ²  179: ³ 
 180: ´  181: µ  182:   183: · 
 184: ¸  185: ¹  186: º  187: » 
 188: ¼  189: ½  190: ¾  191: ¿ 
 192: À  193: Á  194: Â  195: Ã 
 196: Ä  197: Å  198: Æ  199: Ç 
 200: È  201: É  202: Ê  203: Ë 
 204: Ì  205: Í  206: Î  207: Ï 
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Decimal Character Decimal Character Decimal Character Decimal Character 
 208: Ð  209: Ñ  210: Ò  211: Ó 
 212: Ô  213: Õ  214: Ö  215: × 
 216: Ø  217: Ù  218: Ú  219: Û 
 220: Ü  221: Ý  222: Þ  223: ß 
 224: à  225: á  226: â  227: ã 
 228: ä  229: å  230: æ  231: ç 
 232: è  233: é  234: ê  235: ë 
 236: ì  237: í  238: î  239: ï 
 240: ð  241: ñ  242: ò  243: ó 
 244: ô  245: õ  246: ö  247: ÷ 
 248: ø  249: ù  250: ú  251: û 
 252: ü  253: ý  254: þ  255: ÿ 
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D: Error Messages and Troubleshooting 
The following error messages may be encountered while using DASYLab. 

Analog output had to be interrupted 
Cause  the D/A buffer is empty, DASYLab could not generate 

data to be sent by the D/A module fast enough 

Correction  reduce the output rate, or increase the output buffer size 

Cannot create DDE Link 
Cause  the specified server application is not active or the speci-

fied Topic or Theme is not available 

Correction  start application and make sure that Topic and Theme are 
defined 

Cannot execute the worksheet at this module - aborted 
Cause  the worksheet contains a loop that means the output of a 

module is (indirectly) needed for its input 

Correction  insert a time delay module or remove the loop completely 

Cannot open COMx 
Cause  the serial port is used by another application under Win-

dows and is not available for DASYLab 

Correction  make sure that the specified COM-port is not used by the 
mouse or by any other Windows application 

DDE Link was interrupted 
Cause  the DDE Link was interrupted by the Server program  

Correction  make sure that the Server program is still running 

Digital output had to be interrupted 
Cause  the digital output buffer is empty, DASYLab could not 

generate data to be sent by the Digital Out module fast 
enough 

Correction  reduce the output rate, or increase the output buffer size 

Error No 15 
This message may occur with some drivers that have not replaced the de-
fault message text. 

Cause (and meaning) data acquisition could not be started be-
cause a hardware conflict (like interrupts) has been de-
tected. This is a driver error code and you should report 
this message to technical support for more information. 
Please be prepared to describe the exact situation in which 
it occurs. 
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File read error 
Cause  the data file you want to read is corrupt or has the wrong 

file format 

Correction  check for the correct settings in the dialog box and make 
sure that the file format is correct 

Illegal block size STOP 
Cause  the FFT related module can only handle block sizes that 

are a power of 2 

Correction  use the Data Windows module to change the block size at 
the FFT input to a power of 2 

Output rate does not match the channel rate for one channel. STOP 

Output rate does not match the input rate at an input. STOP 
Cause  these messages indicate that the global acquisition rate is 

not an integer multiple of the defined output rate. Syn-
chronized output can only be realized in a way that one 
sample is sent to the D/A Card after a certain number of 
input samples has been acquired. Therefore the input rate 
divided by the output rate has to be an integer value. In 
both cases DASYLab does not use the channel rates, but 
the summed rates. 

Correction  adjust the analog or digital output rate 

The sample frequency is too high for this module 
Cause  up to version 1.54 of DASYLab the Chart Recorder was 

limited to 100Hz per channel. From 1.55 it does not 
check the rate of input signals. 

Correction  slow down the input rate by separate or average modules 

The sampling rate is too fast. The measurement has been 
stopped 

Cause  the speed DASYLab can acquire data from an analog in-
put card is limited. The limits depend on the hardware 
structure and the computer you use as well as on the 
worksheet you run. There may be different circumstances 
causing this message. The most common reason is that the 
driver buffer in DASYLab had an overrun and that the 
driver did not know where to store the next samples. In 
this case the measurement is stopped. Usually the bar in 
the status line indicates how much of the driver buffer is 
used, there are some situations where there may be no 
time to update the indicator. Another possible reason is 
that the interrupt frequency that is needed to acquire data 
at the desired rate was too high and that DASYLab no-
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ticed that interrupts have been lost. This may be caused by 
extreme bus activities of the graphics or hard disk control-
lers. When this happens, the message also appears without 
having the buffer status indicator filled. 

Correction  slow down the sampling rate or increase the driver buffer 

You cannot display signals from these input channels together in 
one scope 

Cause  the Y/t Chart module can only display signals of the same 
type in one display. The same type means that they are all 
time dependent, all frequency dependent or all histograms. 
When the signals are time dependent they have to have 
the same gap structure, that means that they may have 
gaps, but all at the same time and of the same length. 

Correction  use the Signal Adaptation module before the Y/t Chart or 
use different Y/t Charts for the different types 

You cannot display signals from these input channels together in 
one X/Y chart 

Cause  the X/Y Chart module can only display signals of the same 
type in one display. The same type means that they are all 
time dependent, all frequency dependent or all histograms. 
When the signals are time dependent they have to have 
the same gap structure, that means that they may have 
gaps, but all at the same time and of the same length 

Correction  use the Signal Adaptation module before the X/Y Chart or 
use different X/Y Charts for the different types 
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E: Product Support 
DASYLab is an innovative Windows application that has been developed over 
a period of several years by a team of committed engineers. To ensure that our 
software product will meet the changing needs of its users, we will continue to 
develop DASYLab. If you fill in the registration form included in this package 
and send it back to us, you will automatically receive the latest information on 
any updates of the software. 

Information about changes or features that were included after this user guide 
was printed is covered in the README file on your setup disk. Use Windows 

“Write” (or a similar word processor) to read this file. Read this file to find out 
about improvements and about conversions that may be necessary before you 
can use the latest DASYLab version. 

If you have any questions, suggestions, or requests regarding the DASYLab 
software and documentation, please contact us – we will be glad to help. 

 

DASYLab Support �  

Tel. +49 - 89 - 741 31 30     FAX +49 - 89 - 714 60 35 
email: support@dasylab.net 

www.DASYLab.net 

MeasX GmbH & Co. Kg. 
Postfach 401264, 

D - 41182 Mönchengladbach, Germany 

 

In North America 

Tel. 1-800-731-5015 or (603) 314-0340 FAX (603) 472-1069 

Email: support@dasylab.net 

www.DASYLab.net 

DASYTEC USA 
A National Instruments Company 

6 Bedford Farms, 

Bedford, NH 03110, USA 
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Index 
*.ASC 5-4 
*.DDB 5-5 
*.DDF 5-5 
*.DPF 5-3 
*.DSB 4-2, 4-43, 5-1 
*.DSQ 3-12, 3-13, 4-71 
*.I32 5-4 
*.IIS 4-33 
*.INI 5-3 
*.IOU 4-33 
*.SIM 4-33 
*.SIS 4-33 
*.SOU 4-33 
16-bit Program Worksheets 1-13 
32-bit version 1-13 
Acquisition 

Mode 4-26 
Rate 4-24 

Action Junction 3-13 
Actions 

Key Events 4-48 
List 4-49 
Screen Locking 4-48 

Activate Channel 1-16 
Active/Passive Partner 5-11 
Additions And Changes 1-15 
Alphabetic Index (Help Index) 4-85 
Analog Output Setup 4-27 
Analysis Toolkit 1-13 
Animation 4-35 
ASC 5-4 
ASCII Data Format 5-4 
Auto Start 

Experiment Menu 4-22 
Automatic Experiment/Program Start 6-4 
Automation 

Key Events 4-48 
Autorouter 3-5 

Options Menu 4-46 
Back to Main Chart (Black Box) 4-11 
Background Color 4-45 
Basic 1-13 
Bitmap Snapshots 1-17 
Black Box 

Colors 4-12 
Edit Menu 4-10 
Info 4-11 
Leave ~ 4-11 
Save 4-10 

Black Box Levels 4-11 
Block Size 2-5 

Maximum 4-25 
New Feature 4-25 

Block Size 4-25 
Blocked 

Data Stream 4-46 
Branches 3-3 

Create 3-5 
Delete 3-6 
Rearrange 3-6 

BSI DISC PD-2000-1 ii 
Buffer 

Driver 4-25 
button 3-25 
Calculate Expression 4-52 
Channel Activation 1-16 
Channel Status 3-4 
Channels 

Differing Sampling Rates 4-24 
Channels Names 

Copy 4-68 
Client 4-22, 5-11 
Clipboard, Copy to ~ 

File Info 4-5 
Layout 4-12 
Worksheet 4-9 

Clocking 2-5 
CLP 4-9 
Colors 

Background 4-45 
Black Box 4-12 
Data Channels 4-45 
Edit Custom ~ 4-45 
Grid 4-45 
Options Menu 4-45 
Screen Customization 3-9 
Worksheet 2-2 

Command Line 4-22 
Comment Flowchart 2-2, 3-13 
Company Logo 6-8 
Configuration 

Function Bar 3-24 
Module Bar 3-22 
Module Bar Menu 4-13 

Configure 
Module 4-18 

Context Menu 2-6 
Continuous 
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Acquisition Mode 4-26 
Control Sequencer 3-12, 4-69 
Control Sequencer View 3-13 
Control Sequencer Window 3-12 
Conventions 2-4 
Convert 16-Bit Program Worksheets 1-13 
Copy 

Channel Names 4-68 
File Info to Clipboard 4-5 
Layout to Clipboard 4-75 
Layout Window 2-3 
Module 2-2 
VITool 2-3 
Worksheet to Clipboard 4-9 

Copy Layout as Bitmap into Clipboard 1-17 
Copy/Paste 

Layout Window 4-75 
List Actions 4-49 
VITool 4-75 

Copyright Information 4-41 
Create 

Data Channels/Branches 3-5 
Create Directory 4-42 
Cut 

Layout Window 2-3 
Module 2-2 
VITool 2-3 

Cut/Paste 
Copy Layout 4-12 
Modules 4-15 
Worksheet parts 4-15 

DASYLab 
Data Format 5-5 

DASYLab Versions 1-12 
DASYLab.DML 4-15 
DASYLab.INI 5-3 
DASYLab-Net 

Client 4-22, 5-11 
Master/Slave 5-11 
Remote Control 4-22, 5-11 
Server 4-22, 5-11 
TCP/IP 5-12 

Data Channels 
Autorouter 4-46 
Colors 4-45 
Create 3-5 
Delete 3-6 
Rearrange 3-6 

Data format 
Disk Streaming 4-28 

Data Format 

ASCII 5-4 
DASYLab 5-5 
I32 5-4 
Universal 0 4-28 

Data Stream Blocked 4-46 
DBB 4-10 
DDB 5-5 
DDE 5-13 
DDF 5-5 
Deactivate Channel 1-16 
Debugging Aids 3-4 
Default 

Module Bar 4-15 
Default Directories 4-43 

Data 4-43 
Devices 4-43 
Other files 4-43 
Streaming 4-43 
Worksheet 4-43 

Default Options 2-2 
Define 

Global Strings 4-50 
Global Variables 4-55 

Delete 
Data Channels/Branches 3-6 
Layout Window 2-3 
Module 2-1, 4-18, 4-19 
Modules 4-16 
Output Channels 2-2 
VITool 2-3 
Window Arrangement 4-39 

Delete Input Channels 2-1 
Digital Output Setup 4-27 
Directories 

Default 4-43 
Data 4-43 
Devices 4-43 
Other files 4-43 
Streaming 4-43 
Worksheet 4-43 

Global Strings/Variables 4-61 
Disk Streaming 2-5, 4-27 

Data Format 4-28 
Read Data 4-28 

Display 
Function Bar 4-35 
Module Bar 4-36 

Display Window 
Dialog Box 3-11 
Display Tree 3-11 
Display Window 3-11 
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Display Window Icon 3-11 
Fixed Arrangements 3-28 
Function Bar 3-11 
Hide ~ 4-36, 4-37 
Make Visible ~ 4-36 
Menu Bar 3-11 
Restore ~ 4-36 
Scroll Bar 3-11 
Status Bar 3-11 
Title Bar 3-11 

Display Windows 
Saved Arrangements 3-28 

DLL drivers 4-31 
DML 4-14, 5-2 
DMX (File Extension) 5-1 
Documentation 2-2, 3-9 

List Actions 4-49 
DOS Prompt 4-22 
Dots (Grid) 4-41 
Double Format 1-17 
DPF 5-3 
Drawing Elements 4-76 

Layout Windows 3-18 
VITool 3-18 

Driver 1-10, 4-31 
Driver Buffer 4-25 
Driver Selection 4-22 
DSA (File Extension) 5-1 
Dynamic Data Exchange see DDE 
Edit 

~ Menu Commands 4-9 
Custom Colors 4-45 

Edit Action 3-13 
Embedding (Black Boxes) 4-11 
Error Handling 4-46 
Ethernet 5-12 
Event-Driven Action 

Screen Locking 4-48 
Events 

Key 4-48 
Examples 

Global Strings 4-61 
Global Variables 4-61 

Exit 
Black Box 4-11 
Program 4-8 

Experiment 
~ Menu Commands 4-20 
Auto Start 4-22 
Automatic ~ Start 6-4 
Pause 4-21 

Setup 4-23 
Acquisition Mode 4-26 
Block Size 4-25 
Driver Buffer 4-25 
Sampling Rate 4-24 

Start 4-20 
Start/Stop 6-3 
Stop 4-20 

Expressions 4-52 
Extended 4-52 
Extended Tooltip 1-16 
Extension (File-) 

VEC 5-9 
Extensions 

ASC 5-4 
Black Boxes 4-10 
DBB 4-10 
DDB 5-5 
DDF 5-5 
DML 4-14, 5-2 
DPF 5-3 
DSB 4-2, 5-1 
I32 5-4 
IIS 4-33 
INI 5-3 
IOU 4-33 
List Module Bar Files 4-14 
Save Module Bar 4-15 
SIM 4-33 
SIS 4-33 
SOU 4-33 

Extensions (File-) 
DSA 5-1 
TXT 5-2 

Extensions (File~) 
DMX 5-1 

External Programs 4-89 
FIFO Status 3-4 
File 

~ Menu Commands 4-1 
Default Directories 4-43 
Formats 

Initialization 5-3 
Interpolation 5-3 
Module Bar 5-2 
Open Module Bars 4-14 
Open Worksheets 4-2 
Reference Points 5-3 
Worksheets 5-1 

Info 4-5 
Open 
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Module Bar 4-14 
Worksheet 4-2 

file header 4-59 
Files 

Default Directories 4-43 
Find Modules 4-16 
Float Format 1-17 
Flow Chart see Worksheet 
Flowchart Junction 3-13 
Font Sizes 

Global Setting 4-44 
Format see File ~s 

Page ~ 4-6 
Worksheet 5-1 
Worksheet Files 5-1, 5-2 

Free H(ot)Keys 4-45 
Free Variables/Strings 4-64 
Full version 1-13 
Function Bar 

Configuration 3-24 
Display/Remove 4-35 
Screen Element 3-23 
Window Arrangements 3-28 

Function Buttons 1-15, 3-25 
Getting Started 1-15 
Getting Started Guide 1-15, 2-7, 4-87 
Global Block Size 2-5 
Global Clocking 2-5 
Global Sampling Rate 2-5, 4-24 
Global Setting 

Font Sizes 4-44 
Global String 

Overview 4-54 
Global Strings 4-50 

Directory Example 4-61 
Examples 4-61 
Module Use 4-54 
System 4-54 

Global Variable 
Overview 4-54 

Global Variables 4-55 
Directory Example 4-61 
Examples 4-61 
System Information 4-57 
Use in Modules 4-57 

global Variables and Strings 1-15 
Graph Object 

Properties 4-78 
Graphic Card 1-12 
Grid 

~ Type 4-41 

Color 4-45 
Hands-On Guide to DASYLab 2-2 
Hardware 

Requirements 1-9 
Hardware Setup 4-23 
Hide 

~ Display Window 4-37 
~ Display Windows 4-36 

Hotkey 4-44 
Hot-Keys 1-15 
I32 5-4 
ICom/IEEE Modules 1-17 
IIS 4-33 
Index 

Help Menu 4-85 
Information 

Black Box 4-11 
File ~ 4-5 

INI 5-3 
Input Channels 

Delete 2-1 
Install 

Module 4-18 
Installation 

Setup 1-10 
System Requirements 1-9 

Instruction 2-2, 1-15, 2-7, 4-87 
First Worksheet 2-7 
Help Index Option 4-85 

Interpolation 
File Format 5-3 

IOU 4-33 
Isolated Series 

Acquisition Mode 4-26 
Junction Points 3-3 

Pop Up Menu 3-12 
Rearrange 3-6 

key combinations 1-15 
Key Events 4-48 
Keyboard 3-2 

Screen Locking 4-47 
Keyboard Operations 6-1 
Layout Object 

Properties 2-3 
Layout page 4-83 
Layout Window 3-17 

Bitmap Objects 3-16 
Copy 2-3 
Cut 2-3 
Delete 2-3 
Display Objects 3-16 
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Drawing Object 3-16 
Function Bar 3-16 
Menu Bar 3-16 
Text Objects 3-16 
Title Bar 3-16 
ToolBox 3-16 
View 4-82 
Visualization Objects 3-16 
Zoom 4-82 

Layout Windows 
Active Elements 3-19 
Bitmapped Graphics properties 4-77 
Copy 4-75 
Copy Layout to Clipboard 4-12 
Copy/Paste 4-75 
Delete 4-75 
Drawing Elements 3-18, 4-76 
Linked Graph Properties 4-78 
Linked Text Properties 4-78 
Load 4-75 
Load from file 4-13 
New Layout 3-17 
Page Properties 4-83 
Passive Elements 3-18 
Properties 3-17 
Save 4-75 
Save to file 4-12 
Text Block 4-79 
Text Elements 3-18 
Text Grid 4-79 
Text Line 4-79 
Toolbox 3-20 
Visualization 4-77 
Visualization Elements 3-18 

LE 1-13 
leap year ii 
Leave Black Box 4-11 
Levels (Black Boxes) 4-11 
Limited 1-13 
Lines 

Grid option 4-41 
List Actions 4-49 
Lite 1-13 
Load see Open 

Network Open 5-11 
Program 4-58 

Logo 6-8 
Main Chart (Black Box) 4-11 
Main Menu 

Customizing 4-89 
External Programs 4-89 

Margins 4-7 
Master 5-11 
Maximum 

Block Size 4-25 
Memory Requirements 1-9 
Menu 

Display Window 4-68 
Layout 4-68 
New Layout 4-68 
Window 4-68 
Worksheet 4-68 

Menu Bar 
Screen Element 3-20 

Message Module 1-17 
Mode 

Acquisition 4-26 
Module 

~ Menu Commands 4-16 
Copy 2-2 
Cut 2-2 
Default Options 2-2 
Documentation 2-2 
Install and Configure. 4-18 
Polar Plot 1-16 
Properties 2-2 
Replace 2-2 
Search 2-2 

Module Bar 2-4 
~ Menu 

New 4-14 
Open 4-14 
Save As ... 4-15 
Set to Default 4-15 

~ Menu 4-13 
Configuration 3-22 
Display/Remove 4-36 
File Format 5-2 
Icons 3-2 
Removing 3-23 
Saving 3-22 
Screen Element 3-22 

module default 1-15 
Module Groups 

~ Overview 3-29 
Modules 

Delete from Worksheet 4-16 
Global Strings 4-54 
Global Variables 4-57 
Search 4-16 

Motorola 
Double Format 1-17 
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Float Format 1-17 
Mouse Button, Right ~ 2-1 
Move 

Module 4-18 
MS TCP/IP-32 5-12 
Net option 1-13 
Network 5-12 

TCP/IP 5-12 
New 

Module Bar 4-14 
Worksheet 4-1 

New in Version 8.0 1-15 
new Layout 4-69 
New Line (text boxes) 4-5 
NI-DAQ 2-5, 4-31 
Off-line phase 4-64 
One Series 

Acquisition Mode 4-26 
Open 

Module Bar 4-14 
Worksheet 4-2 

Operations 
Keyboard 6-1 

Options 
Program Start 4-41 

Options Menu 4-82 
Options Menu Commands 4-40 
Output Channels 

Delete 2-2 
overview 1-15 
Overview 4-35, 4-54 
Overview window 4-64 
Page 

~ Format 4-6 
~ Frame 4-7 

Page Properties 4-83 
Paper 4-7 
Parameter 

Module 4-18 
Passive Partner 5-11 
Password 

~ Protection 4-47 
Password Protection 

Black Boxes 4-47 
Paste 

Modules 4-15 
Worksheet 2-2 
Worksheet Parts 4-15 

Pause 
Experiment 4-21 

PC Clock 4-31 

PC Hardware Configuration 1-11 
Polar Plot 1-16 
Power Management 1-11 
Preceding Level (Black Box) 4-11 
Precision B-1 
Print 

List Actions 4-49 
Page Format 4-6 
Viewport 4-6 
Worksheet 4-5 

Printer Setup 4-6 
Processing Cycle 4-25 
Program Automation 

Key Events 4-48 
Program Item Properties 4-22 
Program Load 4-58 
Program Operation Fundamentals 2-1 
Properties 

Bitmapped Graphics 4-77 
Layout Object 2-3 
Layout Objects 4-77 
Layout Window 4-81 
Module 2-2 
VITool Objects 4-77 
Worksheet 2-2 

Protocol 
TCP/IP 5-12 

QuickStart 1-15 
Quit 4-8, see Exit 
Read see Open 
Read Data 

Disk Streaming 4-28 
Read or Write Access 4-64 
README file 2-2 
README File 1-15 
Rearrange Data Channels 3-6 
Reference Points 

File Format 5-3 
References (Help Index option) 4-85 
Regression Module 1-17 
Remote Control 4-22, 5-11 
Remove 

Display Window 4-37 
Display Windows 4-36 
Function Bar 4-35 
Module Bar 4-36 

Replace 2-2 
Requirements 

Memory 1-9 
Resource Conflicts 1-12 
Response Time 4-30 
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Restart after Time 4-21 
Restore Display Windows 4-36 
Right Mouse 2-6 
Right Mouse Button 2-1 
Risky Applications iii 
Running Series 

Acquisition Mode 4-26 
S/B ratio 4-30 
Sampling Rate 2-5, 4-28 

Differing ~ s 4-24 
Sampling Rate 4-24 
Sampling Rate/Block Size Ratio 4-30 
Save 

Black Box 4-10 
Module Bar 4-15 
Window Arrangement 4-38 
Worksheet 4-3 

Save As 
Module Bar 4-15 
Worksheet 4-4 

Save Data 
Disk Streaming 4-27 

Screen 
Customization 3-9 

Screen Locking 4-47 
Search 2-2 
Search for Modules 4-16 
Security 

Black Box Passwords 4-47 
Editing Passwords 4-47 
Screen Locking 4-47 
Worksheet Passwords 4-47 

Select 
Window Arrangement 4-38 

Self-Paced Tutorial 2-2 
Sequencer 3-12 
Sequencer Comment 3-15 
Serial Devices 4-32 
Serial number 1-10 
Server 4-22, 5-11 
Setup 

Analog Output 4-27 
Digital Output 4-27 
Disk Streaming 4-27 
Experiment ~ 4-23 
Hardware ~ 4-23 
Output Buffer 4-27 
Output Rate 4-27 
Output Start 4-27 
Printer ~ 4-6 

Show 

Copyright Information 4-41 
Show Display Windows 4-36 
Show File Information 4-41 
SIM 4-33 
Slave 5-11 
Sockets 5-12 
Spacing 4-41 
Start 

Automatic Experiment/Program Start
 6-4 

Experiment 4-20, 6-3 
at Time 4-21 
Auto Start 4-22 
Restart after Time 4-21 

Start Options 4-41 
Start/Stop 5-11 
StartUp 

From Windows 2-4 
Status Bar 2-3, 3-4, 3-27 
Status line 4-65 
Step-By-Step Guide 2-2 
Stop 

Experiment 4-20, 4-23, 6-3 
after Time 4-21 

Streaming 2-5 
Strings 

Examples 4-61 
Switch to Runtime 4-68 
System Information 

Global Strings 4-54 
Global Variables 4-57 

System Requirements 1-9 
TCP/IP 5-12 
Text 

Block 4-79 
Elements 4-79 
Grid 4-79 

Text Block 
Layout Object 4-79 

Text Boxes 3-10 
Text Elements 

Layout Windows 3-18 
VITool 3-18 

Text Line 
Layout Object 4-79 

Text Object 
Properties 4-78 

Text Objects 
Strings and Variables 4-81 

Time 
Restart after ~ 4-21 
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Start at ~ 4-21 
Stop after ~ 4-21 

Time Base Setup 2-5 
Time Bases 2-5, 4-31, 4-32 
Time Zone 1-12 
Title Bar 3-20 
Tooltip 1-16 
Tutorial See Instruction, See Instruction, See 
Instruction, see Instruction, see Instruction 
TXT (File Extension) 5-2 
Undo 4-15, 4-75 
Universal 0 

Data Format 4-28 
Used Variables/Strings 4-64 
User Defined Function Buttons 1-15, 3-25 
User defined Hot-Keys 1-15 
user-defined Hotkeys 4-45 
Variables 

Examples 4-61 
VEC (File-Extension) 5-9 
Vector-File 

Data format 5-9 
View Menu 4-82 
View Menu Commands 4-34 
Viewport 4-6 
Virtual device driver 1-11 
Visualization 

Layout Window 4-77 
Visualization Elements 

Layout Windows 3-18 
VITool 3-18 

VITool 
Active Elements 3-19 
Bitmapped Graphics properties 4-77 
Copy 2-3 
Copy Layout to Clipboard 4-12 
Copy to Clipboard 4-75 
Copy/Paste 4-75 
Delete 2-3, 4-75 
Drawing Elements 3-18, 4-76 
Layout Window 3-16, 3-17 
Layout Window Properties 3-17 
Linked Graph Properties 4-78 
Linked Text Properties 4-78 
Load Layout Window from File 4-75 
Load Layout Windows 4-13 
Menus 4-74 
New Layout 3-17 
Page Properties 4-83 
Passive Elements 3-18 
Save Layout Window 4-12 

Save Layout Window to File 4-75 
Text Block 4-79 
Text Elements 3-18 
Text Grid 4-79 
Text Line 4-79 
Toolbox 3-20 
Undo 4-75 
Visualization 4-77 
Visualization Elements 3-18 

Window Arrangement 3-28 
Delete 4-39 
Save 4-38 
Select 4-38 

Window Menu 4-68 
Window Setup 4-40 
WINSOCK 5-12 
WMF/CLP 4-9 
Work Area 

Layout Window 3-17 
Worksheet Window 3-8 

Worksheet 
Open 4-2 

Worksheet 
Colors 2-2 
Element 3-1 
Modules 3-1 
Properties 2-2 
Symbols 3-2 

Worksheet 
Save 4-3 

Worksheet 
Save As 4-4 

Worksheet 
Print 4-5 

Worksheet 
File Format 5-1 

Worksheet Documentation 3-9 
Worksheet Settings 2-2 
Worksheet to Clipboard 4-9 
Worksheet Window 

Dialog Box 3-8 
Display Window Icon 3-8 
Function Bar 3-8 
Menu Bar 3-8 
Module Bar 3-8 
Scroll Bar 3-8 
Status Bar 3-8 
Title Bar 3-8 
Work Area 3-8 
Worksheet Window 3-8 

Year 2000 Compliance ii 
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